Copyright

This documentation is protected by law. All rights, especially the right to duplicate, circulate, and translate, are reserved.

No part of this publication may be reproduced in the form of copies, microfilms or other processes, or transmitted into a language used for machines, especially data processing machines, without the express written consent of the publisher.

All copyrights reserved.

All other product names are trademarks of the corresponding manufacturers. Errors in and changes to the contents as well as program modifications reserved.

Copyright© MAGIX Software GmbH, 2002 - 2012. All rights reserved.

MAGIX is a registered trademark of MAGIX AG.

Other mentioned product names may be registered trademarks of the respective manufacturer.

This product uses MAGIX patent pending technology.
Preface

With MAGIX PhotoStory on DVD 2013 Deluxe you can teach your photos how to walk – or even better, how to dance! With this software your photos will become the star of an impressive multimedia show, and you’re the director!

Enjoy your photos together with your family and friends on TV or on your PC. Play your pictures just like a feature movie with great transitions and effects as well as narration and subtitles. Add intros and outros or invent your own closing credits. Transform your TV into a silver screen!

Create attractive DVD menus that match the format of your slideshow: 4:3 or 16:9 for widescreen TVs or monitors. Burn your slideshow together with a professional menu to DVD, Blu-ray Disc or AVCHD.

You can find detailed documentation as a PDF in the start menu of your MAGIX product. The electronic manual can be opened using “F1” to provide a more detailed explanation of the options, dialog boxes, menus, and program interface.

Have fun with MAGIX PhotoStory on DVD 2013 Deluxe!
Table of Contents

Copyright 2
Preface 3
Support 8
Serial number 10
More about MAGIX 11
MAGIX News Center 11
MAGIX Online Album 11
MAGIX Website Maker 11
Catooh – the Online Content Library 11
MAGIX Community 12
Introduction 13
What is MAGIX PhotoStory on DVD 2013 Deluxe? 13
What’s new in MAGIX PhotoStory on DVD 2013 Deluxe? 13
Properties 14
Projects, slideshows and photos 16
Quick start 17
Program start 17
Load photos 19
Sorting Photos 20
Editing slideshows 22
Divide slideshow 24
Create disc menu and burn 25
Settings 29
Slideshow 29
Project 29
Program 30
Screen: Slideshow 35
Video monitor and transport console 36
Zoom in video monitor 37
Toolbar 37
Start and end markers 43
Mute sound 43
Overview mode 43

www.magix.com
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storyboard mode</td>
<td>44</td>
</tr>
<tr>
<td>Timeline mode</td>
<td>45</td>
</tr>
<tr>
<td><strong>Media Pool</strong></td>
<td>48</td>
</tr>
<tr>
<td>Media</td>
<td>49</td>
</tr>
<tr>
<td>Fades</td>
<td>53</td>
</tr>
<tr>
<td>Title</td>
<td>53</td>
</tr>
<tr>
<td>Effects</td>
<td>53</td>
</tr>
<tr>
<td><strong>Title editor</strong></td>
<td>68</td>
</tr>
<tr>
<td>Creating titles using a template</td>
<td>69</td>
</tr>
<tr>
<td>Creating titles without a template</td>
<td>69</td>
</tr>
<tr>
<td>Position titles</td>
<td>70</td>
</tr>
<tr>
<td>Edit titles retroactively</td>
<td>71</td>
</tr>
<tr>
<td>Advanced settings</td>
<td>72</td>
</tr>
<tr>
<td><strong>Transitions (fades)</strong></td>
<td>74</td>
</tr>
<tr>
<td>Transitions in Storyboard Mode</td>
<td>74</td>
</tr>
<tr>
<td>3D fades</td>
<td>74</td>
</tr>
<tr>
<td>3D series</td>
<td>75</td>
</tr>
<tr>
<td>Stereo3D fades (deluxe version only)</td>
<td>75</td>
</tr>
<tr>
<td>Simple crossfade in Timeline Mode</td>
<td>76</td>
</tr>
<tr>
<td>Drag &amp; drop onto a “hard” transition</td>
<td>76</td>
</tr>
<tr>
<td><strong>Effects</strong></td>
<td>77</td>
</tr>
<tr>
<td>Effects in menus</td>
<td>77</td>
</tr>
<tr>
<td>Effects from the Media Pool</td>
<td>77</td>
</tr>
<tr>
<td>Video stabilization</td>
<td>79</td>
</tr>
<tr>
<td>Sound optimization</td>
<td>81</td>
</tr>
<tr>
<td>Slideshow effects</td>
<td>84</td>
</tr>
<tr>
<td><strong>Audio recording</strong></td>
<td>87</td>
</tr>
<tr>
<td>Advanced audio recording settings</td>
<td>88</td>
</tr>
<tr>
<td>Connecting the source for recording</td>
<td>89</td>
</tr>
<tr>
<td>Adjusting the Signal Level</td>
<td>90</td>
</tr>
<tr>
<td><strong>Special functions and wizards</strong></td>
<td>91</td>
</tr>
<tr>
<td>Create a slideshow with the wizard</td>
<td>91</td>
</tr>
<tr>
<td>Divide slideshow</td>
<td>94</td>
</tr>
<tr>
<td>Slideshow Maker</td>
<td>94</td>
</tr>
<tr>
<td>MAGIX Soundtrack Maker</td>
<td>98</td>
</tr>
<tr>
<td>Musical Cut Adjustment</td>
<td>100</td>
</tr>
</tbody>
</table>
Search empty sections 102
Clean-up Wizard 103
Export 103
Travel route animation 103
Movie templates 111
Create panorama images 112
Automatic volume damping 114
Manual volume decrease 115

**Stereo3D** 116
3D basics 116
Record 3D 117
Prepare 3D editing 118
Set playback mode for 3D 119
Align videos and pictures for 3D 120
Turn camera movements into 3D videos 121
Export and burn 3D videos 122

**The “Burn” interface** 124
Preview and editing 125
Menu 126
Edit DVD menus with MAGIX Photo & Graphic Designer 7 135
Disc selection dialog 141
Burn dialog for DVD player 142

**Export** 145
Output as video file 146
Output as individual photos 147
Export as 3D video 148
Present on MAGIX Online Album 148
Publish online 149
Output for a mobile device 150
Archive project onto hard disk 151
Archive project onto disc 151
Output as media player 151

**Menus** 152
File Menu 152
Edit Menu 163
Effects Menu 166
“Share” menu 170

www.magix.com
Table of Contents

Help Menu 171

**Activate additional functions** 173
Free activation (MPEG 2 & 4 codec) 173
Activation problems 174

**Problems and solutions** 175
File will not load 175
Choppy or uneven playback 175
Activation problems 175

**Encoder** 177
Appendix: MPEG Encoder Settings 177
MPEG-4 encoder 180
MPEG glossary 191

**Annex: Digital Video and Data Storage** 197
Video Editing on the PC 197
HDTV 197
MPEG Compression 198
General notes on AVI videos 198
Digital Versatile Disc (DVD) 199
Blu-ray Disc 200
AVCHD disc 200

**If you still have questions** 201
Tips for program help 201
System requirements 202

**Glossary** 203

**Keyboard shortcuts** 217
Media Pool 217
Slideshow 217

**Index** 220
Support

Dear MAGIX customer,

Our aim is to provide fast, convenient, solution-focused support at all times. To this end, we offer a wide range of services:

• **Unlimited web support:**
  As a registered MAGIX customer, you have unlimited access to web support offered via the convenient MAGIX service portal on http://support.magix.net, including an intelligent help assistant, high-quality FAQs, patches and user reports that are constantly updated.
  The only requirement for use is product registration at www.magix.com

• **The online community, on-the-spot support and a platform for exchange:**
  MAGIX customers have free and unlimited access to the online community at www.magix.info, which includes approx. 150,000 members and offers the opportunity to ask members questions concerning MAGIX products as well as use the search function to search for specific topics or answers. In addition to questions & answers, the knowledge pool includes a glossary, video tutorials and a discussion forum. The multiple experts, found round-the-clock at www.magix.info guarantee quick answers, which sometimes come within minutes of a question being posted.

• **Email support for MAGIX products:**
  For every new MAGIX product you will receive, as of date purchase, 12 months of email based customer service.
  **Premium email support:**
  For priority support, or if you want the MAGIX support team to help with non-MAGIX related hardware problems you can purchase a Premium email support ticket. Log in at http://support.magix.net and click on “Purchase access code”, the ticket is for a specific problem, and is valid until it is solved, it is not restricted to an email.

**Please note:** To be able to use the Premium email support and free product email support via the Internet, you have to register your MAGIX product using the serial number provided. This can be found on the CD case of your installation CD or on the inside of the DVD box.

• **Additional telephone service:**
  Besides the large number of free customer service offers, we also offer a fee-based telephone customer service.
Here you can find a summary of our technical support telephone numbers:
http://support.magix.net/

**Mail (Europe):** MAGIX Development Support, P.O. Box 20 09 14, 01194 Dresden, Germany

**Mail (North America):** MAGIX Customer Service, 1105 Terminal Way #302, Reno, NV 89502, USA

**Please make sure you have the following information at hand:**
- Program version
- Configuration details (operating system, processor, memory, hard drive, etc.), sound card configuration (type, driver)
- Information regarding other audio software installed

**MAGIX Sales Department**

You can reach the MAGIX Sales Department workdays for help with the following questions and problems:

- Orders
- Product consulting (pre-purchase)
- Upgrade requests
- Returns

**Europe**
Monday - Friday, 09:00-16:00 GMT

- **U.K.:** 0203 318 9218
- **Denmark:** 45 699 18 763
- **Sweden:** 46 852 50 07 13
- **Finland:** 35 89 424 19 023
- **Norway:** 47 210 35 843

**North America**
9 am to 4 pm EST Mon-Fri
**Phone:** 1-305-722-5810
Serial number

A serial number is included in each product. This serial number is required for the installation of the software and enables usage of additional bonus services. Please store this number in a safe place.

What can a serial number do?
With a serial number your program is clearly assigned to you and only you. This will allow you take advantage of the free email support service. Serial numbers also help to protect against software piracy which ensures that we are able to continually provide our customers with an optimal price/performance ratio.

Where can the serial number be found?
The serial number can be found on the reverse side of your CD/DVD case. If your product is packed in a DVD box, you’ll find the serial number on the inside.

If you have purchased the download version, you will receive a confirmation email with the serial number.

When will you need the serial number?
The serial number is required when you start or register the program for the first time.

Note: We explicitly recommend registering your product (free), since only then are you entitled to download updates and to use MAGIX support services (view page 8) or activate codecs.
More about MAGIX

MAGIX News Center

The MAGIX News Center features links to current online tutorials and tips & tricks on the software application examples. The "News" is indicated by color according to content:

• Green indicates practical tips & tricks for the software
• Yellow reports the availability of new patches and updates
• Red for special offers, contests and questionnaires

If no new messages are present, the button will appear gray. When the MAGIX News Center is clicked, all of the available information will be displayed. Click the messages to reach the corresponding website.

MAGIX Online Album

MAGIX Online Album is your personal multimedia album on the Internet. If you want to present slideshows or videos online, then MAGIX Online Album is the perfect service.

MAGIX Website Maker

MAGIX Website Maker helps you create a personal Internet showcase with a professional design in just a few mouse clicks – without prior knowledge, including your own chosen domain and email address. Publish slideshows and videos and accessorize your site with music and various effects – anything from a simple business card to a fireworks display of effects, professional or private – show your best side!

Catooh – the Online Content Library

If your project is missing pictures, videos, DVD menus, sounds, or samples, then you should have a look at the huge selection available at Catooh. There you’ll be able to buy media in excellent quality for low prices: DVD menus, Slideshow Maker styles, decorative elements, 3D power effects, 3D transition series, MAGIX Soundpools, songs, ringtones... Perfectly suited to all MAGIX photo, video, and music projects.
MAGIX Community

MAGIX Community is the place to exchange photos, videos, and music with friends and the world. As soon as you have registered for free, you can use all of its great features.
Introduction

What is MAGIX PhotoStory on DVD 2013 Deluxe?

The name says it all: MAGIX PhotoStory on DVD 2013 Deluxe puts your photos and movies onto a CD or DVD as a slideshow that can then be viewed on your PC screen or TV just like a movie. Along with “classic” DVDs, you can also burn Blu-ray or AVCHD Discs.

A typical case: Your hard drive is full of digital photos from your camera or scanner. What to do with all those photos? MAGIX PhotoStory on DVD 2013 Deluxe will tidy everything up, put it together and add transitions, music or effects to create an exciting slideshow.

What’s so special? A personal slideshow is created, professionally arranged just like a feature movie. Then you can burn it to a disc and even include additional photos. The disc can be played back on any compatible player and you can enjoy it on TV. There are also many more possibilities for exporting slideshows as movie files or present them directly online.

What’s new in MAGIX PhotoStory on DVD 2013 Deluxe?

Intuitive interface: Improved design for even better control.

Flexible tracks: Photos, videos and text can be positioned and combined on all four tracks in Timeline mode. This is ideal for creating collages. Additional audio material can be positioned on three tracks.

Combined objects: Videos with an audio track are displayed with the audio and video together on one combined object.

Travel route animation: With the included program Vasco da Gama 5 HD Pro you can create impressively detailed travel route animations in Full HD.

Quick access feature in the Media Pool: The new quick access feature allows you to play back, trim and import video clips directly from the Media Pool and into the timeline of your slideshow project.

Automatic image effects: With one click you can add random camera movements, zooms and rotation effects to an entire selection of photos automatically. Manually created effects and transitions are not affected by this process.
**Improved audio functions:** Automatic volume and sound optimization for the audio track.

**New decorative elements and templates:** The right element for any subject and now in new, improved quality.

### Properties

**Import**

**Import formats**

Video: AVI, DV-AVI, MPEG-1, MPEG-2, MPEG-4, MTS, M2TS, MXV, MJPEG, QuickTime, WMV(HD), MKV

Audio: WAV, MP3, OGG, WMA, MIDI, DolbyDigital Stereo

Images: JPEG, BMP, GIF, TIF

**Export formats**

Video: AVI, DV-AVI, MJPEG, MPEG-1, MPEG-2, MPEG-4, QuickTime, WMV(HD)

Audio: WAV, MP3, WMA, DolbyDigital Stereo

Images: JPEG, BMP

**Edit**

MAGIX PhotoStory on DVD 2013 Deluxe provides a large number of multimedia functions that help you really get the best out of your photos and make fascinating slideshows from them. For instance:

- **Three editing modes:** In Storyboard Mode all photos are listed in sequence. In “Timeline Mode” they are displayed in “realtime”. In “Overview Mode” all photos are displayed in several rows with little preview icons to maintain an overview of all pictures.

- **Image optimization:** Typical defects (exposure, color, red eyes...) can be removed easily. Picture size and position can be corrected by increasing the size, rotating, clipping, leveling the horizon, etc. Each edit is non-destructive, i.e. the original photos remain unchanged.

- **Zooms & camera pans:** Zoom into the photo, then pan through the image.

- **3D effect templates** to reshape motifs and have them fly through the picture.

- **1-click animations** for transforming photos into videos (e.g. jumping, mosaic, kaleidoscope).

- **Decorative elements** and **superimposed videos** with cartoons, speech bubbles, costume accessories, frames...
• Multimedia opening and closing credits with video templates including sound, personal texts and motifs

• Transitions: Alongside the many variations for “simple transitions” (e.g. soft fades, black fades, page turn, wave), there are also complex transitions like picture-in-picture fades or thematic 3D fade series (gallery, photo table, notice board).

• Titles and title templates: Add texts to your templates, e.g. by displaying text as subtitles, lower thirds or in speech bubbles.

• Audio dubbing & Soundtrack: You can add audio files and CD tracks to the original soundtrack of your photos and videos, record your own speaker comments or use the integrated MAGIX Soundtrack Maker to add your own music onto the soundtrack. Use one of the many professional audio editing effects to enhance the soundtrack further.

• Slideshow Maker automatically turns tiresome photo series into spectacular multimedia shows. For particularly fast results.

• Special functions: Panorama image montage, travel route animation, stabilize shaky videos, picture-in-picture collages and much more.

Burning

You can use the “Burn” interface to burn a disc from your photos and slideshows. Before you do that you can design a professional menu screen for selecting your slideshows and photos using a remote control.

The following disc types can be burned:

• DVD: The slideshows are made into a classic movie DVD in excellent quality.

• Blu-ray Disc: Also a high-resolution disc format for playback on a TV. Requires a suitable player (Blu-rayTM player) to be connected to a TV. You also need special Blu-ray discs and a Blu-ray burner in your PC.

• AVCHD: Similar to Blu-ray Discs but you can also use regular recordable DVDs for burning. You need an AVCHD compatible Blu-ray player for playback on a TV.

Export

The “Output” dialog has several options for what you can do with your slideshows:

• Output as video file: This exports the slideshow as a video file that can be viewed on your PC, edited in other programs and shared.

• Output as individual photos: Saves the slideshow as individual photos for editing or sharing.

• Output as 3D video: Save the 3D slideshow as a video file in WMV-3D format. To play back 3D video files you have to have a 3D video player installed on your PC (e.g. Stereoscopic Player) and 3D glasses.

• Present in Online Album: Present your movies, slideshows and photos to your friends or anyone else in the MAGIX Online Album.
• **Publish online:** You can also share your slideshows directly online on sites like YouTube, Flickr or Facebook.

• **Export to mobile device:** You can also export your slideshows directly to a connected mobile phone, digital picture frame, organizer, games console and any other external device.

• **Output as media player:** Create an HTML-enabled media player for playback on an Internet browser or to embed it in a website.

• **Archive project on hard drive or disc:** This is a good final cleanup step after you are finished working on your project.

**Projects, slideshows and photos**

In MAGIX PhotoStory on DVD 2013 Deluxe you can work with “projects”, “slideshows” and “photos”. In order to work quickly and intuitively, it is important to know the differences between these three hierarchically-ordered terms.

**Project**

A “Project” includes everything that you want to include on a disc. This normally contains one or more slideshows and includes a menu structure/menu design which allows you to choose a slideshow later on the disc. Projects can be saved as “<Pojektdatei>” files on your hard drive and can be loaded later for further editing.

**Slideshow**

A slideshow is a multimedia presentation of photos which is played like a movie. Enjoy it on a PC or TV, since it offers maximum multimedia entertainment value from photos, videos, music, title texts, transition effects, and much more.

Any slideshow can be exported individually as a video. The “project” can be considered a type of drawer into which you can put multiple slideshows for burning to disc later.

**Photos**

Photos are the main part of your slideshows. You can import photos and videos into your slideshow (the right video codec has to be installed on your system). Besides photos and videos, a slideshow also includes plenty of other elements: image titles, transitions, decorative elements, music, spoken commentary...

**Summary:** “Projects” include “Slideshows”, “Slideshows” include “Photos”. Slideshows of a project appear as menu entries, photos (as well as videos) appear as sub menu entries of these entries for navigation on the finished disc.
Quick start

Program start

When you start the program, a welcome dialog will appear.

Here you can choose what you want to do.

For the purpose of this introduction we will describe the normal procedure: Starting a new project, loading your own photos and arranging them as a slideshow that will be burned to disc. The other options offered in the welcome dialog will be dealt with in later chapters (view page 90).

• The the default setting is "Manually create new project". Simply click on "OK".
A settings dialog will appear where you can select the screen format.

- Choose whether you want to create a slideshow in widescreen or 4:3 format.
- Then click on “OK”.

A new empty project that you can fill with your own photos will appear in the program interface.
Load photos

The Media Pool is to the right.

Open a folder in the Media Pool that contains photo files by using the navigation buttons.

All photos and all other useable files are then listed in the Media Pool.

When you hover the mouse pointer over the detail list, small selection boxes will appear and can be used to activate a preview of the file or to load the file directly.

The arrow on the left activates the preview. The icon on the right loads the file into the project.

You can select and load all the photos you would like to use one after the other.

Are your photos upside down or sideways?
Use the rotation button on the preview image to rotate any photo until it is displayed properly.

To play back your show, press the space bar or start the slideshow using the transport console below the preview window.

Each photo is shown one after the other in the video monitor.

Sorting Photos

You should also sort the slideshows correctly. In a good slideshow the pictures tell a story that has a beginning, a middle and an end with lots of dramatic tension building up to an exciting climax.

This is easy to do with a slideshow about your last vacation because the dramatic composition is already there. It starts with pictures of the departure and then shows pictures of your arrival at the hotel and then the first adventures ...

A good vacation comes with a natural drama that results from the chronological order of the events. This is not necessarily the case for other slideshows; in this case you should consider the order in which you would like to present the photos. The problem with sorting also depends on the purpose for which you have created your slideshow.

Sorting the photos is easy:

• Drag each photo from the photo bar and drop it on the correct position.

You can’t select several photos and sort them simultaneously in the Storyboard. You should switch to Overview mode.
In Overview mode you can use the whole screen to sort your photos.

- Click on the top switch in the mode selection in the bottom left corner to open Overview mode.

You should maximize the overview to get the best possible overview if you are working with a lot of photos.

If all photos don’t fit into the list you can use the zoom to reduce the size of the display:

Overview mode is the ideal view mode to arrange all photos perfectly for a slideshow. You also may select multiple photos and move them at once.
Editing slideshows

MAGIX PhotoStory on DVD 2013 Deluxe provides many different editing functions. Let's start with Storyboard mode:

Each preview photo has several settings for duration, transitions, effects, and text.

**Set display time:** By double-clicking on the time display below the preview image you can access the input dialog where you can manually enter the display numerically or by using the slide control.

**Add titles and text:** Titles (e.g. subtitles, opening/closing credits) can easily be added to every photo by clicking on this button.

**Transitions:** The transition (fade) buttons are situated between the photos. You can now preview the available transitions, try them out and see the result immediately in on the preview monitor.

**Image editing:** Press the "FX" button on the photo box to access the effects and image editing tools which can be used separately on each photo, e.g. optimizing image quality.

**Rotation:** If a photo is on its side or upside down, click on the symbol with the rotating arrow. The photo will rotate 90 degrees. You can check the effects directly on the video monitor.

**Tip:** MAGIX Photo Designer 7 is an additional image editing program that is included for more complex single image editing. To load a photo into MAGIX Photo Designer 7, select the option "Edit photo" in the FX menu of the photo box. Read more on this in the MAGIX Photo Designer 7 Help.

**Dubbing:** If you would like to add spoken commentary to your slideshow, then use the record function for audio recording. A click on the record button (red dot) indicated in the transport console opens the record dialog. You can also use audio CDs, records, or tapes. Audio CD tracks of non-copy-protected CDs and other audio files can be dragged onto the preview photo directly from the Media Pool.
**Timeline mode:** In "Timeline mode" your photos are displayed "temporally". The longer the object remains in the track, the longer the corresponding photo will be displayed during playback. Videos also can be used.

The easiest way to access the Timeline mode is with the Tab key (you can also click on the corresponding link at the left-hand border of the photo bar).

There are four tracks available.

All of the material in project including photos, videos, background music, titles & text, transitions, decorative elements etc. appear as "objects" on a track when imported. If photo or video files include an audio track, a combined object will be created which has image and audio areas.

Image objects can be placed on any track and can easily be moved around with the mouse. Audio objects can be moved to tracks 2-4.

All objects can be resized using the "object handles" on the lower edges. Move the mouse over one of the lower corners of the object until the mouse pointer becomes a double arrow. You can now can compress the object until it is the length you want. An object can be faded in or out with similar handles at the top of the object.

Effects are added as objects underneath the "related object" and create a group that moves along with the "related object".
Divide slideshow

Sometimes you might want to separate your slideshow into two slideshows. For instance, if you discover that you have loaded a certain number of images for a certain subject and would prefer to have this subject in its own slideshow.

- Move the photos you want to sort out to the end of the slideshow. Ideally, you should use overlay mode.
- Switch to Storyboard mode and place the start marker at the position where you would like to split the old slideshow.
- Select “Separate slideshow” in the Edit menu.

This creates a new slideshow where all materials of the old slideshow are moved from the position of the start marker. All contents are moved too: title, soundtrack, transitions, effect settings, object settings...

Finally, you should enter descriptive names for both slideshows. You can do this in the context menu of the slideshow tab.
Create disc menu and burn

Once you are satisfied with your slideshow you can burn it to a disc.

Manage slideshows

You can manage several separate slideshows in one project to burn them together to one disc. In the context menu of the slideshow tab you can add new slideshows or import existing ones as well as remove slideshows that should no longer be a part of that project.

- To do this, right-click on the tab.

You can also embed slideshows from an existing project into your project. Select "File -> Open", find the desired project on the hard drive, and then click "Open". MAGIX PhotoStory on DVD 2013 Deluxe will now ask you if you would like to close the current project or add the new project. Choose the latter option to add the slideshows to your project.

Menu view and menu navigation

To burn a disc, switch to the "Burn" view.

- Click the “Burn” button to get started.

MAGIX PhotoStory on DVD 2013 Deluxe automatically adds graphical disc menu. The menu is also burned to disc and appears when inserted into your player. Just like with a purchased DVD, you can easily select your slideshows with the help of preview pictures, or access particular chapters within a slideshow.

In the “Preview” view in the “Burn” screen you can access complete menu templates and add them by double-clicking.
If you want to adjust them, you first have to switch to the “Edit” view.

- At the center of the monitor you can see a preview of the selection menu. The editable elements are outlined. You can move them around or adjust their size with the mouse.
- Double-clicking on an element opens an editor where you can adjust the titles or preview images.
- There are buttons on the right side that can be used for additional editing of the menu properties.
• Use the “Navigation” button to access the structure of the selection menu.

Here you can switch off all chapters that should not be in the chapter menu. Deactivate the corresponding box.

This way, the entry will be removed from the menu only; the related photo will not be removed from the slideshow. (More than 99 ticks cannot be made as the DVD player cannot list more than 99 entries.)

In the lower section of the screen you can find a whole row of pre-made menu layouts. Use the scroll bar to view each template. There are plenty to choose from:

• If you wish to fully apply a template, first click on “Templates” in the template bar and double-click on the template of your choice. The complete template will then be applied.

• You can also combine the various elements of the individual templates. For example, if you want to combine the text format of a template with the background of another one, then select “Font” first and double click the template with the text of your choice. Then select “Buttons” and double click the button you like. The preview in the middle shows you the results immediately.

• Double click the preview picture or a menu entry to change the movie or chapter name and select a different preview picture.

• Back in the “Preview” view you can use the virtual remote control to test the functioning of finished discs to make sure that everything works as planned.
Disc selection dialog

In the “Preview” view you can open the disc selection dialog by clicking the large “Burn” button.

In the “Edit” view you can access the same dialog using the red button.

Here you can select what kind of disc you would like to create.

- DVD is the right format for projects that will be played back on a normal DVD player.
- Blu-ray and AVCHD are good for playback on high-resolution screens.
Settings

All settings dialogs can be accessed through “File -> Settings”.

Slideshow

The dialog with the settings for the current slideshow are displayed here.

Select preview image automatically: MAGIX PhotoStory on DVD 2013 Deluxe uses an automatically-selected preview image.

Use image file: With a mouse click on the folder button you can open a dialog for loading image files. In this dialog you can navigate to the folder where the image file is found and select it with a double click.

Use preview image from slideshow: Select a frame from the current slideshow using the slider.

Effect settings for the slideshow (view page 84) can be found in “File” > “Settings” > “Slideshow effect settings.”

Project

When creating a new disc project, you can specify multiple settings that will continue to apply to the related slideshows.

Project name: Give your disc project a name. This name will be used as a preset title for the disc you are going to burn. The slideshows will also be given this name.

Use 16:9 aspect ratio for current disc project: This option lets you edit the slideshow from the very beginning in 16:9 format. The video monitor’s size adjusts to correspond to this.

Cut new images to fit screen automatically: Images that do not correspond to the slideshow’s ratio are adjusted automatically. The zoom factor is set in such a way that there are no black bars to the left or right or top and bottom.
Program

You can access the project-independent MAGIX PhotoStory on DVD 2013 Deluxe settings this way. These settings are also global.

Playback

Audio playback

Driver selection: You can set up “DirectSound” here. DirectSound is a component of DirectX that is installed automatically on your PC during program installation (if necessary). If the DirectX system is no longer installed on your PC or no longer works properly, there is a DirectSound installation routine for reinstallation to be found in the “Addon” folder of the MAGIX PhotoStory on DVD 2013 Deluxe program disc.

Output device: Use this option to specify which sound card plays the wave audio objects. This is especially important if you have multiple sound cards installed on your computer.

Audio buffer size: Here you can specify the buffer size that should be used for playback of the entire arrangement or for previewing audio files in the Media Pool.

Arranger

Autoscroll during playback: The screen playback does not follow the playback cursor if it has reached the end of the screen.

Fast: If autoscroll is activated, the screen view automatically shifts when the playback cursor reaches the last quarter of the screen during playback.

Slow: If autoscroll is activated, the screen view automatically shifts when the playback cursor reaches the right edge of the screen during playback. This is particularly useful for longer disc projects.

Warning: Scrolling requires constant recalculation of the screen view, which may lead to interrupted playback if the amount of system RAM is too low. If this happens, simply deactivate the autoscroll feature.

Image material playback

Resizing high-quality image material: Use this feature to improve the quality during resizing, particularly when downsizing to less than half of the original size (e.g. for picture-in-picture effects). This, on the other hand, requires more processing power.

Note: Switching off this option has no effect on quality during exporting/burning.

Load image material in background: Image material will be loaded in the background so that it can still be edited during the loading process.
**Paths**

**Projects:** The standard path for all projects (*.<projektdatei>*)

**Exports:** The standard path for all file exports via the command “File” > “Export”

**Audio import:** The standard path for all imported (music) files.

**Disc images:** Specify the path for the folder where MAGIX PhotoStory on DVD 2013 Deluxe saves the temporary files required for creating a disc.

**Menu Editor:** Determines the Menu Editor path, which can be started using the “Burn” interface.

**Options**
Here you can specify the most important options for the behavior and display of MAGIX PhotoStory on DVD 2013 Deluxe.

**Keyboard shortcut:** P

**Video standard**
PAL is used in Europe; the US and Japan use NTSC. This setting should not be changed.

**Preview**
The resolution can be reduced for video decoding, but this only has an effect while preview editing. If playback becomes jerky, then we recommend entering a lower value. The quality of exported videos is not influenced by this.

**Video options**

**High output quality for dynamic zoom and combination effects:** If this option is set, a newly developed zoom algorithm will be used that provides results that are much more accurate. You should, however, only use this option if you own a PC that is capable of handling processor-heavy tasks. Otherwise the export (and invariably the creation of a disc) can take a lot longer.

**Other**

**Reactivate warning dialogs:** In its newly installed state, MAGIX PhotoStory on DVD 2013 Deluxe displays a number of security queries at various parts of the program. Each of them can be switched off by clicking the small box at the bottom that says “Don’t show this message again”. To display these warning messages, select the this option.

**Configure online services:** Here you can configure the online services that you use. This function requires an Internet connection.
System

Fade photos automatically with dissolves: When loading photos, they will automatically fade from one into the other using a dissolve effect (view page 73).

Automatically create frametable during import: Sometimes, rebuilding a frame table can get rid of problems in certain MPEG files. For example, such problems can be present if the navigation (positioning of the playback marker, transport) is bumpy or doesn’t function at all. Normally, when loading MPEG video, a frame table is not created in order to speed up the loading process. If you do create one anyway, MPEG files are normally noticeably faster and easier to edit.

Import CD tracks through record dialog: If this option is activated, you can record audio CDs using the record button in the transport console. When dragging & dropping from the File Managers the record window where recording starts will be opened. This option can be used if drag & drop through the File Manager is not working properly, or if you want to record the first bars of an incomplete CD track in the arrangement. You should note that the digital track data from the digital analog converters of the CD-ROM drive have to be converted into analog signals and then into digital data by the analog-digital converters. Depending on the quality of the converter used, this can lead to a loss in quality.

Automatic preview when changing transition: When this option is activated, a short preview of the transition effect will be quickly played between the two objects you selected.

Project setting “Cut to fit monitor automatically” affects videos: If this option is active, then videos will be cut to avoid black edges. The property “Cut to fit monitor automatically” must be activated for the project.

Preview images in the background: The update of the object display after move and zoom operations in the arranger is performed in the background in order to let you work smoothly.

Relocate memory for bitmaps to other process: Activating this option will improve handling of bitmaps as they will be processed differently.

Hide news: This option deactivates the MAGIX News Center (view page 11) in the main interface of MAGIX PhotoStory on DVD 2013 Deluxe.

Facial recognition for zoom shots and automatic sections: MAGIX PhotoStory on DVD 2013 Deluxe recognizes faces in your photos and adjusts the photos so that faces aren’t cut out when changing sections or zoom level.

Automatic preview of export clips: If you export a slideshow as a video file, it will be played immediately after being created.
Hardware acceleration during MPEG-4/AVCHD export if possible: Here you can activate Hardware acceleration (view page 182) during MPEG-4/AVCHD export if your system supports it.

**Standard picture length**
Here you can adjust the default display duration of the selected photo. This can be changed again at any time.

**Display**
**Video mode:** Set up the playback mode in the Arranger here. You have the choice of:

- **Compatibility mode:** This mode works on all systems. Activate this mode if there are problems with playback.
- **Standard mode:** This mode offers extreme speed boosts by letting the mixing, many effects and various transitions be calculated directly on the graphics card. Depending on the graphics card, performance can increase by 300%. The graphics card will not be used during export.

**Warning!** To use this mode the graphics card must posses at least 128 MB memory. You will need to install Direct 3D 9 or higher, and the graphics card driver must support “High Level Pixel Shader Language 2.0”. MAGIX PhotoStory on DVD 2013 Deluxe checks the corresponding properties when this mode is selected, and switches it off if necessary.

- **Alternative mode 1:** This mode performs hardware-based deinterlacing for output onto a PC screen or a projector, whereby the playback quality is significantly better than with interlaced analog video recordings.
- **Alternative mode 2:** This mode uses the hardware de-interlacing function of modern graphics cards together with DirectX 9. Make sure that you are using the most recent version of your graphics card driver, which must be compatible with DirectX 9 to function properly. This mode is only superior to “Overlay mixer” mode with a limited number of graphics card models.

**Deinterlacing:** In the DirectShow modes “Overlay Mixer” and “Video Mixing Renderer 9”, you can activate hardware de-interlacing with your graphics card. For general information about de-interlacing and the options “Top/bottom field first”, please read the corresponding article “De-interlacing (view page 194)” in the manual.

**Image formation in the Vertical Blank Interval (VIB):** Image formation takes place in the vertical blank intervals of the monitor signal (or the connected TV signal). This helps avoid image interruptions.

**Warning:** Because of waiting time required for the next VBI, this process adds significant computational time!
For digital displays like the TFT monitors you can deactivate the option. In the Overlay mode image formation occurs exclusively in VBI.

**Use high resolution for fullscreen playback:**

*Note:* This option is available only in the standard mode (hardware acceleration Direct3D).

If the option is activated, image resolution during preview will be increased. This demands more computer resources, but is not a problem for most graphics cards. You should deactivate this option only if you have problems with fullscreen playback.
Screen: Slideshow

When you start MAGiX PhotoStory on DVD 2013 Deluxe you’ll see a slideshow window. This is where you load photos and edit your slideshow. This screen provides access to almost all the features that are necessary for creating perfect slideshows.

1. **Menu bar** (view page 152)
2. **“Slideshow” interface** (view page 35) for creating and editing your slideshows.
3. **“Burn” interface** (view page 123) for burning slideshows to disc.
4. Use **“Output” dialog** (view page 145) for all other slideshow uses.
5. **Media Pool** (view page 48) for navigating through the folders of your computer.
6. **Video monitor** (view page 36) with universal preview function so that you always see what the effects and settings do.
7. **Video monitor transport console** (view page 36)
8. **Buttons** for quickly toggling between the three screens: Overview mode (view page 43), Timeline mode (view page 45), and Storyboard mode (view page 44).
9. **Arranger (Storyboard mode):** All the pictures of your slideshow are shown here including preview photos.
Video monitor and transport console

Use the video monitor to preview the current slideshow. With the button “Full screen” you can switch to full screen playback. Press the “Esc” key to return to normal playback. The transport console can be used to begin playback of the slideshow. It can be found below the video monitor.

- **Play/Pause**: The “Play” button in the middle starts endless playback of the slideshow: The range between the start and end markers is played back as a loop (“infinite”, recurring). Clicking on the play button a second time pauses playback.
- **Stop**: The “Stop” button ends playback.
- **Back**: This button moves the start marker to the previous picture. This is displayed in the video monitor. During playback you can use this button to rewind.
- **Forward**: This button moves the start marker to the next picture. This is displayed in the video monitor. During playback you can use this button to fast-forward.

**Note**: You can fast-forward or rewind using the cursor (arrow buttons) on your keyboard. Why not also try out the additional functionality of the CTRL or Shift buttons.

- **Back to start**: With this button the start marker is quickly moved to the beginning of the slideshow.
- **Recording**: The “Slideshow” window offers audio recording. New audio is inserted at the position of the start marker, e.g. commentary.

www.magix.com
**Stereo3D:** Here you can set up the mode for stereoscopic playback. More information is available in Stereo3D (view page 115).

**Zoom:** Click on the arrow and set the zoom level in the preview monitor.

Use the position slider to move quickly within the project. The current position of the playback marker is displayed numerically on the right.

### Zoom in video monitor

The video monitor includes a zoom function for zooming into a certain position for editing, e.g. to select colors exactly.

**Shortcuts:**
- zoom: Ctrl + Mouse wheel
- Reset zoom (100%): Ctrl + double click
- Move section with the mouse: Ctrl

**Note:** The zoom function is not involved with section selection, but is only a view option and is not included during export or burning!

### Toolbar

Important editing and effects menu commands are available as buttons in the slideshow window. There are different buttons available for each mode.

**Top Toolbar**

This toolbar lies directly under the menu or the video monitor of the MAGIX PhotoStory on DVD 2013 Deluxe.

**New project**

This menu item creates a new MAGIX PhotoStory on DVD 2013 Deluxe project. You can also open this feature via the "New project" button above the video monitor.

**Keyboard shortcut:** Shift + N
Load project
This menu item loads a previously saved MAGIX PhotoStory on DVD 2013 Deluxe project. Please note that the related files must be accessible.

MAGIX PhotoStory on DVD 2013 Deluxe searches for the used sounds, pictures and videos under the path to where you last saved the disc project.

Keyboard shortcut: Ctrl + O

Save project
The current disc project is saved with the name displayed in the project window. If you have not yet specified a name for your project, a dialog will open wherein MAGIX PhotoStory on DVD 2013 Deluxe asks you to do so.

Keyboard shortcut: Ctrl + Alt + S

Import files from camera
Here you can import all available data from your digital camera into MAGIX PhotoStory on DVD 2013 Deluxe.

Source: Select the path for your digital camera’s memory card.

Save in following folder: Here you can specify where the imported files will be saved.

Select: Specify which files should be imported: “All” “New only” since the last import or “None”. Delete the selected files using the “X” symbol.
Import individual images by ticking the box next to the image in the selection field. Subsequently the image will be displayed in the preview monitor.

**View filter:** You can choose to display either all “Movies” and “Photos” or “Display selected only”.

Adjust the preview image size using the slider. This option is only available if “Large icons” is selected in the view menu.

Select whether you want to see “Large icons” or a list with “Details” on the files.

**Import options:** Specify whether the files should be imported into the slideshow directly (“Import to slideshow”) and whether the files should be deleted from the camera after importing from the memory card (“Delete selected files after importing from camera”)

If you have entered all settings, then click on “Import”

**Slideshow Maker**

This is where to open Slideshow Maker.

**Undo**

You can undo the last steps you made. This means that you can easily try out critical operations. If the result does not meet your expectations, then you can simply “undo” it and return to the initial status.

Keyboard shortcut: Ctrl + Z

**Redo**

This function undoes the previous “Undo” function.

Keyboard shortcut: Ctrl + Y

**Lower toolbar**

The following buttons are visible in all modes of the “Edit” surface directly under the video monitor.

**Cut button and editing menu**

The cut button and cut menu next to it can be found under the transport console.
Use the cut button to cut a selected object in two at the position of the start marker.

With a click on the small arrow beside the cut button, you can access the cut menu which contains further relevant commands.

**Split object**

This command cuts a scene at the point where the start marker is positioned. This way, two free-standing objects are created.

You can isolate a part of an object in order to delete it:

1. Place the start marker where you’d like to have it by left clicking in the timeline.
2. Select the video object by clicking on it and click on the cut button.
3. Place the start marker at the end of the part you wish to remove and click on the cut button again.
4. Select the middle object that was created and press the "DEL" key.
5. Pull the object at the back to the front; it should automatically snap into place. All subsequent objects will be moved along in unison so that no gaps appear.

You can also use this function to apply effects to a certain part of an object only.

Keyboard shortcut: T

**Remove scene start**

This command cuts a selected object at the point where the playback marker is positioned and removes the material before the playback marker.

Keyboard shortcut: D

**Remove object end**

This command cuts a selected object at the playback marker position and removes the material behind the playback marker.

Keyboard shortcut: U

**Hint:** If the commands “Split” and “Remove beginning/end” are applied without a selection, all objects at the position of the playback marker are cut.
Split slideshow
This command splits the slideshow at the point where the start marker is positioned, making two separate slideshows.

**Note:** You can use this function if you wish to include chapter menus and if your slideshow already contains over 99 photos. Otherwise, only every second or third photo (depending on the number of photos) in the chapter menu, as the number of menu entries is technically limited to 99.

Keyboard shortcut: Alt + W

Delete
This command deletes the selected photo (or selected object) in Timeline mode.

Keyboard shortcut: Del

Cut
This function deletes the selected photo (or the selected object in the Timeline mode) and copies it to the clipboard. You can then use the “Paste” command to copy it into any slideshow.

Keyboard shortcut: Ctrl + X

Copy
This command copies the selected scenes (or the selected object in Timeline mode) to the clipboard. From there you can paste it into any other slideshow using the “Paste” command.

Keyboard shortcut: Ctrl + C

Paste
This command inserts the clipboard material (photo or object) at the current position of the start marker.

Keyboard shortcut: Ctrl + V

Exchange object
Replaces the selected object with an object selected in the Media Pool. Length adjustment moves the objects following it correspondingly.

If photo objects are removed/exchanged, then the display duration will remain.
Background design
Select a color, a picture, or any video on your hard disk, which you would like to serve as the background for the photo displayed. This function is especially useful when photos have black bars around them, or if they are reduced in size.

Automatic image effects
Camera movements, zooms and rotation effects are added to the current slideshow automatically. If you have already added effects and transitions manually, they will not be affected by this process.

You can apply this function to the entire slideshow or to a specific range that you can select by setting the start and end markers.

Also in Timeline mode and Overview mode
The buttons listed here are also visible in the Timeline mode and Overview mode

Title editor
Opens the title editor (More information can be found in the section “Title editor” on page 67) for the selected photo or video object.
Shortcut: Ctrl + T

Rotate right
Rotates the photo 90° clockwise.
Keyboard shortcuts:
Ctrl + Alt + F to the right
Ctrl + Alt + G to the left

Only in Timeline mode
The following buttons are found exclusively in Timeline mode.

Mouse mode for individual objects
This mouse mode for individual objects enables free positioning of individual objects.

Optimize grid view
The start and end markers are moved to the start or end so that all scenes are visible and the complete film can be played. Zoom is also set to 100% so that all objects are visible.
Keyboard shortcut: Shift + B
Connect objects in all tracks

In this mouse mode all objects located behind the one selected will be moved in unison.

Start and end markers

The range between the start and end markers is played just above the first track.

The start and end markers can be set with a mouse-click in the timeline. A left-click sets the start marker and a right-click sets the end marker.

The play marker is a red vertical line which moves from left to right during playback. It indicates the current play position.

Note: The start marker can also be shifted using the arrow buttons on your computer keyboard. The “Forwards/Back” buttons on the transport controls move the start marker to the next or previous picture, which can then be seen immediately in the video monitor.

Mute sound

Shuts off the entire audio playback temporarily. This only affects the preview, not the disc that is finally produced. This button is located below to the right in the program window.

Overview mode

“Overview mode” is a special slideshow viewing mode that helps clarity and maintenance of the photos. All photos are listed one after the other (in multiple lines, like in a text program) and can be copied, cut, moved, deleted, and inserted.
There are no start, play, or end markers in Overview Mode. The photo that is to be played is fitted with a border and highlighted in blue allowing you to see where to find the photo that is currently playing.

This slider specifies how large the photos will appear in the storyboard. The smaller the photos, the more you'll be able to fit on screen.

Use this button to maximize the overview mode to fullscreen.

**Storyboard mode**

Storyboard mode is used to view the layout of slideshows. All photos are displayed in linear sequence with preview images. It includes different buttons, text, effects, rotation, time settings and transitions.

---

**Text:** The title editor is opened. Enter text, e.g. for subtitles, lead or end credits.

Texts can be displayed in all kinds of fonts and colors. To make your credits scroll down the screen (just like it should be), you can select different movements, effects, and designs from the template menu.

**Effects:** In the “Effects” menu or by clicking on “FX” you can select the effects for editing sounds and images.

You can use the option “Edit photo” to open the photo in the separate image editing program MAGIX Photo Designer 7. After editing the image, it is transferred directly to the MAGIX PhotoStory on DVD 2013 Deluxe storyboard.

**Note:** For more info on using MAGIX Photo Designer 7 please read its help file which you can open by pressing the F1 key.
Rotate: If a photo is on its side or upside down, click on the Rotate button. The photo will rotate 90 degrees. You can check the effects directly on the video monitor.

Playback: The range between the start and end markers in the upper half of the storyboard is the section which will be played back. Both markers can be set directly with the mouse by left-clicking or right-clicking. Use the spacebar to start and stop playback most effectively. Of course you can also control the playback functions by using the transport control below the preview monitor.

Playback marker: The playback marker will show which object is currently being played. It is a vertical line that runs from left to right over the scene as it is being played back.

Transitions (Fades): You can also set up the transitions from one photo to the next by mouse-clicking on the symbol. A menu will open from which you can select different transitions (view page 73).

Timeline mode

In "Timeline mode" your photos are displayed in order: The longer the object remains in the track, the longer the corresponding photo will be displayed during the slideshow. Unlike Storyboard mode, the speed of the playback marker does not change on playback. You also have direct access to all media files currently being used in the slideshow.

Timeline

The progress of the slideshow in the movie is displayed horizontally above the tracks. To structure this progression, the actual timeline is visible at the very top above the first track. The unit of measurement of the timeline is milliseconds.

The range between the start and end markers in the timeline is played back as an endless loop.
Tracks
There are 4 tracks in total for arranging and editing media files:

- Photos, videos and titles can be put on any of the tracks, even on top of one another, e.g. to create a picture-in-picture effect.
- The fourth track is for additional audio material. Additional audio recordings (view page 86) (also called „overdubs“) can be placed here, e.g. commentary. But audio objects can also be moved to tracks 2 and 3.

Zooming
**Keyboard shortcut:** The easiest way to zoom is by using the key combination Ctrl + Up arrow (for zooming in) and Ctrl + Down arrow (for zooming out).

**Zoom menu:** Right-clicking on the start marker opens the context menu where you can select the most important zoom levels.

**Sliders:** Use the slider (“fader”) to adjust the visible clip on the horizontal time axis. Alternatively you can use the mousewheel to zoom in and out.

Objects
All of the material in project including photos, videos, background music, titles & text, transitions, decorative elements etc. appear as “objects” on a track when imported.

All objects can be cut uniformly, edited with effects and arranged. During playback all objects on all tracks are mixed together automatically. When moving a photo, all related objects will be moved along with it, for example, audio recordings, frames and text objects.
Combined objects
If photo or video files include an audio track, a combined object will be created which has image and audio areas. The video sound will be displayed as a waveform in the lower area.

The audio track can be removed and reinserted into the combined object by right-clicking. The automatic volume reduction (view page 114) and sound optimization (view page 81) can also be started (in “Audio and waveform display”).

Object cutting and fades
All objects can be shortened with their lower edge “object handles”. Move the mouse over one of the lower corners of the object until the mouse pointer becomes a stretch symbol. You can now compress the object until it is the length you want. At the top ends of every object you’ll find two fade handles that can be adjusted to fade an object in or out.

Context menu
Right-clicking on an object opens the context menu with effects. It is equipped with the same effects as in the Storyboard mode and the Effects menu.

Duplicate objects
Small objects (for example, audio loops) can be duplicated very easily. First, the objects that need to be duplicated must be selected. Activate the copy command and then the Insert command (“Edit” menu or via the buttons in the Timeline mode).

Speed up this process by clicking on the object to be copied with the mouse while holding down the “Ctrl” key. This generates a copy which you can immediately drag to the desired position.

Mouse modes
With these mouse modes you can specify various working methods of MAGIX PhotoStory on DVD 2013 Deluxe when moving objects.

Mouse mode for individual objects
This mouse mode for individual objects enables free positioning of individual objects.
Connect objects in all tracks

In this mouse mode all objects located behind the one selected will be moved in unison.

Media Pool

The structure and functioning of the Media Pool is similar to Windows Explorer with the only difference being that the Media Pool only displays usable files. This is used to access and load multimedia files of all kinds: photos and other image files, video files, audio files, transitions, effects, and also complete projects.

Note: The Media Pool displays the files on your hard drive. If you delete files here, you won’t be able to find them again using Windows Explorer.

If you hover the mouse pointer over a media file, two icons for the options will appear: playback (preview) and import.

• **Preview:** All media files can be played back using this function. If you click on the playback icon, the file will be played back in the preview monitor. Video and image files are displayed and audio files are played back through the sound card. There are previews for the templates and effects included to make it clear how they will function.

• **Import:** All media files from local drives or the Internet can be dragged and dropped into the project or loaded through the Import icon.

You can also load files from the Media Pool by double-clicking. Selected entries (including entire folders) can be selected by holding down the left mouse button and dragging them into the slideshow (drag & drop). If you want to load several files simultaneously, you first have to select them in the Media Pool.
• Click on the selected entries one after the other while holding down "Ctrl" to select them one after the other.
• If you would like to load a sequence of files, hold the Shift key and first click on the first entry, then on the last. All entries in between are marked.
• By holding down the left mouse button you can select drag out a selection box over multiple picture files to select them. "CTRL + A" selects every entry contained in a Media Pool folder.

Tip: Improve access to your media folder by creating a link in the "Import" area of the Media Pool. You can do this by right-clicking on one of the entries and selecting "Create link". Select the media folder and click "OK" to confirm.

Note: All links are automatically deleted if the function "Reset standard program settings" ("Edit" menu > "Settings") is used.

Media

Search
The Media Pool has an easy search function for finding files on the computer. It may be activated and turned off again with the shown button.

**File name:** Enter any part of the name of the file you are looking for in the “File name” field. The X symbol deletes the entry. A "?" may be used as a placeholder for a single character, and "*" for any number of characters.

**File type:** Here you can enter a file name extension. Multiple entries are separated using a semicolon. Below the entry field, various presets may be selected for often-used file name extensions.

**Date:** Here, you can set time period limits on your search. Choose an entry from the list.

**Folder:** If you don’t want to search the entire computer, but only look on certain drives or in a single folder, you can define a certain search path.

**Search depth:** Here you have various options that determine whether additional locations should be searched.

• Search indexed locations and the selected folder
Search indexed locations, the selected folder and personal files.

Search indexed locations, the selected folder, personal files and the project file.

“Indexed locations” are folders, which are searched and cataloged in Windows via the index list. If the index list is activated, the files in the indicated folders will be indexed while the computer is idling, so that the user’s search query may be completed faster.

**Note:** In Microsoft Windows XP, the indexing service is usually deactivated by default. The search functions in Windows Vista® may be installed with the current version of “Windows Search”. They make it possible to easily add to the indexing service. Please refer to the installation instructions from Microsoft.

### Deleting, copying, and moving files

All files listed in the file list can be selected, deleted or moved/shifted (by holding down the mouse button and using drag & drop to move them) into other folders just like in Windows® Explorer. This way, all objects that come into question to be used in a slideshow can be compiled into a separate folder beforehand.

The selection of these functions can be executed via the context menu which can be opened by right-clicking the entry.

All the context menu’s functions can also be accessed via this button.

### Navigation buttons

The navigation buttons let you navigate through your computer’s drives and folders.

- **Forward/back**
  - These buttons access the previously viewed folders.

- **Up**
  - This button accesses the next highest folder level.

- **Search**
  - The search function allows you to find specific files quickly. You may specify your search according to file type, date, or certain folders.

- **Browse history list and path details**
  - The path information for the current folder is displayed in the center above. Use the arrow button to open the menu to find the folders you previously visited.

- **Options**
  - All functions of the context menu (switch views, rename, or delete files, etc.) can also be accessed using the options button.

- **Display options**
  - Settings for how detailed the entries should be listed may be made here.
Display options

To get a preview of the image files directly in the Media Pool, click on the display options at the top right and select “Large icons”.

Now all image files in the Media Pool will be displayed with a small preview image.

Computer
The link button “Computer” displays the drives in the Media Pool. All drives will be listed along with their drive letters and can be opened with a double click.

User directory
The second button featuring the user’s name opens their personal folder in the Media Pool.

My Media
Projects: Here you can change the folder, where your projects and slideshows will be saved by default.

My pictures: Switches to the “My documents\My pictures” folder. This folder is often used by digital cameras and scanners to store transferred images by default. The
included MAGIX Photo Manager program also uses this folder (e.g. during image import).

**My videos:** Displays all usable files found in "My documents\My videos."

**My music:** Displays the contents of the "My Documents\My Music" folder. MAGIX Music Manager also suggests this folder for importing your music collection into the database.

**Slideshow music**

**Slideshow music:** This directory contains various songs that may be used by Slideshow Maker.

**MAGIX media**

**Movie trailers:** MAGIX PhotoStory on DVD 2013 Deluxe includes ready-made trailer projects for a range of styles (e.g. action, documentary, travel...) in which you can replace (view page 110) the integrated placeholders with your own photos.

**Animations (.xar):** If you have an external editor such as Xara Designer Pro or MAGIX Web Designer installed on your computer, there are ready-made animations available that can be dragged and dropped into an object. The external editor will open to let you "fill" the animation. When the editor is closed, the animation will be inserted under the object.

**Manage...:** This opens the database management program MAGIX Photo Manager. It creates and organizes the database, which can be easily accessed by MAGIX PhotoStory on DVD 2013 Deluxe.

**Database:** Use this button to open the database view. Right-clicking opens the database search. The database first must be created using the provided additional programs MAGIX Photo Manager and/or MAGIX Music Manager.

**Online Album:** This button opens MAGIX Online Album. This provides a shortcut for uploading and deleting data. To do this, you must first register on MAGIX Online Album.

There are many ways to upload data:

1. While holding “Ctrl” down, select the data to be uploaded in the Media Pool, and select “Copy” in the context menu (opened by right clicking). Switch to the MAGIX Online Album screen, open the desired folder, and select “Paste” in the context menu.

2. In the Media Pool, click on “Online Album”, and go to the desired directory. Open the Windows Explorer, select the desired data with “Ctrl” held down, and drag it into the Media Pool.

Both options will result in your data being uploaded to your MAGIX Online Album.
Note: This function requires an Internet connection. Make sure you have your login details (email address and password) ready.

Downloads: Use this button to access the media files that you downloaded with Catooh.

Travel routes
Click here if you would like to create a travel route (view page 103).

Fades
Here you can find all fades from MAGIX PhotoStory on DVD 2013 Deluxe, sorted into various categories. One click on a category displays all of the fades that are contained.

To load a fade, drag it with a held-down mouse key onto the object, into which you would like to fade.

You can find additional information in the “Fades” (view page 73) section.

Title
This displays the title settings and the title editor. These presets are sorted into different categories and may be loaded by double-clicking or drag & drop. The 3D title templates are also located here.

The text featured by title objects may be changed directly in the program monitor by double-clicking.

Effects
This provides access to the effects that are sorted into the various categories. Read more about this in the chapter “Effects”.

Templates
Most effects categories contain many useful templates that can be added simply by double clicking them. A single click provides a preview.
Image optimization

Brightness

Auto brightness: This button automatically optimizes brightness and contrast with one click. For specific adjustments, use the slider in the dialog.

Brightness/contrast: Using the sliders, you can raise or lower brightness and contrast of the image.

Gamma: Set the middle grey value, which can be determined from various color areas. In the preset list, select various areas to edit only the dark, median, or brightest areas of the image. Using the fader you can also set the power of the brightness/darkness adjustments.
Color

Red Eye Removal
Using this photo function, you can remove the unnatural red eye effect which results from using a flash. Click on the eye symbol and then select the red pupils in the preview monitor using the mouse.

Hint: We recommend using MAGIX Photo Manager for photo optimization. The program is installed automatically and can be used for quickly and easily optimizing your photos. It has a tool for correcting red eye and setting auto color and white balance to control discoloration in pictures.

For more complex editing like photo panorama and photo filter effects, a separate image processing program MAGIX Photo Designer 7 is included. Users of the classic version can download the software at any time for free. To load a photo into MAGIX Photo Designer 7, select the option “Edit” in the FX menu of the photo box. Read more on this in the MAGIX Photo Designer 7 Help.

White balance
All light is not the same. Depending on whether it is sunlight or artificial light, this will have an effect on color variation. The human brain is able to compensate for this variation: A white sheet of paper will still look white under candlelight, although it is in fact much more yellow than by daylight.
In order to imitate this filtering done by the brain, a camera must also analyze and correct the light. White balance does the same thing to a picture that the brain does by setting the camera to the so-called “color temperature” of the surroundings.

If you do not possess a camera which performs this function automatically, you can apply the white balance function in MAGiX PhotoStory on DVD 2013 Deluxe.

An incorrect white balance can lead to an unnatural blue or red hue.

**Directions:** To use the white balance, click on the button to the right of the label “White balance” and then select a point which represents white or a neutral gray to the “outside world”. The color temperature is then corrected automatically.

**Tip:** Cool color effects can be achieved by setting a different color as the white benchmark. There is definitely room for experimentation!

**Color shade**
Select a color for coloring the image from the color chart.

**Red/Green/Blue**
Using the “Red/Green/Blue” slider, you can change the color portion mix for each color.

**Saturation**
You can increase or reduce the color portions of images with the “saturation” fader. A newly developed algorithm is applied which makes color changes related to other parameters (for example contrast settings) in order to achieve the most natural coloration possible. With just a little bit of experimentation, you can achieve astounding results – anything from turning summer snapshots into autumnal scenes to funky pop art!
Secondary color correction allows individual colors in video and image objects to be adjusted. Choose “Selected” or “Not selected” in order to edit the desired ranges separately. The entire image may also be influenced (“Complete image”).

“Selected” corresponds with the mask created, and “Not selected” involves the rest of the picture. Here’s how to create a mask:

• Activate “Add”.
• Place the mouse over the preview monitor. The mouse pointer turns into a pipette tool.
• Click with the pipette tool on the color in the program monitor that you would like to assign to the mask. Unwanted colors can be removed from the selection again by selecting “Remove” and clicking the corresponding color again.

MAGIX PhotoStory on DVD 2013 Deluxe displays the mask in black and white stripes to highlight the current selection.

• Adjust the color using the color selection slider until it is satisfactory.
**Sharpen**: The fader allows you to regulate the level of image sharpness or apply a soft filter.

**Apply to**: Allows you to set just how much the sharpness settings should be applied to surfaces or to edges. This enables you to effectively reduce ongoing image distortions (noise).

**Artificial blur**: Here you can apply various soft filters. The achieved effects are much stronger compared to simply sliding the controller under “Sharpen”.

**Tip**: Artificial blur achieves good effects when used for transitions. Edit the front image so that it is out of focus and let the image that follows appear blurry before it is displayed again normally.

**Distortion**

A large palette of effects for transforming your image material is available.
Art filter

Erosion: The image is broken-up by means of small rectangles and resembles a "patchwork".

Dilate: This works like erosion, but uses light surfaces instead of dark ones to form the rectangle.

Emboss creates a relief of the image edges, in which case strong contrast differences are interpreted as edges.

Substitution: Using the rainbow scale red, green, and blue components are exchanged. Quickly create surreal landscapes or a green face!

Move: The color values are inverted increasingly. Blue colors turn red, and green appears purple.

Quantize: Depending on the setting, colors are either rounded up or down so that the overall number of colors is reduced. This creates interesting grids and patterns.

Colorize: Using this slider, color in the video with red, green, and blue colors (the basic TV colors).

Contour: The image is reduced to its contours in two sizes (3 x 3 or 5 x 5). It is possible to select either vertical or horizontal contours.
Motion: Moving parts of the image are enhanced and warped.

Echo: The moving images create an optical "echo"; previous images stand still and gradually turn paler until they completely disappear.

Whirlpool: The image is twisted into an "S" shape.

Fisheye: The perspective is distorted as if the image were viewed through a fisheye lens.

Mosaic: The video is depicted as a mosaic.

Lens: The image is dynamically distorted at the edges.

Sand: The image is depicted in a granulated manner.

Kaleidoscope: The left upper corner is mirrored horizontally and vertically.

Mirror horizontal/vertical center: The object is mirrored vertically or horizontally – it appears on its side or upside down.
Speed

The playing speed can be adjusted with the slider control. The range between 0 and 1 plays the video slowly; values above 1 accelerate playback. If the playing speed is increased, the object length in the arranger is automatically shortened.

Reverse: This button reverses the playback direction (with the same tempo).

View & animation

Section

Cropped cutaways can be used to

• display just one section of the photo.
• to move the clip through the picture with the help of a movement effect – the result is a type of camera movement. Read more about this in the chapter “Movement”.

In the program monitor, you can set a picture section to serve as the basis for the movement effect. Press the left mouse button and drag out the section you want to use.
In this menu, you can select the format for the section.

The format of the original picture is used as the default.

**Fullscreen:** If this check box is selected, the opened section will be zoomed to fullscreen. If this option is switched off, it won't be possible to add movement to the section.

**Camera/zoom**

With this effect, you can move a previously selected frame inside the image, creating an impression of camera movement or zoom.

**Movement in direction**

Determine the direction in which the selected section or image will move in the process during the time selected under "time period". In addition to horizontal and vertical movements, diagonal movements are also possible.

**Preview:** Displays a preview of the section at the playback marker location.

**Direction & time**

- **Zoom out:** The selected picture section is displayed and then zoomed out to show the entire picture according to the value set in “Time”. If no portion is previously set, a central portion of 50% of the picture is set.

- **Zoom in:** The entire picture is displayed and then zoomed in to show only a smaller picture section according to the time set in “Timeframe”. If no portion is previously set, a central portion of 50% of the picture is set.
**Duration**

The option selected here sets the position where the keyframes of each movement effect are set by default. You determine the positions where a movement begins and ends.

**Note**: Automatically placed keyframes may be edited retroactively, and the option will then be set to "Use custom settings". Read the section “Retroactively editing an effect’s keyframes” in the chapter “Objects”.

**Reset**: This option applies a static zoom to show the selected section of the picture only.

The size and the position of the image can be roughly entered in the program monitor by simply moving the image into it and dragging on the handles. The frame of the video monitor with handles can also be moved with the keyboard.

**Keyboard shortcuts for moving the edges of the frame that are visible in the video monitor:**

- Nudge the screen 1 pixel: Arrow keys
- Nudge the screen 5 percent: Shift + arrow keys

For animated movement effects, it often makes sense to zoom out of the video monitor and use the resulting workspace to, for example, let a minimized image or text object move through the picture.

**Keyboard shortcuts for the preview picture:**

- Thumbnail zoom in/out: Ctrl + mouse wheel
- Move thumbnail: Ctrl + left mouse button + drag

See the “Animation from outside of the image” section for more detail.
**Size/Position**

**Values in:** Set whether the values are applied in percent or pixels.

**Position**

**Left:** Enter the start position from the left image border.

**Top:** Enter the start position from the top image border.

**Center:** Based on the current image size, the image starting points (left and top) will be positioned so that they are centered.

**Note:** Negative values can, of course, also be entered. The image borders will then be outside of the visible area.

**Size**

**Width:** Enter the width of the image.

**Height:** Enter the height of the image here.

**Maximize:** The image will be maximized according to the movie’s resolution.

**Set original size:** The image will be scaled to its original size.

**Keep proportions:** This option makes sure that the image will not be stretched or distorted. The proportions of width to height will remain the same.
Mirror & Rotate

This button resets all of the current settings.

**Note**: If you animated the object using keyframes, resetting will affect the entire animation. Individual keyframes can be deleted during animation.

**Rotate**
- Rotates the image on the horizontal axis.
- Rotates the image on the vertical axis.
- Rotates the image around its center point.

**Straighten horizon**
The image can be rotated around the axis using the slider. The image is automatically zoomed to avoid black edges.

**Show guidelines**: Activating this check box displays a grid in the program monitor for orientation during horizontal straightening.
**Zoom automatically:** This function is preset to active. Unwanted black borders that result from horizon straightening are eliminated by zooming in on the image.

**Note:** If the image format does not completely conform to the current movie format and already has black borders, these cannot be eliminated with the horizon straightening function.

**Mirror**
- Mirrors the image on the vertical axis.
- Mirrors the image on the horizontal axis.
- Rotates the image 90° clockwise.
- Rotates the image 90° counterclockwise.

**Angle & shape**
This makes real 3D positioning of images possible, letting you distort the image in space and move it. Here you can enter the individual corner points numerically or move them in the program monitor using the mouse.

This button resets all settings.

**Stereo3D in the Media Pool**
This accesses the program’s Stereo 3D functionality. Please read the corresponding chapter “Stereo3D”. (view page 115)
Design

Decoration
Under “Decoration” you will find plenty of choices for pepping up your slideshow. You will also find various categories of decorative objects which serve to orient you during selection.

All you need to do is click the corresponding element and you can start playback by pressing the space bar.

Filmstrips: With the start and end markers in the filmstrip you can specify at which point you wish the decoration to appear and when it should finish.

Double arrows: A category usually contains more elements than can be seen at first. Use the double arrows to switch to the previous and next pages of each category.

Style
Below this point you can find all the styles from Slideshow Maker, which can be used on individual photos. Select the corresponding style by either double-clicking it or by dragging it onto an image whilst holding down the left mouse button.

Background
MAGIX PhotoStory on DVD 2013 Deluxe provides diverse backgrounds that can be used in many different ways. Simply drag & drop the desired background at the position you want.

Upright-format effects
Here you can select individual effects that are especially made for vertically formatted photos.

Hint: This option does not appear for photos in horizontal format.

Intros / Outros
These are beginning and end scenes for slideshows with various themes.

Picture-in-picture collages
These work similarly to normal picture-in-picture effects, but more objects are used. Depending on the collage, arrange the selected objects one after the other and drag the collage onto the first object.
Title editor

Titles can be used for many applications: as a running text (ticker), subtitles, speech and thought bubbles, to display date and time, and much more.

Pressing the text button opens the Title Editor.

Enter text, e.g. for subtitles, lead or end credits in the video monitor. Texts can be displayed in all kinds of fonts and colors.

If you want to format individual words or letters, select them with the mouse and choose a different format or color. If no selection is made, the entire text will be formatted.
Creating titles using a template

The Media Pool includes the tab “Title” with folders filled with additional, thematically named title templates.

• Open one of these entries and select any title template. A simple mouse click provides a preview, and double clicking creates a title object using the template.

Note: Templates may be applied to an existing title object. Settings outside of the text will be lost!

Creating titles without a template

• Try clicking the “General” entry under “Title” in the Media Pool.
  • Click the title editor button. A standard title will be produced and displayed in a frame in the video monitor.

• Open the first title in the video monitor by double clicking it
• Next, simply enter the text via your keyboard.
• After the text has been entered, click the check mark in the preview monitor to confirm your entry.
• The size and position of the title may be adjusted directly in the video monitor.
• Format the title via the title editor in the Media Pool however you like.
Text may be displayed in all kinds of fonts and colors.

If you want to format individual words or letters, select them with the mouse and choose a different format or color.

If no selection is made, the entire text will be formatted.

Position titles

- Click once on the title in the preview monitor and a positioning frame will appear. Simply move the positioning frame using drag & drop.

- The size of the positioning frame can be adjusted at the corners. If “Adjust font size to title field” is activated, the text size will also change.
Edit titles retroactively

- Double-click on the title in the preview monitor (or the title object in “Timeline” mode). Now change the text however you like.
- Confirm your entry by clicking the check mark next to the positioning frame.

You can also go to the Media Pool area “Titles > General” and enter your text there.

**Font**

- **Font**: Select the font used to display the text.
- **Font style**: Choose here whether all of the text or parts of it should be shown bold, in italics, or underlined.
- **Font size**: Set the size of the text here.
- **Alignment**: Select whether the text should be justified on the left, centered, or on the right within the positioning frame.
- **Color**: Use this button to color the font.

**Wrap text automatically**: When activated a break will be inserted automatically after each line.

**Important**: The result will be seen once you have confirmed the entered text by ticking next to the selection box or by pressing the Enter key.

**Adjust font size to title field**: If this function is activated, the font size will automatically increase when the title field is enlarged by adjusting the handles.

**Effects**

- **Border / Shadow / 3D**: Here you can enhance the text with various effects like shadow, 3D effects or borders. These settings can be adjusted in detail using "Advanced".
Animation

You can make your credits scroll down the screen, and many other text movements and effects and designs are also available.

The display duration for the subject can be set here.

Templates for animated text are arranged in the other Media Pool categories; the icon and the description are there to help you find the correct settings.

Title object

Center position  Clicking this button will position the title back in the middle.

Delete  Deletes the whole title object, i.e. text and settings.

Advanced settings

**Only use visible TV area**: The text will be zoomed so that it will always be within the TV’s limits, which is specified in the Movie effect settings (view page 85).

**Background**: Specify here whether the text’s background should appear black or white. This is only meaningful if no other video or image object is in the background.

**Text effects**: Here you can edit different text effects in detail. One color may be set for each effect.
Shadow: The position of the shadow may be set on the horizontal and vertical axes.

Transparency makes the background “shine through” more or less.

Soften: Makes the edge of the shadow harder or softer.

Outline: A border appears around the letters in the text.

Width: You can enter the width of the frame in points.

Color: Clicking on this button opens a color selection dialog, where you can set the frame color.

Filled in: The text will be filled with the color selected in the Title Editor. If the option is deactivated, only the frame will be visible, and the background will appear instead of the color fill.

3D: The text appears with a 3D-style outline. The width and thickness of the 3D contour (H) can be set in points.
Transitions (fades)

If you drag photos into the Arranger they are usually in sequence in Timeline/Storyboard mode. This is called a "hard" transition.

Transitions (fades) are a very important style tool for bringing the slideshow to life. With MAGiX PhotoStory on DVD 2013 Deluxe there are many and diverse ways of fading between a slideshow and photos.

For the duration of a transition two scenes may be shown at once and mixed together in different ways. These are called “Transitions” or “Fades”. You will find a multitude of different variations in the transitions folder in the Media Pool.

Advanced settings

There are special settings dialogs for all transitions of the first part of the menu and for the transitions in the sub-menus “3D morph” and “3D tile”. These are opened with the “Settings...” button. Here you can make further adjustments depending on the type of transition. The dialogs are self-explanatory, the best way of getting to know them is by trial and error.

Transitions in Storyboard Mode

You can open the transitions menu by simply clicking on the transition symbol between two individual photos.

Here’s where you’ll find all of the transitions that MAGiX PhotoStory on DVD 2013 Deluxe has to offer. Simply select a transition.

You can also choose the length of the transition. “Apply to all” applies the setting to your entire slideshow. Additionally, you can set random presets for each transition (“Random Transitions”) or apply the selected preset to all.

3D fades

General

3D effects offer exciting and varied opportunities to create transitions between two videos. You can find 3D effects under "Fades" > "Spatial fades" in Media Pool.

Settings

The fade settings enable the behavior and appearance of the 3D fades to be influenced. Click the corresponding fade symbol for the object and choose “Settings” to do this.
You have the following options:

**Anti-Aliasing:** A bothersome jagged edge sometimes appears on the borders of 3D objects. Anti-aliasing reduces this effect, but also requires more computer power. The setting applies globally to all 3D fades, switching on anti-aliasing during 3D fades has the effect that all other 3D fades are also affected by this setting.

**Mirror X / Y:** You can change the movement trajectory of 3D objects inside the fade. The option “X-axis mirror” mirrors the movement of the object horizontally (along the X-axis). The option “Y-axis mirror” mirrors the movement of the object vertically (along the Y-axis).

### 3D series

The 3D series are an advanced development of the 3D transitions (view page 74) and open up new thematic possibilities. The spatial effect and a sensible sequence of transitions are the most important things here. For instance, you can let photos pop up and disappear on a notice board or make it look as if the photos were hung on the walls of a gallery. The series stretch out over several photos or even entire slideshows.

In MAGIX PhotoStory on DVD 2013 Deluxe there are several options for accessing 3D series for photos:

1. In the Media Pool, click on „Transitions“ and open the folder „3D > 3D series“.
2. Select a 3D series and drag it onto the photo where the 3D series should start.
3. In the Transitions menu, the various 3D series are listed under “3D series” between 2 photos. Click on the 3D series you want to use.

A dialog opens in which you can select how many of the subsequent transitions should be replaced by the 3D series.

### Stereo3D fades (deluxe version only)

The fades in the Media Pool feature the category “Stereo3D”. This includes transitions that create slideshows with “real” 3D effects from regular 2D photos.

These transitions feature a selection of familiar transitions from MAGIX PhotoStory on DVD 2013 Deluxe that have been prepared especially for real 3D. These are displayed stereoscopically in the respective 3D playback modes (view page 119).

**Warning!** These transitions may not be applied to 3D photos, since this makes them very unpleasant to look at and can cause serious headaches!
Simple crossfade in Timeline Mode

A simple transition can be created in the Arranger of the Timeline mode by dragging one object over another. A **crossfade** is automatically created.

Using this basic transition the brightness of both images will be added together, and then one will be faded in as the other is faded out simultaneously. The duration of the crossfade is displayed in the Arranger by white crossing lines. You can adjust the **length of the crossfade** by dragging the upper object handle of the second object to the left or to the right.

To select a transition type click on the transition symbol displayed on each selected object, and then choose your favorite from the menu.

The transition icon will change depending on your selection.

Drag & drop onto a "hard" transition

Click on the “Fades” button in the Media Pool. The transitions folder will now appear in the file list. Like always, clicking on a transition once will bring up a preview.

Now just drag the desired transition and drop it onto the second of two photos you want to crossfade. Only when the mouse pointer with the transition preset is placed over a scene change will it turn into an object symbol. The object at the back will be shifted to the front to accommodate the transition.

The length of a transition is decided by you. If a transition is shortened, it means that the resulting effect is speeded up. There are two types of transitions: vfx transitions and alpha transitions. They can be found in the Media Pool and are displayed as blue/yellow icons with the letters A/B on them.

If you have selected this type of fade, then you can access it again by clicking on the fades button in the menu and then selecting “**Settings...**” at the very bottom, which, in turn, opens a dialog for fade effect settings. Thus, an object’s fade symbol in the Media Pool can represent an entire group of different effects.

The alpha fades (iris, objects, random, etc.) are actually pre-produced black and white videos combined with the alpha keying effect.
Effects

Effects in menus

You can do some fine tuning with the effects available in either the „Effects” menu (view page 165), the FX menu in Storyboard Mode (view page 44) or the context menu of an object.

The entries for "Image optimization", "Transform", "View & animation", and "Design" access the corresponding Effects in the Media Pool (view page 53).

Effects from the Media Pool

The effect files in the Media Pool "Effects" settings (view page 53) can be applied by clicking them or via drag & drop.

Simply click on one of the effects to view a short preview on the video monitor to see what an effect can do. If you want to use the effect, simply drag & drop it onto a photo or video.

To deactivate all effects of a photo, select "No effect" (you can also deactivate the effects via “Turn of effects” from the “Effects” menu).

Other effects can be set directly in the Media Pool; they have a direct effect on the selection.

Animate objects

Different kinds of animations are provided in the Media Pool. In the “Effects” tab, “Image optimization”, “Distortion”, “View and animation” and “Stereo 3D” (only in deluxe) provide you with the effects that can animated using keyframes.

The following objects can be animated:

• Image objects (still images)
• Title objects
• MAGIX 3D Maker objects (3D title)
• Video objects

Preparing animations

• First, select the object in the arranger to animate.
• In the Media Pool, open the “Effects” tab, and then click on the effect you would like to animate.
• If necessary, set up the effect however you would like it for the start of the animation.
• A timeline is located at the bottom of the Media Pool where keyframes can be set, selected, moved, and deleted.

**Note:** The figure corresponds to the display in “Timeline” mode.

**Set keyframes**
Click the timeline to set the playback marker at the locations where a keyframe should be added.

**Note:** You can also use the timeline in the arranger for exact positioning.

- The button places keyframes for all parameters required in the animation.
- Additional keyframes can be added simply by placing the playback marker at the next keyframe location and changing the effect accordingly.
- The positioned keyframes can also be retroactively moved via drag & drop.

**Copy keyframes**
Select the keyframes to be copied by clicking them and then press the “Copy” button.
Next, set the playback marker at the location for insertion and the press the “Insert” button.

**Display keyframes of individual parameters**
Multiple keyframes are added simultaneously to effects if they include multiple parameters.

Click the small arrow beside the name of the animated effect to display all of its parameters.

Now all keyframes of the effects parameter can be individually moved, deleted, activated, and deactivated.

**Note:** Only those parameters are listed which are used for the animation. As soon as another parameter is required for editing the effect, it becomes visible to you here.
Retroactively editing an effect's keyframes

Previously set keyframes can be retroactively moved and their values can be edited.

Keyframes can be moved via drag & drop. Simply click on the keyframe to be moved and drag it to the desired position.

To change an effects setting for an already positioned keyframe, click the keyframe and adjust the effect in the Media Pool.

Soft movement

Normally, a hard, unnatural pan is the result of set keyframes.

This option makes sure that the progression of these movements is executed more softly and more naturally.

It lets you activate the entire parameter group as well as individual parameter curves.

Delete keyframe

Select the keyframe to be deleted by clicking it.

This button removes the selected keyframe.

Video stabilization

The video stabilizer is a great tool for smoothing out shaky footage. This feature can be accessed from the context menu of a video object or in the “Effects” menu.

Functionality

Video stabilization removes undesired picture movement. The motion stabilizer counteracts unwanted movements by moving the image in the opposite direction. This produces overlapping edges in the footage that are trimmed automatically and replaced by black borders which are then removed using a zoom shot. The result: A clearly more stable, almost imperceptibly larger picture.

Application

Activate the motion stabilizer in the “Effects” menu or the context menu for video objects. You will see the current video object in the preview monitor.

First you have to check the footage for shaky scenes. To do this click on the “Execute stabilization” button. Based on the preset parameters, a relative shift between the pictures is calculated. Once the analysis is complete, take a look at the suggested correction. You can then use the slider for further adjustments. Once you are
satisfied with the final correction click "OK". If the first scan does not provide a satisfactory result, try changing the parameters below and repeat the process.

Keyboard shortcut: Shift + K

**Image stabilization dialog**

Stabilizing radius: To prevent the image stabilizer from recognizing every camera movement as unwanted shakiness, you can determine the radius within which movement is accepted; the larger the stabilization radius, the more shakiness is corrected. Changing this parameter will require re-analysis of the source footage.

Analysis area: This area determines the area of the footage that should be analyzed. The center of the image is preset. If shaking occurs in one area more than in another, then you can move the analysis area (e.g. a foreground element at the edge is especially shaky). To do this, use the mouse to “capture” the shaky area. The smaller the area, the quicker the analysis will be calculated. Generally, changing this parameter will require re-analysis of the source footage.

Maximum movement: Correction moves the image accordingly to the shaking movements. This means that the edge of the image will be removed. This value determines how large the edge area is which may be cut away by the stabilization feature; the smaller the value, the less movement correction. Changes to this value are immediately applied.

Temporal smoothing: This value determines the speed of the movements considered shaky. This allows you to differentiate between a panning shot and a nervous handheld shot. Changes to this value are immediately applied.

Cancel: Exits the dialog without accepting changes to settings.
**Effects**

*Reset*: Resets the current settings.

### Sound optimization

This option opens an editor for correcting audio material discrepancies.

Select the cleaning function you desire from the upper part of the dialog:

- The equalizer (on page 83) allows you to manipulate the frequency spectrum – perfect for cleaning up muffled dialog.
- The compressor is a dynamic volume control that lends the overall sound a deeper, richer quality.
- The stereo FX processor justifies the position of the sound in the stereo panorama.
- DeNoiser, DeClipper, and DeHisser are professional noise reduction tools that do exactly what their titles say they do.

**Presets**: You can try out the suitability of a number of presets in the preset menu.

**Temporarily deactivate all effects**: Switches all the effects off.

**Apply to all**: Applies the current settings of all effects to every photo in the selected slideshow.

### Declipper

Should the input level of an audio recording be too high, overmodulation may result at the louder parts (the signal peaks). This digital distortion is also called “clipping”: At the overmodulated area, the values that are too high are simply cut off, and typical, quite unpleasant-sounding crackling and distortion appear.

MAGIX PhotoStory on DVD 2013 Deluxe contains a special function for dealing with digital clipping and analog distortions. Of course, this only works to a certain degree.

Using the fader you can set at what level the Declipper should register a signal as being overmodulated and, if required, correct it (Clip level). This is important, as different sound cards show different clipping methods. The more the fader is turned up, the lower the level recognized by the program as overmodulated. If the clip level is set too high, unwanted sound modification may occur.

**Get clip level**: The clip level is gaged automatically.

### Noise Reduction: Denoiser and Dehisser

**DeNoiser**

The DeNoiser is especially useful for clearing long-lasting disruptive noise like mains humming, hissing, noises from sound charts, disturbance noise from ground circuits,
interference from audio-equipment with high mic outputs (record players), impact noise, or the rumbling of records.

The DeNoiser requires a noise sample. Some typical sounds are at your disposal.

Set the degree to which the noise should be reduced with the fader. It is often better to reduce interference signals by 3-6 dB rather than as much as is possible so as to keep the sound “natural”.

Another possibility is to create a noise sample yourself. You need a short sample from the sound track in which only the background noise can be heard. Then switch to the DeNoiser dialog with the “Advanced” button.

**Step 1: Select noise sample**
First you have to select a noise sample of the noise you want to remove.

You have two options:

**Pick out typical background noise:** You can select and use a number of typical background noises from the flip menu. Select one and listen to it via the “Play” button. If it is similar to the background noise in your sound track, go ahead and use it (see “Step 2: Removing background noise”).

**Extracting a new noise sample from a sound track:** You can also pick out a short passage (from the existing sound track) in which you can hear the background noise.

**Automatic search:** Searches especially quiet passages in which background noise most probably resides.

**Previous/play/next:** These buttons allow you to play all of the passages found for easy comparison.

**Save as:** Once found, you can save noise samples on the hard drive which then appear as an entry in the “Typical background noises” drop-down menu to be used in other projects. There’s no need to save it if you only want to use it once, and in this case switch to “Remove background noise”.

If you only want to use the noise sample in the current project, then you don’t have to save it. You can immediately switch to the “Remove category”.

**Step 2: Remove background noise**

**Noise level:** The level of the noise reduction function should be set as precisely as possible. Low settings result in incomplete deletion of the hissing. An incomplete deletion of the hissing produces artifacts and should be avoided. High settings produce dull results and useful signals which are similar to hissing (woodwinds, for example) are also filtered away. It’s worth your time to find the best setting.
Reducer: Here you can set the balance between the original signal and the signal with depressed interference. It is often better to reduce interference signals by 3-6 dB rather than as much as is possible so as to keep the sound natural. For buzzing it's best to apply complete removal.

Dehisser
The Dehisser eliminates regular “white” noise typically produced by analog tape recordings, microphone pre-amplifiers, A/D converters, or transformers.

Noise reduction can be regulated in decibels with the fader. It is often better to reduce interference signals by 3-6 dB rather than as much as possible in order to keep the sound “natural”.

Noise level: You can choose between different noise levels. The level of the noise reduction function should be set as precisely as possible. Low settings result in incomplete deletion of the hissing. Incomplete deleting of hissing produces artifacts and should be avoided, since high settings will produce dull results and some useful signals (i.e. woodwinds) which are similar to hissing are also filtered away.

Equalizer
The 10-track equalizer divides the frequency spectrum into 10 areas (tracks) and supplies them with separate volume controls to allow you to achieve many impressive effects, from the simple rising of the bass to total sound transformation. If you raise the low frequencies too much throughout the whole level, it might cause distortions.

Fader: The volume of each of the 10 frequency bands can be set separately with the 10 volume controls.

Link frequency bands: The frequency fields can be bundled together flexibly in order to avoid artificial-sounding exaggeration in individual frequency fields.

Compressor
The compressor is an automated, dynamic volume controller. Loud passages become quieter and the total value is raised. This makes the volume more consistent and speech easier to understand. A compressor is mainly useful in case background noise or music interferes with speech and simply increasing the volume of the individual objects or tracks does not result in any significant improvement.

Level: Regulates the level of compression applied (the “ratio”).

Function: Defines the compressor depending upon the sound material.

Stereo FX
The stereo FX processor provides adjustment of the alignment of the audio material in the stereo balance. If the stereo recordings sound weak and undifferentiated, an extension of the stereo base width can often provide better transparency.
Bandwidth control: Adjust the bandwidth between mono (on the extreme left), unchanged base width (center) and maximum bandwidth (“wide” on the extreme right).

Reducing the bandwidth can raise the overall level. In extreme cases, when the left and the right channels include identical material and the bandwidth control is pushed to the extreme left on “mono”, the result can be a level increase of 3 decibels.

Raising the bandwidth (values of 100) diminishes the mono compatibility.

Slideshow effects

In the slideshow Effects menu (view page 165) you can recall the slideshow effects by clicking on “Slideshow effect settings”. The dialog is almost identical to the Optimize photo (view page 54) dialog.

The slideshow effects apply to the entire slideshow and are intended to regulate the color saturation in the slideshow as a whole.

You can find special TV screen size (view page 85) options for cropping the screen edge, since the image usually exceeds the screen size for a normal TV set.

General use

Presets: Try out the presets from the preset menu.

Temporarily switch off all effects: With this option, you can temporarily deactivate all effects. This way, you can quickly compare the original with the edited version.

OK: The adjustments made to the settings will be applied.

Cancel: Closes the dialog, the settings will not be applied.

Help: Opens the program’s help file.

Exposure

Brightness/contrast: Use the sliders to increase or reduce the brightness and the contrast of the picture.

Selective brightness (gamma): “Gamma” specifies the mean gray value that is provided by the various color ranges. “Selective brightness” is the most important function for image improvement. In the preset list, select the various envelope curves to edit only the dark, median, or brightest areas of the image. Using the fader, you can also set the level of brightening or darkening.

Adjust colour space: This option is effective for correcting extreme colors that violate TV standards and can no longer be displayed properly on-screen. The color saturation
of the affected material is thereby reduced until the maximum permitted value is reached.

**Color**

**Saturation:** Use the saturation slider to increase or reduce the hue proportions in the image. A newly developed algorithm is now used, which carries out color changes in relation to other parameters (for example contrast settings), in order to get the most natural coloration possible. With some experimenting, you can achieve some amazing results – such as turning summer images into autumnal pictures, or creating funky pop art...

**Hue:** Use the palette to select a hue for coloring-in the picture.

**Red/Green/Blue:** Changes the color portion mix.

**Image sharpness**

You can reduce (soften) or increase (sharpen) the object’s focus using this slider.

“Fine adjustment” allows you to set how sharp surfaces or edges should appear. Using it, you can effectively decrease persistent image deficits.

**Anti-flickering filter intensity:** The anti-flickering filter affects only still images. It is especially intended for zooms in images with many edges and transitions with high contrast (e.g. fences, bars, brick walls). High-frequency images such as these begin to flicker when they are reduced in size. This filter smoothes these edges somewhat. You should set the intensity of the anti-flickering filter according to your preferences, because smoothing is always a compromise between good contrast and fluid image sequence during playback.

**TV image size (Slideshow master effects)**

This option ensures that the image size is adapted to fit the real television picture (anti cropping). Without adjustment, the television might otherwise crop the image borders.

The four input fields also enable the borders of the four sides to be adjusted freely in percent. It is important to find the optimal balance between distortion, reduction, bar formation, and image cropping:

- If the same value is entered for every margin the image size is reduced proportionally. In this case no distortions will occur, but there will be bars along the edges.
- If different values are entered for the 4 fields the image size will not be reduced proportionally. This will distort the image.

**Use edges on:** This option enables the input values for the four image borders to be applied to all photos, videos or titles in reduced form. The result can immediately be viewed on the preview monitor.
**Tip:** In order to limit individual objects to the visible range, please select the option “Edge cropping balancing” in the menu “Effects -> Image optimization -> TV image.”

**Fade in TV display area in the preview monitor:** This option displays the image borders of the television as lines in the preview monitor. The four image borders of the TV display area can be set using the four input fields. Here, it is of course necessary to know the actual size of the TV picture. To determine it, proceed as follows:

**Determining the visible TV frame size**

To determine the picture properties of your television as well as optimal image size editor settings, you should perform a test run:

1. Load the **Visible TV picture.mvm** movie from the “My projects > visible TV picture” folder.
2. Play back the movie and read the instructions on the video monitor.
3. Burn the slideshow to a disc.
4. Place the disc into your player and play back the movie. Compare the TV picture to the picture displayed on your video screen by MAGIX PhotoStory on DVD 2013 Deluxe.
5. Determine the proportional value of the borders cropped by the television with the 4 measurement scales along the edges of the test picture.
6. Enter the values in the “Full TV size” editor.

The image size is now optimized to your TV picture. Please note: Depending on device settings and disc carrier type, the cropping values may vary slightly.
Audio recording

Songs, noises or instruments can be easily recorded in MAGiX PhotoStory on DVD 2013 Deluxe using the recording function. The created wave file will be inserted on track 2 in Storyboard mode.

The corresponding sound sources have to be connected and calibrated (view page 90) for the recording to be correct.

Record dialog

Add sound to entire slideshow: Use this option to begin playback of your slideshow from the start marker while recording in order to be able to comment on each photo one after the other. At the same time, the recording is cut after every photo. This way you can move your photos after recording; the corresponding comment is moved automatically.

Add sound to selected photo: Use this option to play the selected photo and position your commentary precisely. If your audio recording lasts longer than the duration set for the photo, the display time for each photo is automatically extended.
Note: If you are using photos or videos with the original sound in the slideshow, it will be overwritten during an audio recording, because recordings are always placed on the second track. You can prevent the overwriting by moving the material to the fourth track, which is actually intended for background music.

Audio driver: Selects the sound card for the recording.

Save audio file as/ Save in folder: Here you can select the title of the audio file you wish to record. You can also select the folder where you wish to store the file.

Recording quality: Sets the sound quality of the recording. In the preset menu you can choose between medium wave radio (“AM tuner”), UKW (“FM Radio”), DAT (Digital Audio Tape) and CD quality.

Display Volume control: Using the peakmeter, you can monitor the level of the incoming signal. Please read more on this in the chapter “Adjusting levels” (view page 90)

Record: This button starts the actual recording.

Stop: Click this button to stop recording

Note: To remove noise that developed while recording, you should try out the effects in the Audio Cleaning dialog (view page 81).

Advanced audio recording settings

Driver info
Shows the name of the chosen recording device.

General options
• "Mono" can be activated for recording in mono. This reduces the required memory space in half. This is useful for spoken commentary as the microphone only communicates a mono signal.
• “Real-time sample rate adjustment” automatically matches the sample rate of a new file to be recorded with the sample rate of the selected slideshow (set in the video recording).
• Automatic damping of volume levels on other tracks (“Ducking”): If you slideshow already has a well-modulated soundtrack, and you would like to add some spoken comments or other sound material, activate “Automatic damping of volume level on other tracks” in the record dialog. This automatically lowers the volume of audio objects in the arranger during the recording session. This is achieved using an automatically configured volume curve: Before and after the recording other tracks will be faded in or out, resulting in a homogeneous total
volume level. (Lowering of volume level during spoken comments is also called “Ducking”.)

**Track damping options**

**Intensity of damping:** Here you can determine by how many dB (Decibels) the volume should be lowered. A signaled lowered by about 6 dB will be perceived by the human ear to be about half as loud.

**Tip:** Depending on the kind of music or original sound, different settings should be given a try. If the music is already soft, lowering by 6 dB will probably be enough; a hectic original audio track or loud rock music damping should be stronger.

**Cross fade duration [sec]:** Here you can enter, in seconds, how quickly the signal should be lowered or raised before and after the recording.

**Hint:** Volume damping can be edited later on in the track. You can read more about this topic in Volume curves (view page 114).

**Connecting the source for recording**

First of all, the source of the audio material must be connected to the sound card input. Again, there are several possibilities which primarily depend on the type of equipment you have.

If you are recording from a microphone, then please connect the microphone to the microphone jack on your sound card (usually red).

If you want to record material from a stereo system, then you can use the line-out or AUX out jacks on the back of your amplifier or tape deck. This involves connecting them to the sound card input (usually red).

If your amplifier has no separate output (other than for the speakers), then you can use the connection intended for headphones for your recordings. In most cases, you will need a cable with two mini-stereo jacks. This type of connection has the advantage of being able to set the headphone input signal level with a separate volume. As headphone connections generally are not the best, it is advised that you use the line outputs if possible.

When recording cassettes from a tape deck, you can connect the tape deck’s line out directly to the sound card input.

When recording from vinyl records, you should not connect the record player’s output directly with the sound card because the phono signal needs to be pre-amplified. A more suitable method would be to use the headphone connection or an external pre-amp.
Adjusting the Signal Level

Adjusting the signal level to the sound card is also recommended to get the best sound quality during digital recording.

Once a recording source is connected to the sound card, the “Record” button opens the recording dialog and starts the recording source.

You can now adjust the recording level with the help of the LED display in the recording dialog. For this, you must first check off “Show Levels”.

If the adjustment is set too high, distortion occurs and the incoming signal must be reduced. If you have connected the source through either an amplifier or tape deck output to the sound card, you can only reduce the signal level in your sound card’s software mixer interface. You can access the mixer directly from within the recording dialog via the “Recording Level” button.

If you reduce input sensitivity by using the input fader, the resolution at which the analog signal is digitized is also reduced. Try to set these automatic controllers to the loudest sound level possible.

The maximum setting for an optimal level is the loudest part of the material. The loudest part should be adjusted to be the maximum. The actual recording begins when you press the “Record” button. At the end of the recording you will be asked if you want to use the recording. Upon confirmation, the newly-recorded material will be placed at the next free position of the start marker in the arrangement.
Special functions and wizards

In this chapter, we will introduce you to some of the especially useful special functions.

Create a slideshow with the wizard

The Slideshow Wizard helps you quickly and easily create great slideshows. You can find this in “Edit” > “Wizards” or in the welcome dialog that appears when the program is started.

The Wizard will now lead you through the steps required for creating a new slideshow.

In the following selection dialog other tips and hints can be opened by clicking the buttons.

Specify settings

Next you can set the aspect ratio for the project. You can also determine how MAGIX PhotoStory on DVD 2013 Deluxe should behave with photos that do not match the project’s formatting.

Cut to fit screen automatically: Images that do not correspond to the project’s ratio are adjusted automatically. The zoom factor is set in such a way that there are no black bars to the left or right or top and bottom.
**Project name:** Give your disc project a name. This name will be used as a preset title for the disc you are going to burn. The slideshows will also be given this name.

**Disc format (capacity display):** Set the disc type you prefer here. MAGIX PhotoStory on DVD 2013 Deluxe estimates how much space the project will occupy on the corresponding blank disc. This display can be found below the slideshow.

**Load photos**

Go to “Load files...” to select photos that should be added to the project. “Delete” removes the selected photos from the list. The sequence of photos can be adjusted using drag & drop.

**Display time for each photo (seconds):** By default, photos are displayed for the time entered here. Of course, you can later change the time each photo is displayed.

**Total length of slideshow:** The approximate total length of the slideshow created is shown here. It adjusts if the display time per photo is changed.

**Rotate image(s) 90°:** Are your photos upside down or sideways? Use this feature to rotate it accordingly.

**Note:** If you load more than 100 photos, the wizard will suggest creating more than one slideshow. Then, the photos will sorted according to creation date using so-called EXIF files, if present. Otherwise, the file date will be used.
Specify effects

Select one of the styles that best suits the theme of your slideshow. If you don’t want any effects, then select the entry marked “No effects”.

In addition you can also refine your slideshow’s style with various transitions, effects, trailers, text and background music.

More information about effects settings can be found in “Slideshow Maker”.

Finishing a new slideshow

Click here to create the slideshow according to the set specifications. A preview will be generated.

After clicking “Next” you will be given the option to continue editing the slideshow manually or to burn the slideshow to disc. To do so select “Edit slideshow manually” or “Add menu to slideshow and burn”.

A click on “OK” closes the Wizards. Clicking “Back” allows you to make design changes to your slideshow again.
Divide slideshow

You can divide up your whole slideshow into several individual shows using this Wizard. This can be particularly useful if you want to add photos from vacation to one slideshow, and photos of the arrival and departure to another. This allows you to customize the material and makes navigating through the DVD menu easier.

There are three available options:

**Group photos according to date:** The photos are divided into sections according to when they were taken (e.g. days or weeks). A slideshow is made up of one or more sections depending on the minimum number of photos specified for a slideshow.

**Create slideshow according to number of images:** Enter the number photos a slideshow should contain.

**Separate the photos onto the specified number of slideshows:** Enter how many slideshows should be created. Note that there will only be a few images in a slideshow if there are lots of them.

Slideshow Maker

Slideshow Maker is ideal for converting still images into moving pictures, adding background music, and effects.

Open Slideshow Maker through “File -> Wizards” or the button in the toolbar.
**Style templates**
Select a template that best matches your needs.

![This button plays a sample slideshow with the selected style template.](image)

**Save/delete style template**
Homemade style templates appear in the list of included style templates. If you like, these can be deleted again.

- ![Save style template](image)
- ![Delete style template](image)

**Intensity**
Controls the portion of video and image objects that feature effects. With “Normal” you will see a balanced amount, whereas with “Weak” or “Strong”, correspondingly fewer or more effects.

**Transitions**
Transitions can be individually activated or deactivated using this button.

- ![Fades](image)

The slider in the transitions dialog can be used to adjust the amount of each type of transition.

- **Transition duration**: Set the length of the transitions in seconds.

- **3D transitions use Stereo 3D mode**: If this option is activated, 3D transitions use Stereo 3D mode.

- **Random transitions**: The transitions are set to random values.

The “play” button below the preview monitor plays a preview.

**Effects**
Various effects can be individually activated or deactivated using this button.

- ![Effects](image)

The slider in the dialog controls the amount of each effect type.

- **Random effects**: The faders that control the amount of effects are set randomly.
Treat special image formats intelligently

Treat special image formats intelligently. Panoramas and portrait photos can be treated “intelligently”. If this option is activated, then panoramas and portraits will be treated with special effects adjusted to the format. These effects can also be selected and unselected in the detail view.

If this option is not selected, then these images will use the same effects as all other images.

Properties & titles

Properties & title

Slideshow length

Resulting slideshow length: This is an approximation of how long the slideshow will be after Slideshow Maker is applied.

Available music: This is the complete length of the music that is currently selected. “Background music” enables detailed settings for the pieces of music to be used.

Adjust slideshow length to music: An effort will be made to adjust the length of the slideshow objects to the background music. If the slideshow is too short, the music will be cut off. If the slideshow is too long, the music will be repeated.

Adjust music length to the slideshow: Photo objects receive a set length and the resulting slideshow is filled with music. The music at the end of the slideshow is simply faded out.

Including video objects

Process videos: If this option is set, then videos will be automatically processed with effects and transitions.

Length: Settings may be made here about whether the original length of the video should be maintained or if it should be shortened.

Opening and closing credits

Set the text for opening and closing credits here.

Text: Enter the corresponding text for opening and closing credits that should be added by Slideshow Maker.

File: A title template, a video, or an image file may also be used.

Note: Titles created using Slideshow Maker may also be edited at any time.
Group similar recordings
If this option is active, an attempt is made to detect associated events via their date information and to separate them from each other optically. Detection of individual events is based on the time span of these events to achieve a sensible separation.

Begin group with black fade: A black fade is added between the different events.

Start group with date/time over a black fade: A black fade is added between the different events. A title is also faded in with a suitable duration, e.g. 1st/2nd/3rd day, provided the events take place over multiple days.

Start group with date/time over image: A black fade is added between the different events. A title is also faded in with a suitable duration after the black fade, e.g. 1st/2nd/3rd day, provided the events take place over multiple days.

Background music

Use background music: Select whether you want to add music to your slideshow.

Resulting slideshow length: Displays the duration of the finished slideshow.

Available music: shows the length of all available tracks that could be used as background music.

Load file(s): here you can load music tracks into the project. You can also use MP3 files.

Remove: Deletes the selected music track located to the left of the project window from the project.

Please note: The song is removed from the project, not from your hard drive.

Add random: Randomly loads music tracks from the "Slideshow music" folder into the slideshow.

Preview: By clicking on this button, you can listen to the music track selected in the project window.

Random order of background music when switching the style template: If you change your mind before you have finished the slideshow and decide you want to use a different style template, the music tracks are ordered randomly.

Tip: You can manually change the order of the music in the project window using drag & drop.
**Volume ratio:** If your slideshow includes videos, you can adjust their volume in relation to the background music using the sliders. If you want to hear more of the music, move the slider to the left. If, on the other hand, you want the video’s audio to be more prominent, simply move the slider to the right.

**Tip:** Songs in the fourth track are listed and used for the background music, provided they are not removed.

**Create slideshow**

After all of the important settings have been made, click this button to produce the slideshow.

If the results do not match what you imagined, then click "Cancel" to discard the changes. Otherwise, you can change the settings again or select another style template and click "Create slideshow".

**MAGIX Soundtrack Maker**

The MAGIX Soundtrack Maker automatically generates music tracks corresponding to the specified mood. Open the MAGIX Soundtrack Maker using the Edit > Assistants menu.

**Choose music style**

First choose a music style. Clicking on “Buy more styles” will open the MAGIX Online Content Library. Here you can buy more music styles for MAGIX Soundtrack Maker.

The option “Apply only between start and end marker” lets you limit the length of the background music you want to create. You can also set the start and end markers (view page 43) with the left and right mouse key if MAGIX Soundtrack Maker is open.

**Set mood change**

If your slideshow includes videos, you can adjust their volume in relation to the background music using the sliders. If you want to hear more of the music, move the slider to the left. If, on the other hand, you want the video’s audio to be more prominent, simply move the slider to the right.

**Tip:** Songs in the fourth track are listed and used for the background music, provided they are not removed.

**Create slideshow**

After all of the important settings have been made, click this button to produce the slideshow.

If the results do not match what you imagined, then click "Cancel" to discard the changes. Otherwise, you can change the settings again or select another style template and click "Create slideshow".

**MAGIX Soundtrack Maker**

The MAGIX Soundtrack Maker automatically generates music tracks corresponding to the specified mood. Open the MAGIX Soundtrack Maker using the Edit > Assistants menu.

**Choose music style**

First choose a music style. Clicking on “Buy more styles” will open the MAGIX Online Content Library. Here you can buy more music styles for MAGIX Soundtrack Maker.

The option “Apply only between start and end marker” lets you limit the length of the background music you want to create. You can also set the start and end markers (view page 43) with the left and right mouse key if MAGIX Soundtrack Maker is open.
Select a mood from the list.

**Preview:** Here you can preview your selected emotion.

**Position:** With the position slider you can move to a certain position to set the emotions at a certain position. Instead, you can also move the start marker with the left mouse button. The preview will be displayed in the video monitor.

**Add emotion:** This button inserts the emotion at the current position. MAGIX Soundtrack Maker will then suggest a new position for the next emotion by repositioning the position slider. Of course you can also put it elsewhere and insert further moods.

**Delete emotion:** Deletes the current emotion.

### Generate background music

One click on “Create soundtrack” creates a new soundtrack. “Progress” shows the current status.

### Variations

If you don’t like the background music that was created, then you can create variations. You can do this for the entire background music as well as for individual emotions.

- If you want to vary the entire background music, then simply click “Create variations”.
- If you only want this to apply to a certain emotion, then you should first go to it with the position slider in the dialog (or the start marker on the main screen). Then activate the option “Vary only selected emotions” and click on “Create variations”. 
Musical Cut Adjustment

Musical cut adjustments gives you the option of automatically displaying the photos and videos to the beat of the music, e.g. to sync the picture sequence with the music for a music video. It can be activated through “Edit” > “Wizards”.

To perform musical editing adjustment the music must have tempo and bar information. To do this you can use the Tempo and beat recognition which analyzes the music and generates the information. The basis for this analysis is the rhythmic speed measured in BPM (Beats per Minute).

**Preparation - Setting the start marker and object end**
Before opening the Auto Remix Assistant, you should set the start marker at the position in the song object in the arranger where you want detection to start. If the song contains a long intro without beats, set the start marker after the intro. As a rule of thumb, the Auto Remix Assistant should always be “fed” dance music.

- The start marker should be set before a quarter note beat or, better still, briefly before a beat at the start of a bar.
- If the start marker lies before the song object, the object is examined from the beginning.
- If detection is not performed by the end of the song, the object can be shortened accordingly with the object handle at the end of the object.

**Checking the automatic tempo recognition**
A song must have the following properties in order to be analyzed:

- It must be longer than 15 seconds.
- It must contain “rhythmic” (danceable) music.
- It must be in stereo.

The analysis takes place in four steps:

**Step 1: Checking the start marker**
**Step 2: Tempo recognition**
**Step 3: Specifying beat starts**
**Step 4: Application of BPM and beat recognition**

**Step 1: Checking the start marker**
Before you start the analysis you should set the start marker at the position where the rhythmic music begins. This means that if the song has a long ambient intro, the start marker should be set after the intro. If the wizard can’t detect any rhythm it will ask if the start marker has been set after the intro. If not, you can move it to a better position in the dialog.
If the beginning of the song does not have a definite rhythm, you will be asked if you want to move the start marker.

**Step 2: Checking the automatic tempo recognition**

The Remix Agent will analyze the audio material and try to determine the tempo. The object is played back while a metronome click can be heard and numbered green beat lines appear in the waveform.

Under the waveform on the left side the established tempo is displayed in BPM. There is a small transport console in the middle to make navigating easier. The slider serves as a position controller. To set the metronome volume, an additional fader and mute button are provided on the right-hand side.

The automatic tempo recognition doesn’t always work right away. If you don’t hear the metronome clicking in time with the music, click the "No" button in the upper section of the dialog in order to access the manual tempo input dialog.

To correct the metronome speed and any timeshift that may occur between the metronome clicks you can use the tempo correction as well as the "Tap tempo" button:

**Tempo correction:** The Remix Agent offers various speed settings. The most probable tempo detected by the Remix Agent is preset. If this tempo isn’t correct, you can choose another one from the list. The next time you play back the song it should be in sync with the metronome.

**On/Off beat correction:** Now it may happen that the tempo is right, but the beats have been displaced. "On/off beat correction" provides a number of alternatives for moving the beats according to the complexity of the rhythm. Try out various alternatives until the metronome clicks are in sync with the beat.

**Tap tempo:** Alternatively, click rhythmically on the "Tap tempo" button or press the "T" key. Additional blue lines are displayed in the wave display. After at least four taps, the Remix Agent attempts to select the correct tempo from the list in "Tempo correction". The display next to the "Tap tempo" button displays the current status. Keep tapping until the red display showing "Unlocked" changes to the green "Locked" setting.

Use the "0" key to manually set the quarter beats while the music plays. Surrounding markers will automatically be removed to ensure that the set tempo remains intact.

You can move the markers with the mouse. If you hold down the "Ctrl" key simultaneously, the subsequent markers are also moved.

If the metronome clicks now correspond with the music, you can continue to the next step.
Step 3: Determining the start of a bar:
Next you can set the time signature. The default setting is 4/4 but you can adjust this if necessary. The beat at the start of the bar should coincide with the high sound of the metronome, or the red line in the waveform display.

It can now be corrected in one step: If the start of the bar can be heard, click on "Tap One" once using the mouse or press the "T" key on the keyboard.

Alternatively, select how many quarter notes the "One" is to be moved back.

Use the "0" key to manually tap the position of the beginnings of the bars during playback. This allows you to correct the beginnings of the bars in longer sections.

Continue to the last step if the starts of the bars are now correct.

Step 4: Apply
The final step is to apply the musical information to the audio material.

The images on track 1 will be repositioned according to this information.

Search empty sections
With these Wizards you can spot gaps in your slideshows quickly.

Go to next empty range: Moves the view to the next range that doesn’t contain image or film material.

Keyboard shortcut: Shift + 5

Go to previous empty range: Moves the view to the previous range that doesn’t contain image or film material.

Keyboard shortcut: Shift + 4
Clean-up Wizard

The Clean-Up Wizard helps you delete projects from your hard drive, including all movies and the audio, video and picture files used in them. Use this function to free up disk space for future projects.

**Caution:** If the files you used in the slideshow have also been used in other slideshows (like trailers, opening music, etc.), then you should make backup copies of these files beforehand.

There are two available options:

**Delete certain files:** Choose this option if you would like to select certain files for deletion. You can select the desired files in the “File selection” dialog. In the next step, the Cleaning Wizard automatically looks for other files which belong to your selection. Using this method, you can delete an entire slideshow with all of its accompanying media, help, project, and backup files. Before they are deleted, you receive relevant information in a dialog and a confirmation request.

**Find and delete unnecessary files:** Choose this option if you want to find unnecessary files or free up some space on your hard drive. The Clean-Up Wizard then automatically looks for extraneous files created during use of MAGIX PhotoStory on DVD 2013 Deluxe. Before they are deleted, you receive relevant information in a dialog and a confirmation request.

**Export**

Opens the Output options (view page 145).

**Travel route animation**

Using the travel route animation, you can quickly create maps with animated travel routes. You can start travel route animation in the Media Pool > Import > MAGIX Tools > Travel route...”.

If you have imported photos with GPS geotags into your movie, you can create a route that will appear as transitions between the photos.

- Position the photos from the start of the trip and the end of the trip directly beside each other and select the first photo.
- Start the travel route animation. The locations will automatically be entered on the map.
Click on “Animation”, save the route as a video and close the travel route animation feature. The travel route video will automatically be inserted between the photos including transitions.

If there are no photos with GPS information, the travel route animation will start without locations. Select the locations on the map yourself to export a travel route.

Program interface of the travel route animation

1. **Map**: Displays map material from openstreetmap.org.
2. **Selected locations**: All locations, searched using geonames.org or selected manually on the map, will be shown on the list and marked using pins.
3. **Map section + zoom**: The map may be moved by pressing the arrows. “Zoom” enables you to zoom into the current section (+) to view more details or to zoom out (-) for a better overview.
4. **Show lines**: If at least 2 locations are marked on the map, then this function will be available for linking the locations. The line color and thickness may be changed.
5. **Animation**: You can animate your travel route and save as video in WMV format.
6. **Save as image**: The current map section may be saved as an image in the format PNG, BMP, JPG, or TIFF.

Select locations on the map

There are several options for selecting locations on the map for creating a route.

**Note**: The map section will adjust itself depending on how many locations you select and where they are. If you would like to view details about a location, simply zoom in using “+” on the number block or the mouse wheel.
Search and select locations:

1. Click on the “+” button below “Edit destinations” to add an entry. This new entry will appear blue below existing locations.

2. Assign a name to the new location and press Enter. The destination will be added to the map. An additional marker is set for beginning and end of a tour.

**Note:** If multiple locations are possible, a list with possible choices will open. You can determine the destination by picking one from the list with your mouse.

If important intermediate stages of the route should also have a marker, click on the marker symbol in the properties (cogwheel) of the destination.

Set destinations manually:

1. Move the map boundary by clicking on the map and holding down the mouse key so as to make the desired destination visible.

2. Click on this button under “Edit destinations” to activate manual entering of locations, or use the keyboard shortcut “M”.

3. Click the target destination on the map. A new entry to the list will be made.
**Rename destinations:**
You can rename destinations by going to its properties (cogwheel symbol) without changing it.

**Search destination anew:**
If the destination is incorrect, you can search the location again in order to adjust the position of the marker.
Enter a new name in the entry field and click on the magnifying glass or press enter.

**Import GPX file:**
If you have created a route with a GPS device and saved it as a GPX file, you can import it and show the route on the map.

**Note:** Depending on the length of the route, it can take some time for the file to be imported and displayed.

**Adjust & delete locations**

**Change the sequence of destinations:**
The order of destinations in the list corresponds to the sequence in which they were created. You can edit the order of the destinations by clicking on a location on the list and dragging it to a new place with the mouse key held down. The route on the map will be adjusted. You can see this especially well if you’ve activated the line (view page 108) in order to optimize the travel route display.

**Adjust the position of the destination:**
You can adjust the position of a destination by grabbing the marker on the map with your mouse and dragging it with the depressed mouse key to a new position on the map. The marker will be moved, the travel route adjusted and the new name of the destination will be automatically changed in the list.
Note: If the destination marker doesn’t appear, you can activate it in the properties (cogwheel) by clicking on the marker symbol.

Hide destination:
Click on the eye icon below the properties (cogwheel) of a destination. The destination will remain in the list, but will be hidden on the map and will not appear in the route. Click on the eye again to display the location again.

Remove destination from the list:
To delete a destination from the list and the route, click on this button next to the destination.

Save and load routes
The entire list of marked locations may be saved to load it later - without having to search for and select all of the locations again.

Save as file:
- Click on this button under “Edit destinations” or use the keyboard shortcut “Ctrl + S”.
- Enter the save location and name of the location list in the dialog that appears.
- Click “Save” to back up the list and quit the dialog.

Open list:
- To load a saved location list, click this button under “Edit destinations” or use the keyboard shortcut “Ctrl + O”.
- Navigate to the save location and select the location list in the dialog that appears.
- Clicking on “Open” closes the dialog and opens the list with saved destinations.

Adjust map section
Use this button to move the map section upwards (north), to the right (east), downwards (south), or to the left (west). The arrow keys on the keyboard may also be used to move. Click on the point between the arrows to move the map window in order to center the selected destination.
Use this controller to zoom out of the map (-) or into it (+). The keys “+” and “-” on the keyboard or the mouse wheel may also be used to zoom in and out.

If you would like to show all marked locations and reveal as much of the map as possible, click this button and the map will be adjusted automatically.

If you would like to display only the route without the location markers, click here and the pins will be hidden. A repeat click will display them again.

Show lines (connect locations)
For two or more marked locations, the function “Show lines” will appear. This function connects destinations on a map with a line in order to better visualize the route.

Click this symbol to show lines connecting selected locations. The functions responsible for line transparency, thickness, and color are to the right.

Tip: The order of destinations in the list corresponds to the sequence in which they were created. You can edit the order of the destinations by clicking on a location on the list and dragging it to a new place with the mouse key held down. The route on the map will be adjusted and the line will follow a different course.

Hide line: To hide the line, click on the “Lines” button again.

Transparency and line thickness: Use the controller to change the transparency (left controller) and the thickness of the lines (right controller).

Line color: Set the desired line color using the color field and slider.

Tip: You can also create animations for the connecting line in the “Animation” (view page 108) section and save it as a video.
Animation
For two or more marked locations, the function “Animation” will appear.

**Animation**
This enables you to display your travel route in motion and even save it as a WMV format movie, e.g. to integrate it into vacation movies or to send it.

**Scroll map**: Activate “Scroll map” and the map will move from location to location when the animation is played back.

**Animate line**: The connecting line slowly connects all selected locations, from the first to the last. It is moving at the speed of an animated object.

**Soft animation**: The animation starts slower, speeds up, and then slows down before each location.

**Animate object**: You can select an object to follow the route of the trip, such as a car or an airplane.

**Duration (seconds)**: You can adjust the duration of the animation however you like, depending on the length of the route. Enter seconds into the field and test the results via the preview option to see if you like the animation.

**Preview**: Before you save an animation as a video, test it to see if it looks the way you want it to by clicking “Play”.

**Save video**: Click on this button to save the animation as a video. Enter the save location and name of the video in the dialog that appears.

*Note*: This button indicates the height and width of the future image. These values are adjusted as soon as window sizes are adjusted or when the location list is shown (arrow next to “Destinations”).

**Close**: To leave the animation area, click “Close”.

**Create a picture of a map**
You can create a picture from a section of a map (including location markings), e.g. to print it.

**Step 1**: Zoom into the map until you have reached the desired level of detail.
Step 2: Click this button (shortcut "Ctrl + E") and enter the save location and the name of the image in the dialog that appears. You may also select the format for the picture.

**Note:** This button indicates the height and width of the future image. These values are adjusted as soon as window sizes are adjusted or when the location list is shown (arrow next to "Destinations").

Step 3: With one click on "Save", the image is saved and the dialog is closed.

If you want to, you can hide the list of locations to the left to show a larger section of the map.

Another click on this symbol will show the list again.

**Keyboard shortcuts**

<table>
<thead>
<tr>
<th>Manual selection of locations</th>
<th>“M”</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom into map</td>
<td>“+” on the number block</td>
</tr>
<tr>
<td>Zoom out of map</td>
<td>“-” on the number block</td>
</tr>
<tr>
<td>Save location list</td>
<td>“Ctrl + S”</td>
</tr>
<tr>
<td>Load location list</td>
<td>“Ctrl + O”</td>
</tr>
<tr>
<td>Save map section (with location markings) as image</td>
<td>“Ctrl + E”</td>
</tr>
<tr>
<td>Move map section north (upwards)</td>
<td>“Up arrow”</td>
</tr>
<tr>
<td>Move map section east (right)</td>
<td>“Right arrow”</td>
</tr>
<tr>
<td>Move map section south (downwards)</td>
<td>“Down arrow”</td>
</tr>
<tr>
<td>Move map section west (left)</td>
<td>“Left arrow”</td>
</tr>
<tr>
<td>Cancel video export</td>
<td>“Esc”</td>
</tr>
</tbody>
</table>
Movie templates

MAGIX PhotoStory on DVD 2013 Deluxe includes ready-made trailer projects for a range of styles (e.g. action, documentary, travel...) in which you can replace the integrated placeholders with your own photos. This way selected photos are bordered with music, intros and titles and are presented in a way that creates powerful trailers. Movie trailers can be directly selected when creating a new project or controlled in the Media Pool under “Media”. Double-clicking on a menu template will open it in Storyboard Mode.

Insert your own material

Suggested structures will appear on the storyboard when the movie trailer is loaded.

Now you can add your own content. Simply drag and drop videos or images from the Media Pool onto the placeholders. The placeholder names indicate which type of material should be inserted here (e.g. “Group shot”).

Audio tracks of inserted material

Menu templates contain audio material. For this reason, the audio track of the inserted audio material will be muted. You can, however, switch it on again by clicking on the speaker symbol in the preview image.

A speaker slide controller appears which lets you control the volume of the original audio track of the inserted video clip.
Design title

Click on the T symbol in the preview image to edit the title included with the movie template.

You can enter your own text in the title editor (view page 69).

Create panorama images

This special function can be selected for highlighted photos under “Effects > Create panorama”. Using it, you can combine several photos into a wide panorama photo. You can also let your imagination run wild and put together anything you want to.

Tip: Optimize your photos beforehand, so that the transitions are not to be seen in the finished panorama.

Select pictures for panorama

The images that should make up the panorama should be selected one after the other while holding down the Ctrl key. Then select the option „Create panorama photo“ in the „Effects“ menu (view page 165).

Invert image sequence for panorama image

Sometimes photos are accidentally loaded in the wrong sequence. To sort the photos properly, click on the “Invert sequence” button.

Panorama settings

Don’t use camera movements on panoramas: The panorama image will be displayed in your slideshow in its entirety. This option is less effective than a camera pan across the image yet well suited for capturing the sheer size of a landscape or city panorama.

Automatic camera movement from lefts to right / from right to left: The finished panorama will zoom in when viewing the finished slideshow. Additionally, the camera position pans from one edge to another. On one hand, this means that no whole panorama image will be displayed, on the hand you will be every detail.

Calculating the panorama image

If you click “Create”, the panorama image will be processed. Depending on the resolution and number of original images included, this may take some time. The
original photos are replaced in your slideshow with the panorama image you’ve created, but the original files on the hard drive will remain intact.

**Hint:** You can create a panorama image from a maximum of six images. Click on “More options” for more information on the upgrade.

**Finished panorama (2 images)**

![Finished panorama from 2 images](image-url)
Automatic volume damping

If you have added background music to your slideshow or created a collage of several videos that will be played back simultaneously, you can specify the “foreground audio” by reducing the volume of all other audio tracks.

To do this, use the volume decrease option in the “Effects” menu.

1. Select the video that should be heard above the others.

2. Select “Volume decrease” in the “Effects” menu. The “Volume decrease of other tracks” dialog will open.
   - Choose between weak, moderate and strong to decide how much the volume should be reduced.
   - Enter the length of the transition: This sets the length of the range for the volume decrease of the other tracks and when they will return to normal volume.
   - If only the video sound of the other tracks should be reduced and not an audio file such as background music, place tick in the box marked “Only decrease video sound”.
   - Confirm your entries with “OK”. The audio track of the selected video will now be heard above all the others. On pure audio tracks on track 4 a volume curve is displayed where you can see the decreased range. You can use the handles to adjust the decrease manually.

If you want to reset the decrease completely, select the adjusted object and go to “Effects” > Volume curve > Reset”.

www.magix.com
Manual volume decrease

1. Select “Display volume curve” in the context menu of an audio track. It will be displayed as a colored line.

2. Double-click on the point in the curve where you want to set an automation point.
   
   • For a simple volume progression, e.g. a volume decrease, 2 automation points (beginning and end) are required. To bring the volume back up to normal after a reduction you will need to set 4 automation points.
   • Curve points can be easily moved by drag & drop, during which the mouse pointer turns into a cross.
   • An additional double click on an automation point deletes it.

Note: During audio recording, volume curves can be automatically created if the Volume decrease (“Ducking”) (view page 88) option is activated.
Stereo3D

MAGIX PhotoStory on DVD 2013 Deluxe enables the editing and creation of “genuine” 3D videos and photos. First, let’s create an overview of this complex topic by familiarizing ourselves with the most important principles and the golden rules that are involved. Next, we’ll look at the individual steps of the workflow in more detail.

Note on using 3D content: Some people experience unpleasant symptoms (e.g. headaches, overexertion, eye strain or nausea) when they are exposed to 3D video. We recommend taking regular breaks for this reason. In case of problems, the user should immediately stop use and refer to a doctor or optometrist. Incorrect production of 3D-content may also produce these symptoms.

Warning for small children: The sight of small children (especially those younger than six years old) is still developing. We recommend referring to a doctor or optometrist prior to allowing your child to view 3D-videos.

3D basics

Human eyes perceive objects from 2 different angles and our brain “calculates” images from this information. This way we can tell the distance and position of an object. For this reason, 3D material should be shot according to this principle.

Viewing 3D

A regular screen or TV can show images only in 2 dimensions, and various technologies have been developed to enable perception of images in 3D. To this day, all technologies share the following: You need special glasses to deliver different information to the left and right eyes. We will examine these technologies in detail later.

The three golden rules

• Stay within limits during recording: To make a 3D recording (view page 117) with realistic depth information, certain limits must be respected. The most important rule is not to go below the point of minimum distance. Minimum point is the point in the picture, where the camera is the closest.
• Frame closest point: In order to place the 3D effect behind the imaginary frame, both image components must overlap each other exactly at the closest point. At the same time, the same objects must be visible at the edges of both partial images, for which, if needed, you can use the Cropping function in the Media Pool.

Note: The imaginary window is a type of a plane, behind which the 3D movie plays. You select the closest, frontmost point. Not keeping up with this rule can result in...
the object to “jump out” of the imaginary window, which when used too much, can cause headaches.

- **Maintain realistic eye angles:** Object with a 3D depth effect viewed as a red/cyan image (Anaglyph) without glasses will appear displaced. This displacement should, if possible, take up less than 1/30 of the entire image. Otherwise, it will appear that the eyes are looking in different directions.

**Notice:** Displacement may only occur along the horizontal axis. Displacements on the vertical axis and rotated portions must be adjusted.

### Record 3D

The distance between eyes in humans is ca. 65 mm, which forms the so-called “stereo base width”. But because our eyes are dynamic and we can even “cross” our eyes, it is possible to focus on objects that are closer.

Various techniques exist for 3D recording. Each method has its advantages and disadvantages:

- **3D cameras with two lenses:** The advantages are obvious; these cameras produce 3D material without excessive work involved. The disadvantage is that the stereo base width (lens distance) cannot be changed.

- **Two cameras on a special mount:** This involves a little more work. Two cameras are mounted on a special support to record material for the left and the right side of the 3D image simultaneously; microphone booms for stereo recordings may also be used for this purpose. The disadvantage in this case is that the shutter releases have to be pressed at exactly the same time if there are moving objects in the picture. In case of video, both movies must be synchronized before being edited. Advantages: Stereo base width may be changed by adjusting the distance between the cameras; larger selection of camera models.

- **Two photos via the same camera:** This technique only allows still images. The camera is simply used to record two images from different perspectives, and these are used as the right and left images. For best results, use a tripod.

- **Consistently fast camera movement, e.g., along a street:** Only a single conventional camera is required in this case, but the range of applications is very limited. This is the most cost-effective method for creating 3D videos. Material is filmed at a speed of circa 6-to 15 km/h. During editing, the edited video object is duplicated and one of the videos is played back with a time lapse. The movement direction determines which is the right and left image. 3D photos may also be created using this method.
Warning, minimum distance!

The position of the object closest to the lens is designated as the minimum point. This minimum point may not exceed a specific minimum point; this is easy to calculate via the following formula:

\[
\text{Note: } \text{Lens focal point} \times \text{stereo base width} \times 1.5 \times \frac{1}{ \text{mm}^2} = \text{minimum point (e.g. 2437.5 mm ~ 2.44 m)}
\]

*1.5 is a factor derived from the cut-off appearing when filming through a lens.
**1 mm is the so-called “deviation” or “spatial dimension”. This only involves a rough value in this case.

Examples for 3D cameras:
Panasonic HDC-SDT750 (base width 12 mm): minimum point is approx. 1.5 m.
Fuji REAL 3D W3 (base width 75 mm): minimum point at approx. 3 m; for long-distance recordings as much as 8 m.

This so-called minimum point has an important role in other aspects of 3D editing.

Prepare 3D editing

3D videos are filmed and saved by different cameras, which means: depending on the camera model or recording method, the videos or images vary.

In one file

Many cameras, especially for photo recordings, create one single file containing the left and the right image next to one another.

- Drag these files from the Media Pool directly into your arrangement.
- Select the created objects.
- Select the “Side-by-Side (left images left/right)” entry in the Media Pool under “Effects > Stereo3D > Properties > Create stereo”.

In multiple files

Some 3D cameras create a file for each the left and the right side. This working technique works also if you simply take 2 pictures with a regular photo camera.

- In the Media Pool, open the folder in which the desired file can be found.
- Sort the files in increasing order according to the date. This way, all files will lie in pairs one below the other.
- Now, select the files and drag them from the Media Pool directly into your arrangement.
- In the Media Pool select “Side-by-side (left image right/left)” under “Effects > Stereo 3D > Properties > Create stereo” for material with halved width.
Note: If you have created side-by-side material yourself (e.g. placed two photos next to each other in an image file), proceed as described, but at the end select the "side-by-side (left image left/right)" for material with full width.

Note: To load MVC material into MAGIX PhotoStory on DVD 2013 Deluxe, you must first activate this codec for a fee.

Set playback mode for 3D

There are various techniques available for playback of 3D videos on the computer. Depending on the technology used, the corresponding playback mode may be activated in MAGIX PhotoStory on DVD 2013 Deluxe.

Select the 3D mode you want to work with in the lower right corner of the video monitor.

Here is a list of available techniques and the corresponding requirements:

<table>
<thead>
<tr>
<th>3D mode</th>
<th>Technology</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>View partially interlaced</td>
<td>Polarizing filter</td>
<td>• Polarizing filter glasses</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• A special monitor, typically referred to as a 3D monitor.</td>
</tr>
</tbody>
</table>

Note: You can choose between right or left image first, depending on which type of display produces better results on your monitor.

Shutter export

Shutter mode

• nVidia 3D Vision Kit
• 120 Hz monitor/projector

Side-by-side Display

• 3D TV

Note: You can choose between right or left image first, depending on which type of display produces better results on your monitor.

Note: Both of these modes should only be set if the preview image is displayed on a separate monitor. Shutter mode also requires a 3D-capable graphics card.

Anaglyph display

Color anaglyphs

• Red/cyan glasses
Align videos and pictures for 3D

Anaglyph display is recommended for this and can be set in the video monitor (view page 119). Only in this mode is precise geometric alignment of images is possible.

**Note:** In case you wish to edit 3D-video material, it is recommended to conduct scene recognition and split the video into individual scenes. This is necessary because the left and right side of each scene must be arranged individually.

The so-called minimum point is the point in the 3D picture that is closest to the lenses. This forms the “center” of the 3D image and must be defined as such in MAGIX PhotoStory on DVD 2013 Deluxe.

To do this, go to “Media Pool -> Effects -> Stereo 3D” > “Alignment”.

Move both images one over the other, so that the minimum point of both sides is at the same location on the screen.

You should first see whether automations for spatial adjustment and synchronization deliver desired results. Click on the button “Automatic”.

If this does not produce the desired effect, proceed as follows:

- Find the minimum point in the image.
• If the images are offset vertically, these need to be balanced using the lower of
  the two slide controllers under “Spatial alignment”.
• If the images have rotational differences, you have to adjust these with the knob.
• Try to position the minimum points of both sides precisely one above the other
  using the upper slider.
• To test the results, put on the cyan/red glasses. In case the image has an
  exaggerated spatial depth, try to position the left and right sides closer to each
  other using the controls under “Spatial alignment”.

Turn camera movements into 3D videos

Camera movements may be transformed into 3D videos by being duplicated and
converted via time displacement. To do so, you can simply record on the right or the
left side while, for example, driving along a street.

The speed should be set between 6-15 km/h (approx. 4-10 mph) and depends on the
frame rate, the focal point, and the distance of the objects being filmed (among other
things). At increased speeds, it may occur that the spatial impression is too strong
and the filmed material seems unnatural and unpleasant.

• If the video is in the arrangement, the stereo depth for the 2D object may be set
  in the Media Pool via “Effects -> Stereo 3D --> Properties”.
• Depending on the direction of the recordings, you will have to move the control
  either to the right or the left.
• Check the results in the anaglyph display with red/cyan glasses
• Correct any unrealistic effects by adjusting the controller in the opposite
direction.
• If the spatial depth is exaggerated, reduce the changed parameters.

**Note:** Not only camera movements, but also other 2D materials may be arranged
spatially.

3D material may be edited with the same functions as 2D material.
Export and burn 3D videos

There are no special requirements for export and burning. Only the desired 3D technique is specified.

**Anaglyph:** This technique is recommended for uncomplicated playback of finished videos or playback with conventional TV sets or projectors. Viewers must simply put on a pair of red/cyan glasses to be able to enjoy a 3D movie.

**Side-by-side:** Create 3D movies for a 3D-capable playback device without having to compromise the quality. It doesn’t matter initially whether your video is viewed in “Shutter” mode or in “Polarized filter”.

- Depending on your playback device, you should set double resolution in order to produce full resolution for both the right and the left image.
- Not all playback devices are capable of double resolution. If this is the case for your device, 50 % pinched images will be displayed. The quality is nevertheless higher than output using the anaglyph technique.

**Note:** When exporting to side-by-side-formats, make sure that the vertical resolution is the sum of both images, but the aspect ratio (e. g. 16:9) is based on a cropped image.

**Only left/right side:** This settings exports only one side of your 3D video instead of the entire 3D video.

**Lenticular image:** This allows you to view 3D footage without 3D glasses. The footage is displayed interchangeably to give the impression that it is wiggling or shaking.

**Superimposed:** This export option is similar to „Side-by-Side”. The images are superimposed during output.

- Depending on your playback device, you should set double resolution in order to produce full resolution for both the upper and the lower image.
- Not all playback devices are capable of double resolution. If this is the case for your device, 50 % pinched images will be displayed. The quality is nevertheless higher than output using the anaglyph technique.

**Note:** When exporting to superimposed-formats, make sure that the vertical resolution is the sum of both images, but the aspect ratio (e. g. 16:9) is based on a cropped image.
**Export files/upload movies to the Internet**

The standard path for all file exports is “File > Export” or “File > Internet”. Depending on the export format and destination, the export dialog also allows the 3D technique to be used to be selected.

For direct selection as Windows Media Video 3D, click “Output” and select “3D movie” from the dialog.

**Burning**

When burning a Blu-ray Disc or DVD, you must first open the encoder settings in the burn dialog and set the desired 3D technology. Next, you may proceed to burn the disc as usual.
The "Burn" interface

Click on the displayed button to go to the "Burn" screen.

Here you can burn your slideshows to DVD, Blu-ray Disc or AVCHD including a selection menu. All slideshows loaded into the project are taken into account. If you want to remove some of the loaded slideshows, switch to the "Slideshow" screen and delete the unwanted slideshows from the project there.

**Note:** At a screen resolution of 1280 x 1024, the program display changes. This makes the program more manageable and easier to use. The work steps remain the same in spite of the different display.

---

1. **Views:** Here you can switch between the „Preview“ and „Edit“ (view page 127) views.
2. **Preview:** This shows you what your disc will look like when you put it into a player.
3. **Remote Control** for testing the menu function.
4. **Categories:** Here you can open (view page 126) various types of menu templates.
5. **Menu Templates:** A selection of designs you can use for your menu. In "Edit" view you can combine various elements for different templates to create your own design.
6. **Burn:** Here you can open the disc selection dialog (view page 28).
Preview and editing

MAGIX PhotoStory on DVD 2013 Deluxe provides two different modes for designing and previewing the disc menu.

The preview mode is mainly intended to behave like a DVD player or Blu-ray player for checking the disc menu under realistic conditions. Only templates may only be used; more detailed editing of the disc menu is not possible at this time.

During editing, you may adjust many features of the disc menu. There are many templates available for this that may be changed flexibly once loaded.

Remote control

The virtual remote control is an important helper when it comes to checking how the disc will perform later.

This remote control works just like a normal remote control and can be used to navigate through the disc just like you would on a normal player. The DVD menu navigation can now be initiated with the arrow keys or the “OK” button. Activated buttons are highlighted.

The number keys select the corresponding entry on the menu page. All menu entries are marked with a corresponding number. Within a chapter menu, playback is started from the particular chapter. In the movie menu, the corresponding chapter menu (if available) is changed or slideshow playback is started.

Navigation buttons: These buttons can be used to navigate in the menu of the disc that will be burned. The entries can be changed and confirmed by clicking “OK”. The remote control works just like the remote control for your home DVD player.

Skip/move forward/back: This allows you to skip to the next or previous scene while playing back your movie. In the menu, you can skip forward or back from one menu page to another.

Play: Starts the first entry in the menu. In case chapter menus are available (see menu modes), the chapter menu will be displayed first.

Pressing the Play button again starts playback.
Stop: Pressing stop halts playback.
Disc switches to the first page of the movie menu.
Sub switches into the chapter menu (if available) of the currently selected slideshow.

Menu

MAGIX PhotoStory on DVD 2013 Deluxe can add selection menus to your slideshows. The menu is also burned to disc and appears when inserted into your player. Just like with a purchased DVD or Blu-ray Disc™, you may easily select your movies with the help of preview pictures, or access particular chapters within a movie.

Menu templates

At the bottom of the screen, you’ll see an array of preset menu templates. A tree structure is located on the left-hand side for you to choose the type of menu template.

- **Animated:** These templates contain background and introductory videos as well as music. The DVD menu tools are displayed in various modes (e.g. selected buttons). These templates are designed for DVDs.
- **Static:** Here you will find templates that are also designed for DVDs. They consist of normal background pictures and elements.
- **Unique:** These templates adjust to your disc project; the photos you use are integrated directly into the menu.

**Note:** For these menus both the „Movie menu“ and „Chapter menu“ modes have to be activated in „Menu design“.

- **HD (DVD, Blu-ray, AVCHD):** These menus contain razor sharp high-resolution background images that look especially god on HDTVs.

If you’ve selected one of the menu templates, you can use the horizontal scroll bar to view all the others available. There are lots of options when using the templates:

- If you wish to apply a template to all menu pages, click on ”Complete“ in the template bar and double click on the template of your choice. The complete template will then be applied.
- You can also combine the various elements of the individual templates. If, for example, you wish to combine the text format of a template with another background, select ”Text“ and double click on the template with the desired text. The preview in the middle shows you the results immediately.

You can load the layout (or individual layout elements) for the current menu (movie or chapter) as well as for all menus.
Click on this button to load the current selection for the entire disc menu. Clicking on the small arrow next to the button opens a menu containing additional options for applying the current selection to the disc menu or current menu page. Here you can set the screen format for the disc menus (widescreen or 4:3).

Starts the preview of the menu animation

**Edit disc menu**

The preview pictures and the menu title can be moved freely in the preview monitor. The menu may be edited very flexibly.

Activate the “Edit” button to do this.

**Edit menu elements**

Hold down the left mouse button and drag text boxes or graphical elements to the desired position. You can adjust the size by dragging out the corners and edges of the frame.

You can undo the last steps you made. This means that you can easily try out critical operations. If the result does not meet your expectations, then you can simply “undo” it and return to the initial status.

Keyboard shortcut: Ctrl + Z

This command cancels a previous “Undo” command.

Keyboard shortcut: Ctrl + Y
Set aspect ratio: To avoid distortion, use this button to set the aspect ratio for the menu elements.

Group: Menu elements are moved or resized simultaneously as a group, including the description text and number.

Fade in TV display area in the preview monitor: This option displays the image borders of the television (view page 85) as lines in the preview monitor.

Grid: You can precisely align the frame positions with one another using the grid button. Using the small arrow next to the button you can open a dialog to fine tune the grid settings.

PSD Import / Export: Clicking on this button imports/exports a self-created menu template as PSD file (for further use in Xara Xtreme Pro, Photoshop...)

Navigation

- All movies are listed as first entries. The corresponding menu level is the film menu.
- All scenes are listed as second entries next to it to the right. The corresponding menu level is the chapter menu.

Removing the red check deactivates the corresponding entry in the chapter menu. The scenes are still played, but you can no longer select them directly from the menu.

- If you click a film entry, then the film menu will open in the preview.
- If you click one of the chapters listed, then the chapter menu will open in the preview.

Disc options

Here you can activate or deactivate certain elements or even complete menus.

Intro video: Press this button to load videos to be used as introductions to your discs. The following formats are supported: "*.avi", "*.mpg", "*.mxv", "*.vob". The intro is played immediately after the DVD has been inserted into the player. The DVD menu will then appear. A check mark "Do not skip" ensures that the intro video must be played completely each time the disc is inserted and that it may not be skipped with the remote control or otherwise.

Slideshow & photo menu

The disc menu essentially consists of two layers:

Film menu: The upper layer includes the film menu, which is only used if a project contains multiple slideshows.
The "Burn" interface

Chapter menu: This is the lower layer of the disc menu, which takes the photos (in the first track of the timeline mode) into the slideshow as chapter entries.

Note: A chapter menu cannot contain more than 99 entries. If your slideshow contains more photos, you should either burn the slideshow without the chapter menu or split your slideshow into several parts.

Preview pictures: Shows/hides the preview pictures in the disc menu.

Numbering: The numbers beside the menu entries can be selected directly using the remote control, but they be disrupted from time to time. Use this option to show/hide them.

Frame: A frame borders the preview pictures. If this is unwanted, it may be removed easily using this option.

Design page

Background: Here you have three options for creating a static background image for the menu:

- You can set a certain color value for the background.
- Select any image file from the hard drive or one of the included backgrounds.
- You can select a frame from your project.

Edit current menu templates: Opens the PSD editor set under path settings (view page 31).

Apply to all pages: Applies changes to the current menu page to all other menu pages.

Only in the deluxe version: New menu pages may also be added or irrelevant pages may be removed.

Adds a new menu page.

Removes the selected menu page.

Animated selection menus

You can also add audiovisual animations to the disc menus. As required, background videos are played as endless loops while the menu is shown on the screen. You can also set up background music in various formats or any background picture for each menu.

Sound/music: You can load a music file for the menu background animation.
Video: Here you can load a video or graphic file for menu background animation. In addition to the options for the background graphic (see above), you can also use a sequence from a loaded slideshow or from a different video file.

Background video options:

- **Create animated menu buttons**: The preview images for the individual slideshows on the movie menu will be displayed as small videos. Set the starting point and length of the animation using the sequence option sliders.
- **Use the audio track of the video**: The audio track of the background video is used with the menu.
- **Play menu animation as an endless loop**: The background movie (audio and/or video) will be played back as a loop.
- **Length of the menu view is set by**: Audio/video or whichever medium is longer. Here you can determine the length of the background video. The other medium will be played as a loop.

Create a button design

MAGIX PhotoStory on DVD 2013 Deluxe enables easy editing of all buttons together with their menu entries.

You can edit menu entries that you created using this button or with a double click on the menu. The dialog with the properties of the menu entries (view page 131) will open.

Edit in MAGIX Photo Designer 7: You can open MAGIX Photo Designer 7 for additional editing of elected menu elements.

Apply to all objects: Applies the properties of the selected button to all remaining buttons.

New menu items can also be added and irrelevant items can be removed.

Adds a new menu entry.

Removes the selected menu entry.

Tip: You can deactivate unused menu items in Navigation.
Jump to linked page

To test the targets of menu entries, select the desired menu entry and click the button.

Menu entry/menu page properties

Double clicking the preview picture or a menu entry opens an editor for you to adjust the preview picture or menu entry.

Menu text

In the text input field, you can enter any text to match the chosen menu entry.

Set the vertical direction of the text (upwards, centered or downward).

Set the horizontal direction of the text (left, centered or right).

Font size: Set the height of the text in pixels.

Font color: Define the foreground color of the text.

Font: Set which font and which style (bold, italic, etc.) should be used.

Shadow: Set the color and size of the shadow that will appear underneath the text.
3D effect: If you would like to make your text appear three-dimensional, you can set the width, height, and color of the 3D effect.

Apply to all: Except for the text, all settings are applied to all entries in the current menu.

Menu image
Use frame from movie: Use the fader to set which frame should be used in the video as a preview picture. The numerical input fields are sorted as follows: Hours:Minutes:Seconds:Frames.

Use different graphic: You can also load your own bitmap images to be used as menu pictures.

Hint: It may be the case that there are no menu pictures in some menu templates, so changing the menu picture won’t have any noticeable effect.

Actions at the end of the slideshow (Slideshow menu only)
Here, you can enter which action should be carried out once the slideshow has finished playing. You have the choice of:

Stop playback: This option depends on the DVD player being used. Most DVD players show the DVD player’s own menu (or background picture) after playback.

Jump to movie menu/chapter menu: Jumps back to the previously shown menu.

Tip: Should one of the two options not be available, please check which menu mode is set.

Jump to next film: The next slideshow will be played without having to do anything else.

Play slideshow as an endless loop: You can burn every slideshow onto a miniDVD or DVD as a loop as well. This means that the slideshow is played as a endless loop until the next menu entry is accessed using the remote control or playback is stopped. This way, you can transform your TV into an aquarium, a train journey, a fireplace or anything that you could watch over and over again.

Note: This option only works with DVDs or mini DVDs.
The "Burn" interface

<table>
<thead>
<tr>
<th>Disc type</th>
<th>Data carrier</th>
<th>Menu</th>
<th>Quality</th>
<th>Length (optimal quality)</th>
</tr>
</thead>
<tbody>
<tr>
<td>DVD</td>
<td>DVD</td>
<td>Yes</td>
<td>***</td>
<td>98 min.</td>
</tr>
<tr>
<td>Blu-Ray Disc</td>
<td>Blu-Ray Disc</td>
<td>Yes</td>
<td>****</td>
<td>110 min.</td>
</tr>
<tr>
<td>AVCHD (view page 200)</td>
<td>DVD/Blu-ray Disc</td>
<td>Yes</td>
<td>*****</td>
<td>30 min./DVD</td>
</tr>
<tr>
<td>Multi Disc</td>
<td>CD/DVD</td>
<td>Yes</td>
<td>****</td>
<td>45 min./DVD, 7min/CD</td>
</tr>
</tbody>
</table>

* The set duration for some DVD players may be determined by this table. Depending on the original size (file size of the images) the number of images that fit on a blank CD or DVD differs.

For the MPEG-2 encoder it can be difficult to supply reliable information relating to the required memory space. If the "variable bit rate" of the MPEG-2 encoder is activated, encoding will occur according to the movements in the picture. The required memory depends on the film material; an action film would need more memory than a drama, for instance.

If you cannot save your disc project on a single disc, you will have to divide it up into different sections.

Further information on MPEG compression and formats can be found in the chapter "Annex: digital video and data storage" (view page 197).

Test series with variable encoder settings

If you would like to know how much memory space you require for various encoder settings, you should run some simulations before burning.

So you don't waste any blank CDs while testing, you should activate the "Simulate first" option.

Then create, for example, a short (ca. 5 min.) disc project and simulate burning in multiple cycles with various settings.

After every simulation you can access the created file on the hard disk to check how large the file has become.

From the results, you can extrapolate how much disc space your disc project will require. The memory requirements of a 5-minute disc project would have to be multiplied by 20 in order to estimate the space required for a 100-minute movie. You should also add buffer for the selection menu. (view page 126)
Separate project onto multiple discs

**Automatically:** If the disc project requires more memory than is available on the disc, a dialog will appear before burning asking whether the disc project should be automatically segmented for multiple discs. Confirm this by clicking “Yes”. The disc project will then be automatically divided into individual disc projects and burned sequentially onto multiple discs. This is the easiest method as everything is automatic and all you have to do is insert a new blank CD when required.

**Manual**

**Case 1:** If several slideshows do not fit onto a single disc.
In this case, delete as many slideshows as is needed until the remaining slideshows fit onto the disc. You can create a new disc project and load and burn the other slideshows afterwards.

1. Switch back to the “Slideshow” interface.
2. All slideshows which shouldn’t be burned at this time must be placed into a project of their own. Save them separately to your hard disk (“File > Manage slideshows > Export slideshow file, for example, as “Part 2” and “Part 3”).
3. Remove the desired slideshows (e.g. “Part2” and “Part3”) from the project (menu “File > Manage slideshows > Remove from project”).
4. Switch to the “Burn” interface and burn the first slideshow (“Part 1”) to disc.
5. Create a new disc project (“New” button), switch to the “Edit” view and load it into the second slideshow (“Part 2”).
6. Switch to the “Burn” interface and burn the second slideshow to disc.
7. Repeat the last two steps for each separately saved slideshow.

**Case 2:** If a long slideshow doesn’t fit onto a disc.
In this case, the slideshow has to be split into two or more parts that will be burned separately onto disc.

1. Switch back to the “Edit” view and place the playback marker to the position where you want to divide the slideshow. Select “Separate slideshow” in the Cut menu in the toolbar.
2. All passages behind the playback marker will be removed from the overly long slideshow and made into a separate slideshow. Both slideshows can be controlled through the slideshow tab in the arranger. Save both of them separately to your hard disk (“Slideshow > Manage movies > Export slideshow file” menu option, for example, as “Part 1” and “Part 2”).
3. Remove one of the two slideshows (for example, “Part 2”) from the disc project (“Manage slideshows -> Remove from project” menu option).
4. Switch to the “Burn” interface and burn the first slideshow (“Part 1”) to disc.
5. Create a new disc project (“New” button), switch to the “Slideshow” view and load it into the second slideshow (“Part 2”).
6. Switch to the “Burn” interface and burn the second slideshow to disc.
Edit DVD menus with MAGIX Photo & Graphic Designer 7

Besides the option of editing the menu template directly in the preview, menu templates can also be exported as a Photoshop file (*.psd) and edited in Xara Photo & Graphic Designer 7. This provides complete control over the appearance of your menu including complex text effects and the design of highlights.

Export menu
The transfer of the menu templates to the graphics program takes place in one of two ways:

- If a complex, longer edit is required or if you have created a menu without a template, then use the PSD import/export function in the menu editing functions.

Next, open the PSD file in the graphics program of your choice.

For smaller changes, you can also shorten this process: click the button “In external editor” in the “Disc options” on “Design page”.

A temporary PSD file will be added and opened in the program that has been selected in the program settings as the menu editor. After editing has been completed and saved in this external program, the temporary PSD file will be imported again and the menu page will be updated immediately.

Menu text with external menu editing
Menu elements are transferred as a bitmap during PSD export as well as during import of the edited PSD. This also applies to the text displayed in the menu. This text may also normally be changed in the “Menu entry properties” dialog. The menu text are adjusted if movies or chapters are added or removed.

The PSD contains these texts as a bitmap and cannot be changed. During importing, the bitmaps replace the original text entries. By the way, this is maintained, and the font will only be set to a size of 0 so that texts are not displayed in duplicate; the menu will therefore look identical after external editing.

It is important that no more movies or chapters are added to the menu. Otherwise the preview images, that have also changed along with the menu structure will no longer match the bitmap text, since the bitmap text will not match the changed references in the menu structure!
An example

A chapter with two entries is present. Entry 1 is named "travel preparations". Entry 2 is named "arrival". A chapter named "the trip" is going to be added between chapter 1 and chapter 2. The second chapter now becomes chapter 3 and moves to the next menu page.

**Normal text behavior**: The second entry (now with preview image for the newly inserted chapter) receives the new title "the trip". The next menu page features chapter 3 as the first entry with the name "the trip".

**Text after external menu editing**: The second entry will feature the title "arrival" (as a bitmap, as a component of the button), but the preview image will feature the new chapter "the trip"! The next menu page now features the preview image for chapter 3 (formerly chapter 2, "arrival"), this is now called "travel preparations"! The name is a component of the button as a bitmap for the first menu entry on the page, and this is "travel preparations" on the first menu page. Completely out of order!

If the number of menu entries displayed is increased, this results from copying the layer groups in the PSD (see below). Of course, the rendered text layers are also copied into the layer groups, which results in incorrect text again.

The best way to proceed is to edit the text entries at the very end, since changes normally will not follow at this point. If changes are required nevertheless, then proceed as follows:

1. Restore the "correct" chapters or movie names by resetting the font size in the dialog "Menu entry properties" to the default value. Two texts will be displayed; the incorrect bitmap and the correct one.
2. Export the menu template as a PSD.
3. Delete the incorrect bitmap object in the corresponding layer and re-import the PSD.

Of course, the menu text may also be added from the start via an external graphics editing program only (in order to take advantage of the additional options provided in this case). Delete the corresponding bitmap objects in the PSD immediately after export and replace these with your own text objects.

**Structure of a PSD file**

MAGIX PhotoStory on DVD 2013 Deluxe produces a PSD file during export that contains a layer for each object of the menu entry. This uses a naming scheme that enables assignment of the objects in the file to their contents. Individual layers feature mathematical signs that indicate their function. This naming scheme is similar to that featured in Adobe Premiere and which is only expanded occasionally in MAGIX PhotoStory on DVD 2013 Deluxe to describe additional mechanisms.)
This is how these mathematical characters are used:

**Characters for layer groups**

++ or (+) Play button/start film
(++) Chapter menu button
(->) Next page
(<) Previous page
(+) Root menu button (jump back from chapter menu)
(*) Menu title:
(**) Layer group is ignored

**Characters for individual layers**

(-) Layer contains text
(=1) Layer contains a bitmap with a highlight of the menu element.
(%) Preview image/thumbnail from the movie to be referenced
Bitmap information will be ignored during import and only the size and position will be exported.

**Edit externally**

**Step 2: Edit menu in MAGIX Photo & Graphic Designer 7:** The created PSD file will now be loaded in the external applications.

**Editing a menu for 3 to 5 movies**

Once the PSD file has been loaded in MAGIX Photo & Graphic Designer 7, the pages & layers gallery will open. Each layer of the PSD file will be created with the contained objects via the corresponding Photo & Graphic Designer layers. The layer groups are represented by the names of the individual Photo & Graphic Designer layers, with PSD layer names separated by backslashes (\).

Find the layers of the group, which you would like to duplicate. In the example, this refers to the 4 layers on the movie button ad two layers of the chapter menu button. You will have to work a little to ensure visual assignment of the objects to the work area, since the program does not select the corresponding objects when a layer is selected, and conversely it doesn’t select the layer when the work area with objects is selected. Open a layer in the pages & layers gallery and select the contained object. The selection is displayed in the work space.

Clicking “duplicate” copies the 6 layers individually with the corresponding objects in the pages & layers gallery. The created layers will always be placed at the top position, so it makes most sense to copy the existing layers from the lower level to the top. Otherwise, the correct order of the new layers may be restored using drag & drop.

Next, select all of the button’s objects while holding the “Shift” key to move them to a new position. Normally, the frames and chapter menu objects behind the highlight
layers also need to be selected and dragged. Multi-selection in the object gallery is not possible since the objects are in different layers, and the program will prevent you from selecting them together.

These steps must be repeated for each additional button.

Finally, the changes must be saved as a PSD file. Select “Export” in the “File” menu to do this (“Save as...” does not allow this).

Add new font to text
In MAGIX Photo & Graphic Designer 7, activate the text tool after loading the PSD file, and write the desired text next to the movie button.

Next, localize the existing text layer for the individual movie buttons (page & layer gallery, see above). Drag and drop the text object from the background into the desired layer and delete the previous text object (“Del” key or “Delete” in the pages & layers gallery). Since naming takes place in the surrounding layer and the objects in program themselves don’t have names, you don’t have to rename anything.

Repeat this process for every movie button and “Export” the result.

Adjust background and buttons
In this case, MAGIX Photo & Graphic Designer 7 features a workflow similar to creating new texts.

For example, when the menu template is open, drag and drop two graphics for navigation buttons into the existing PSD. Two new layers will appear in the menu template with two new graphics objects. Drag these into the layer with the bitmap graphics to be replaced. Renaming them is unnecessary, since the surrounding layers take care of this.

Localize, scale, and move as follows: Create graphics for your new menu, e.g. for “Prev” and “Next” buttons, by dragging them into the open PSD. This includes a total of 4 layers, two button graphics, and two highlights. The highlight layers must be renamed and scaled and placed on the screen using the mouse. Move the layers into the “(+>) next button” or “(+<) prev button” layer set using drag & drop.

Import menu back into MAGIX PhotoStory on DVD 2013 Deluxe
After editing, a PSD file is created, which is imported into MAGIX PhotoStory on DVD 2013 Deluxe again and must then be assigned to a menu page as a template.

If access takes place through “Edit externally” see “Export menu” (view page 135), this is done automatically during saving and closing of the graphics program. Otherwise, use the button “Import PSD” to do this.

This imports and converts the PSD (saved to an automatically generated folder in the folder Content\DVD\Layouts, with TPL files and the generated bitmap files).
Create DVD menus without a template

It is recommended that an existing menu template is adjusted first with a graphics program. This exercise will help you learn about the functions and structure of a DVD menu as a PSD file to create menus without using any templates.

You can create PSD files without templates if the following is observed.

• MAGIX PhotoStory on DVD 2013 Deluxe can only use bitmap layers from the menu PSD file. Text layers are read as a bitmap (graphic) so that MAGIX PhotoStory on DVD 2013 Deluxe cannot make any changes to the text. Layer effects, etc. cannot be read by MAGIX PhotoStory on DVD 2013 Deluxe. For this reason, all layers featuring additional features in the graphics program need to be reduced/combined to bitmap level.

• The correct naming of layers is very important! MAGIX PhotoStory on DVD 2013 Deluxe assigns the layers and layer groups to the menu items via their names, which makes their correctness important. The characters added in front (view page 135) of the layer names should therefore be observed.

A correct menu PSD contains the following elements:

• background
• menu title
• x movie buttons with preview image, frame bitmap, text for menu, text for numbering, highlight
• one chapter menu button per movie button with bitmap and highlight
• 3 navigation buttons: in front, in the back, and the root menu

Background: The background utilizes all layers from the PSD file from the very back to the foremost “usable” layer groups. All of the layers up until this are combined via alpha layering. If the appearance of the background in the graphics and in MAGIX PhotoStory on DVD 2013 Deluxe is different, then this step may also be made in the graphics program. In Photoshop, all associated layers would be combined with the background layer.

Menu titles: In the next step, the layers of the menu title are added and combined into a single layer group. This must feature a name that begins with “(+*)”. Besides the text layer, additional layers such as text background, shadows, etc. may be present. All layers are unified as a single layer via alpha layering.

Film buttons: Layers for film buttons are each combined as a layer group that features the prefix “(-+)” or “(+)” at the beginning of its name. The layers themselves have different functions that are kept together via this naming prefix.

Preview image: The name of the layer for the preview image begins with “(%).” In this case, MAGIX PhotoStory on DVD 2013 Deluxe only reads the position and size of the
layer and uses this range to generate the preview image. In case multiple preview
images are present, their right corners will be combined during importing.

**Text layer:** This includes text layers beginning with "(-)". "(-) index text" serves as an
identifier for the naming, all other text layers will bear the name of the button label.

**Highlight layer:** The highlight layer is the top of the layer groups. Its name begins with
"(=1)". This should contain a highlight version (e.g. altered color) of the frame bitmap.

All other layers will be combined into a frame bitmap.

**Chapter menu buttons:** The last portion features the layer groups for the chapter
menus and navigation buttons. These are named variously "(++)" or "(+)>", "(+)>",
and "(+^)"); by they feature the same principle the structure. All highlight layers
(begins with "(=1)") become the highlight bitmap; all other layers become the
buttons bitmap via alpha layering.

The sequence of the layer groups from the PSD file is basically not considered by
MAGIX PhotoStory on DVD 2013 Deluxe. Characterization in the program takes
place in the order outlined here, even if the associated layer groups in are saved in a
different order in the PSD file.

An exception is formed by movie and chapter menu buttons: arrangement in MAGIX
PhotoStory on DVD 2013 Deluxe takes place in the sequence featured by the PSD file.
The first chapter menu button detected belongs to the detected movie button, the
second to the second movie button, and so on.
Disc selection dialog

In the “Preview” view you can open the disc selection dialog by clicking the large “Burn” button.

In the “Edit” view you can access the same dialog using the red button.

Here you can select what kind of disc you would like to create.

- DVD is the right format for projects that will be played back on a normal DVD player.
- Blu-ray and AVCHD are good for playback on high-resolution screens.
Burn dialog for DVD player

Here you can select your burner and the type of disc.

If you know something about encoders, you can also adjust the encoder settings if the preset is not sufficient.

When burning a Blu-ray Disc, go to “Data carrier format” and select whether you want to use the MPEG-2 codec or the advanced, but computationally more intensive H.264 codec. If activated, H.264 is set by default, otherwise the MPEG-2 codec.

Proceed as follows to burn a disc:

- **Set up burner and burn speed**: If multiple burners are installed, you may select which device you wish to use in this menu.
- **Encoder settings**: Use the “Encoder” button to access the selection dialog to specify settings for the MPEG encoder (memory requirements, quality, and duration of the MPEG conversion). “Advanced settings” accesses a dialog featuring additional options. You can adjust all the fine settings for the MPEG encoder here.
- **Burning disc/starting video encoding**: The button “Burn disc” starts the disc burning process. Every time you burn and every time a simulation is carried out, the disc project is encoded. Please note that the MPEG file is not deleted from the hard disk after the burn process has finished. Depending on the length of the project, encoding and burning may take some time. The time required can be seen in the dialog.

**Creating an ISO image**

The simplest way to create an ISO image is to select “Image recorder” under “Burner”. When starting the “Burning process”, you have to specify a name for the image file you wish to create.
Options

Simulate first: If you are not sure about the write speed or memory requirements of the selected disc, you can simulate the write process before burning.

Activate buffer underrun protection: Many disc drives support technology that prevents the dreaded “buffer underrun”. Use this option to activate this protective feature and burn your files at higher speeds without risking making a coaster out of your blank disc.

Completely format DVD/CD-RW media: This option reformats the RW media and deletes all existing file material.

Shutdown computer after burning: Activate this option to automatically turn off the computer after encoding and burning has been completed. You could, for instance, start the encoding and burning process in the evening, and then you don’t have to wait for the process to finish to switch off your computer.

DVD-compatible write at least 1 GB: Some DVD players have problems reading DVDs which contain less than 1 GB of data. This option fills the DVD to the 1 GB limit with "empty data" so that this problem doesn’t occur.

Burn standard video DVD onto same disc: You can use this option with a WMV HD disc to burn an additional normal DVD video. This ensures that your discs can also be played back on standalone DVD players. See Multi disc.

Activate the burner’s defect management option: If a certain section of the disc is defective, this will be recognized by the burner and labeled. No content will be saved there as a result.

Check data after burning disc: The finished disc will be checked for any mistakes after burning.

CD/DVD title: This is the title of the DVD which is displayed as the disc name on the PC. The disc project name is displayed here by default.

Encoder settings

Use the “Encoder settings...” button to access the selection dialog to specify the properties of the MPEG encoder (memory requirements, quality, and duration of the MPEG conversion)

Preset: Here you will find useful presets for the selected disc type. Here are some of the presets for a DVD:

Longplay DVD Video DVD with extra-long playing time. The bit rate is reduced, which compromises image quality.
Longplay music DVD DVD with extra-long playing time for music. The bit rate for the soundtrack remains at the highest quality level.
Standard DVD Normal DVD
Widescreen DVD Normal DVD in 16:9 format

**Note:** For all settings, you can choose between NTSC (USA and Japan) (Europe).

**Bitrate:** Bitrate determines the size on the disk that the finished video will take up. The greater the bit rate, the larger the file, and the shorter the maximum playing time of the movie that fits on a disc.

**Adjust bit rate:** The expected file size of the finished video is estimated, depending on the set bit rate. If the movie does not fit onto the disc, the bit rate is corrected accordingly.

**Quality:** Specifies the quality of the encoding process. The higher the quality, the better the finished video will look; however, encoding will take considerably longer.

**Smart Rendering:** With Smart Rendering you can significantly reduce the encoding effort for MPEG files. During the production of MPEG files, only those parts of the movie that were changed in the program are re-encoded. Please note: The MPEG files contained in the movie must have the same format, i.e. the bit rates (variable or constant), audio formats, image resolutions and video formats must match.

**Anti-interlace filter:** Activate this option only for playback on a TV screen, where it reduces horizontal flickering around fine details.

**Calculate video effects on GPU:** To accelerate exporting, you can let video effects be calculated on the graphics card. At this time this applies to brightness, gamma, contrast, color, saturation, image size, cropping and position effects as well as various fades and mixes. Please note that external effect plugins and elaborate artistic effects must be processed on the CPU and for this reason using this function will not yield any speed advantage.

**Note:** This function is specifically optimized for NVIDIA graphics cards. You can, however, experience acceleration with other types of graphics cards, too.

**3D mode:** If you have 3D material in your project which has been edited with Stereo3D, you can select here in which mode it should be burned to disc here. 3D is switched off by default.

To return to the standard settings, press the **Reset** button.

Via “Advanced” you can reach the “Advanced settings” dialog. Here you can make changes to all MPEG encoder settings. Read the “MPEG-1/2 encoder-settings” appendix (view page 177) and “MPEG-4 encoder settings” (view page 180) in the PDF manual or program help.
Export

The "Export" button opens the export dialog which features the most important export options for your slideshow.

Note that you will only export the current slideshow. Other slideshows in the project and the disc menu are not included.
Output as video file

This option recalculates a slideshow including all objects, effects settings, fades, texts, and other features into a video file and saves it on your computer.

Select a certain quality (e.g. DVD quality) and a file format (e.g. MPEG -4). The dialog provides further information about the properties of your selection.

**Note:** Only the most familiar and most often used formats are listed as options. “File -> Export slideshow (view page 155)” features many additional file formats.
Output as individual photos

Saves the slideshow as individual photos for editing or sharing.

Collages and videos are exported as videos in MPEG-4 format. Audio tracks are not exported.
Export as 3D video

This option recalculates a slideshow including all objects, effects settings, transitions, texts, and other features into a 3D video file and saves it on your computer.

- The first step is to select a quality in the dialog. It only makes sense to use HD quality if you have high resolution material in your project.
- Next you choose a 3D mode. Anaglyph videos are suitable for viewing on a standard television or monitor and can be viewed with red-cyan glasses. Side-by-Side videos deliver a considerably better 3D experience but require special monitors, TV sets and playback devices.
- Next, click "Save video".

Note: You will always export Windows Media Video 3D files using this dialog. You can access other file formats through "File -> Export movie". See the "Stereo 3D" chapter (view page 115) for more information on 3D video.

Present on MAGIX Online Album

This accesses the MAGIX Online Album login dialog directly. Next, present your photos together with videos and music in custom-designed online albums.
Publish online

This option uploads your movie directly to YouTube, flickr or Facebook (deluxe version only). YouTube® is likely the most famous portal for homemade clips.

Community: Here you can select the platform: YouTube, flickr or Facebook.

Title: Here you can enter the slideshow title.

Description: Here you can enter a short description of your slideshow to inform other members of the community.

Category: Pick a category for your slideshow.

Publish: Decide whether your slideshow should be “Private”, meaning only for you and persons authorized by you, or freely accessible, meaning “Public”.

Export settings: Set various quality settings.
Output for a mobile device

This window lets you transfer your finished video to external devices. In this case, MAGIX PhotoStory on DVD 2013 Deluxe offers settings for a number of playback devices, including tablets, PCs, smartphones or camcorders.

- Select a device from the list.

The menu is divided into various device classes to make choosing your device easier. The last three selections are saved as favorites in the top part of the device list if you have more than one device or want to present your movies to your friends.

If your device is listed here, you don't have to worry about the format settings, as the necessary settings of the export dialog are automatically customized to the target device. Simply select your device and click “OK”.

**Tip (only for Android phones):** Normally your device will be correctly recognized as “Mass storage device”) by your computer. If this is not the case then change the connection detection settings of the device before connecting to your computer, so you can select the correct connection type (e.g. “Mass storage drive”). For more details on these consult your device manual.

**User-defined:**

If your device does not appear in the list after the online update, you can set up the export settings manually. No need to worry though; you only have to do it once, since these settings can be saved as a preset.

Read the instruction manual of your mobile device to find out which file format is required for this. If your device supports multiple formats, then you can experiment with the formats to get the best results.

Specify the file format by opening the target device’s menu and selecting “**User-defined** -> Video -> ...Format”. If you then click on “Export”, you arrive at the Export dialog of the selected file format where you can set all the advanced settings.

For details on these settings, please consult your device manual. Explanations for the file format’s settings can be found in the Overview of the device classes chapter, for the special settings of the export dialogs see “Export movie” in the “File menu” chapter.

**Tip:** If the format settings for your device are not accessible, then you can try out a different device from the same manufacturer and, using it as a template, make adjustments accordingly.
If you find settings you like, we recommend saving these as a preset for further use.

**Archive project onto hard disk**

Saves the project file with all included slideshows, files and DVD menus to a folder.

**Archive project onto disc**

Saves the project file onto a disc with all included slideshows, files and DVD menus.

**Output as media player**

To be able to play back your movie in an Internet browser or to embed it into web pages, you can export it as an HTML-enabled media player.

Select the desired quality and click on "Save video". In target folder, an HTM and an MP4 file will be created for further use.
Menus

In this chapter you’ll find the full menu list of your copy of MAGIX PhotoStory on DVD 2013 Deluxe and the corresponding functions.

File Menu

New Project
This menu item creates a new MAGIX PhotoStory on DVD 2013 Deluxe project. You can also open this feature via the “New project” button above the video monitor.

Keyboard shortcut: Shift + N

Slideshow
This option creates a new slideshow. The default name for a new slideshow can be specified in the program settings.

Keyboard shortcut: Ctrl + Alt + N

Open
This menu item loads a previously saved MAGIX PhotoStory on DVD 2013 Deluxe project. Please note that the related files must be accessible.

MAGIX PhotoStory on DVD 2013 Deluxe searches for the used sounds, pictures and videos under the path to where you last saved the disc project.

Keyboard shortcut: Ctrl + O

Recently opened projects
Project that you have recently opened in MAGIX PhotoStory on DVD 2013 Deluxe are listed and can quickly be opened with a click.

Open automatically saved project...
This option loads an automatically created slideshow backup. This type of automatic backup gets the file extension MV_ (underscore). This command is only intended for use in emergencies, e.g. if you unintentionally saved your change and wish to return to the previous version of the project.

Keyboard shortcut: Alt + O
Manage slideshow

Remove from project
This option removes the current slideshow from the project.

Keyboard shortcut: Shift + F4

Rename
You can enter a name for the current slideshow here.

Attach
This function attaches an opened slideshow to another one. This attaches it to the end of the opened slideshow and automatically applies the original slideshow’s settings.

Attach an opened slideshow: An already opened slideshow can be selected from the list and attached. This option is only available if your project contains multiple slideshows.

Attach the last edited slideshow: All of the slideshows that were last edited are listed. This option is only available if other slideshows have been previously edited.

Load and attach a slideshow: Click a folder and a dialog will open to select a slideshow. Navigate like in Windows Explorer to the folder that contains the desired slideshow. Double clicking on a slideshow file (*.mvm) opens it and attaches it to the current slideshow.

Import slideshow file
Use this option to load a slideshow into your project.

Please note that all related photos must be accessible. MAGIX PhotoStory on DVD 2013 Deluxe searches for the used sounds, pictures, and videos from the path to where you last saved the slideshow.

Keyboard shortcut: Ctrl + O

Export slideshow file
A dialog opens where you can specify the path and name of the slideshow. The slideshow can then be imported again into other projects.

Note: The slideshow file (*.mvm) contains all information about the used media files, cuts, effects, and titles, but not the picture and sound material itself. This is found in the recorded or imported media files that remain unchanged during the entire MAGIX PhotoStory on DVD 2013 Deluxe editing process. To save the full slideshow into a dedicated directory, for instance to continue editing on a different PC, please use the function “Copy movie and media into directory”. 
Save
The current disc project is saved with the name displayed in the project window. If you have not yet specified a name for your project, a dialog will open wherein MAGIX PhotoStory on DVD 2013 Deluxe asks you to do so.

Keyboard shortcut: Ctrl + Alt + S

Save as...
A dialog opens where you can specify the path and name of the video, under which it is to be saved.

Keyboard shortcut: Shift + S

Import from camera
Opens the import dialog (view page 38) for digital cameras, so you can insert images into MAGIX PhotoStory on DVD 2013 Deluxe directly from your memory card.

Import from computer
A dialog for importing media files opens. Choose between “Search” and “Automatic import”.

Search: A dialog for selecting media files opens. The selected files will be imported into the current slideshow after “Open” is clicked.

Note: Media files can be dragged and dropped into the slideshow from the Media Pool much more conveniently.

Import automatically: To copy photos from a digital camera to the computer, the accompanying MAGIX Photo Manager program will open. As soon as the program is ready, connect the digital camera with the computer. The imported photos can be conveniently dragged from the Media pool into the slideshow. Please also read the MAGIX Photo Manager help file by pressing “F1” from within the program.

Note: Files from your digital camera are easier to import if you use the camera import tool.

Database
Switches to the Media Pool (view page 52) database view.

Scan image
Scan photo externally...
Opens MAGIX Photo Designer 7 for scanning photos. This function is required if there are problems when scanning with MAGIX PhotoStory on DVD 2013 Deluxe.

Keyboard shortcut: Alt + Shift + A
Scan with
The scan window of your scan software will appear. Specify the resolution and color depth in this window.

When the scan is complete, the TWAIN software should close automatically and MAGIX PhotoStory on DVD 2013 Deluxe should now contain the newly created image file. It’s possible that the TWAIN window remains open. You can then scan multiple pictures one after the other.

Audio commentary...
This opens the „Audio recording“ (view page 86) dialog where you can record your own sounds like singing, noises or instruments.

Export
This provides all export formats supported by MAGIX PhotoStory on DVD 2013 Deluxe that aren’t covered by burning. Refer to “Exporting” for more information.

Video as AVI
When exporting to AVI video you can set and configure the size and frame rate of the AVI video and the compression codec for audio (audio compression) and video (Codec). Please also observe the general information on AVI video formats (view page 198) in the PDF manual.

Keyboard shortcut: Alt + B

Video as MPEG video
MPEG is short for “Motion Picture Experts Group” and is a very powerful compression format for audio and video files.

MAGIX PhotoStory on DVD 2013 Deluxe is equipped with the high performance Ligos GoMotion encoder. In the MPEG export dialog you can fine tune the options for the MPEG encoder. MPEG files are created when you burn a CD/DVD. Usually
standardized MPEG-1/-2 is used for creating (S)VCDs or DVDs. However, many DVD players can also process (S)VCDs with non-standard bit rates, so there is room for experimenting here.

Simply export your movie to MPEG via the File menu. When burning the disc the program recognizes that the file is already available and uses this instead.

Details on the MPEG encoder settings can be found in the MPEG Encoder help!

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>MPEG-2 (DVD)</th>
<th>Alt + H</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>MPEG-2 (miniDVD)</td>
<td>Alt + I</td>
</tr>
<tr>
<td></td>
<td>MPEG-2 (Super Video CD)</td>
<td>Alt + J</td>
</tr>
<tr>
<td></td>
<td>MPEG-1 (Video CD)</td>
<td>Alt + K</td>
</tr>
</tbody>
</table>

**Video as MAGIX video**

Exports the project in MAGIX video format.

This format is used for video recording by MAGIX PhotoStory on DVD 2013 Deluxe video software and is optimized for digitally editing high quality video material.

Keyboard shortcut: Alt + D

**Video as Quicktime Movie**

Exports the project in QuickTime Movie format. This format enables streaming playback of audio or video files via the Internet.

*Note:* The Apple QuickTime Library must be installed for QuickTime files (*.mov).

Keyboard shortcut: Alt + E

**Video as MotionJPEG AVI**

Opens the export dialog for AVI video in Motion JPEG format. This format is supported by digital picture frames, for example.

**Windows Media Export**

Exports the arrangement in Window Media format. This audio/video format is optimized for the Internet.

You can also use it to archive your movies in high-quality when compared to MPEG-sized files. Windows Media is an alternative if you would like to view your movies primarily on your PC. Pocket PC and Smartphone movies are also created with the Windows Media Format.

Depending on your requirements you can choose between different profiles. If the Windows Media Encoder 9 is installed (which can be downloaded free of charge from Microsoft) you can edit the profiles or add your own.
**Two pass:** The video is compressed in 2 stages in order to export highly-compressed videos for the Internet optimally.

**Slideshow:** Lets you create slideshows with audio soundtracks. The created files are very small despite their high image quality, since only still images (no transitions or movement effects) are displayed.

In the dialog you can add the author name, copyright details, and a description.

Keyboard shortcut:  Alt + F

**Advanced settings**

Here you'll find more on the advanced settings in the Windows Media Video Export section. You can enter precise details for the format you wish to create. Profiles from the system or from another file can also be imported.

**Video as MPEG-4 video**

MPEG-4 is the most advanced video format available at the moment. Unlike others, it can provide high-quality pictures at the same file size.

Behind MPEG-4, you'll find a highly complex "academic" standard that operates and is supported variably according to make. Discussing the differences and parameters in detail goes beyond the scope of this manual. For this reason, indications, along with the operational manual of your device, are given that should help create executable MPEG-4 files. For more experimental users, the complete setup options of the MPEG-4 codec can be found behind the “Advanced settings...” buttons.

**Video/Audio:** The MPEG-4 format and the advanced AVC format are also available but have, as of yet, only been used in a few devices. MPEG-4 video can be combined with AAC or AMR sound, the latter mostly in conjunction with mobile phones. The combination of AVC/AAC is more seldom applicable (Apple iPod Video). AVC featuring AMR will almost never occur.

**Multiplexer:** Here you can find teh so-called container formats and special options for Apple iPod and Sony PSP. MPEG-4 is usually used as an **output format**, mobile phones mostly use 3GP.

**Video as animated GIF**

The video will be exported as an animated GIF file (also called "AniGIF"). This file format is also supported by a lot of older mobiles.

**Single frame as BMP file**

Exports the image located at the playback marker and displayed in the video monitor as a bitmap (*.BMP) file.

Keyboard shortcut:  Alt + M
**Single frame as JPG**
Exports the image located at the playback marker and displayed in the video monitor as a JPEG (*.JPG) file.

Keyboard shortcut: Alt + N

**Output as media player**
To be able to play back your movie in an Internet browser or to embed it into web pages, you can export it as an HTML-enabled media player.

Select the desired quality and click on “Save video”. In target folder, an HTM and an MP4 file will be created for further use.

**Video**
Generates a media player with multimedia slideshow as a video file including all applied effects and background music.

Select the desired quality and click on “Save video”. In target folder, an HTM and an MP4 file will be created for further use.

**Media:**
Generates a media player with all photos, videos and music individually without effects.

Select the desired quality and click on “Save video”. In target folder, an HTM and an MP4 file will be created for further use.
Internet

This is a list of menu entries regarding all of the services that are available directly from within MAGIX PhotoStory on DVD 2013 Deluxe.

Catooh – the Online Content Library

If your project is missing pictures, videos, DVD menus, sounds, or samples, then you should have a look at the huge selection available at Catooh. There you'll be able to buy media in excellent quality for low prices: DVD menus, Slideshow Maker styles, decorative elements, 3D power effects, 3D transition series, MAGIX Soundpools, songs, ringtones... Perfectly suited to all MAGIX photo, video, and music projects.

Import media from web...

Opens the MAGIX PhotoStory on DVD 2013 Deluxe Media Browser

MAGIX Online Album

Impress your friends and family in minutes with your own photos and videos as your own your personal photo & video website: http://first_name.last_name.magix.net.

MAGIX Online Album lets you put your favorite photos online directly from within MAGIX products like MAGIX PhotoStory on DVD 2013 Deluxe, or mobile phones with built-in cameras, and then send a link to them to your friends via email. All photos are immediately available from anywhere in the world on a professionally-designed photo website, in well-organized photo galleries, as full-screen slideshows, or in the form of a personal photo e-card.

• Personalized album website in many designs,
• unique Internet address (URL),
• upload your pictures directly from a camera phone, send the link, and share the picture with other camera phone users,
• full-screen online slideshows with fade effects and music,
• send individual designer e-cards with your own photos,
• Share your photos with friends, including address management and password protection for private albums.

MAGIX Online Album is available in three versions, of which the smallest (the FREE album with 500 MB webspace for your photos) is entirely free.

The larger versions (CLASSIC or PREMIUM) are available for a monthly charge, but also come with many handy features, such as a faster website, 2 GB or 5 GB storage space, more website designs or access by mobile phone/PDA. More information about prices and features is available at http://www.magix-photos.com http://www.magix-photos.com.
Upload images from slideshow

1. Select still image and place the start marker at the position of the image which you want to upload from your slideshow.
2. Then, select “Share -> MAGIX Online Album -> Load image from slideshows” in the menu.

In order to upload photos to your MAGIX Online Album, simply log in using your email address. Naturally, access is protected via your personal password. If you still don’t have a password, click on “Register now”.

Using your MAGIX Online Media Manager, you can quickly manage your photo website, upload photos and music, create new albums, add designs and text, and much more.

Using “Upload movie as video” you can present your slideshow with fades, music, and all other effects as a playable video in the Internet.

1. Design your slideshow.
2. Save your movies, and then under “MAGIX Online Album” select “Share -> Upload slideshow as video”.

Now you just have to follow the instructions on the screen to finish the upload process.

Upload slideshow as audio: With this option, you can present only the audio of your slideshow in your online album.

1. Design your slideshow.
2. Save your movies, and then under “MAGIX Online Album” select “Share -> Upload audio from slideshow”.

Now you just have to follow the instructions on the screen to finish the upload process.

The following options are also available:

Send e-cards and photo emails

Send your photos as unique ecards with great designs or as a photo email to your friends and family.

Order photo prints and gifts

Order paper prints or great photo gifts from MAGIX Online Album and have them delivered directly to your home, or pick them up from a photo lab in your area. Delivery time is usually just 2 - 3 days. More about MAGIX Online Print Service.

www.magix.com
Export to device...
This command opens the dialog for outputting the completed video or its soundtrack to various mobile devices such as smartphones and tablet PCs.

More information about this is available in the „Output“ (view page 150) chapter.

Keyboard shortcut: H

Burn to CD or DVD
Opens the Burn dialog (view page 123) to burn the current slideshow.

Backup copy
Files must be saved to be able to be easily retrieved in case of a hard drive crash or some other error.

Copy project and media into folder...
The project and all of the files it contains are saved together in one folder. Use this function to transfer an entire project to another computer.

Keyboard shortcut: Shift + Q

Copy slideshow and media into folder...
The slideshow and all necessary files can be saved in any folder.

Keyboard shortcut: Shift + R

Burn project and media
Use this option to burn the project with all relevant slideshows and their files to CD or DVD.

Even larger projects can be burned straight to disc. The project, if necessary, will be split up and burned automatically to multiple discs. A restore program which is burned to the first disc of this type of backup guarantees easy re-recording of the backup.

Burn slideshow and media to CD/DVD
Use this option to burn the slideshow and all relevant files to CD or DVD.

Even larger slideshows can be burned straight to disc. If necessary, the slideshow will be split up and burned automatically to multiple discs. A restore program which is burned to the first disc of this type of backup guarantees easy re-recording of the backup.

Keyboard shortcut: Alt + Shift + R
**Burn project (image) again**

All necessary files, menus, and encoded video files needed to burn a CD/DVD will be temporarily stored on your hard drive. After your disc is burned, these are **not** automatically deleted. Use “Burn disc project (image) again” enables you to burn as many discs as you would like without having to encode the files again.

In the dialog, choose the image you want. All necessary files are then transferred to the MAGIX Speed burnR.

**Tip:** For more information on using MAGIX Speed burnR, read the help file of the program.

**Additional programs**

This menu item provides direct access to the tools and programs included.

**Settings**

**Slideshow...**

Opens the settings for the current slideshow.

**Project...**

**Project name:** Give your disc project a name. This name will be used as a preset title for the disc you are going to burn. The slideshows will also be given this name.

**Use 16:9 aspect ratio for current disc project:** This option lets you edit the slideshow from the very beginning in 16:9 format. The video monitor’s size changes to correspond to this.

**Cut new images to fit screen automatically:** Images that do not correspond to the slideshow’s ratio are adjusted automatically. The zoom factor is set in such a way that there are no black bars to the left or right or top to bottom.
Program...
This menu item opens the program settings (view page 29).

Keyboard shortcut: Y

Slideshow effect settings
This menu item accesses the slideshow's effects settings (view page 54). The settings made here apply to the entire slideshow.

Keyboard shortcut: M

Reset Program Settings to Default...
Use this function to reset all program settings (view page 29) you made in MAGIX PhotoStory on DVD 2013 Deluxe to their original settings.

Exit
Closes MAGIX PhotoStory on DVD 2013 Deluxe.

Keyboard shortcut: Alt + F4

Edit Menu

Undo
You can undo the last steps you made. This means that you can easily try out critical operations. If the result does not meet your expectations, then you can simply "undo" it and return to the initial status.

Keyboard shortcut: Ctrl + Z

Redo
This command cancels a previous "Undo" command.

Keyboard shortcut: Ctrl + Y

Cut
This function deletes the selected photo (or the selected object in the Timeline mode) and copies it to the clipboard. You can then use the "Paste" command to copy it into any slideshow.

Keyboard shortcut: Ctrl + X
Copy
This command copies the selected scenes (or the selected object in Timeline mode) to the clipboard. From there you can paste it into any other slideshow using the “Paste” command.

Keyboard shortcut: Ctrl + C

Paste
This command inserts the clipboard material (photo or object) at the current position of the start marker.

Keyboard shortcut: Ctrl + V

Delete
This command cancels the selected photo (or the selected object in Timeline mode).

Keyboard shortcut: Del

Wizards
This menu entry contains different aids for different tasks in MAGIX PhotoStory on DVD 2013 Deluxe.

Slideshow wizard
This wizard makes creating great slideshows (view page 91) child’s play. You will be led through the necessary steps automatically.

Divide slideshow
You can divide (view page 93) up your whole slideshow into several individual shows using this wizard.

Slideshow Maker
This is where to open Slideshow Maker.

Soundtrack Maker
This command opens the MAGIX Soundtrack Maker (view page 98).

Musical editing adjustment
Opens the musical editing adjustment to adjust (view page 99) the photo display to match the beat of the music.
Cleaning Wizard
Use this function to free up (view page 102) disk space for future projects.

Travel route animation
Opens the dialog to create travel route animations. (view page 103)

Exchange
Replaces the selected object with an object selected in the Media Pool. Length adjustment moves the objects following it correspondingly.

If photo objects are removed/exchanged, then the display duration will remain.

Split object
This command cuts a scene at the point where the start marker is positioned. This way, two free-standing objects are created.

You can isolate a part of an object in order to delete it:

1. Place the start marker where you’d like to have it by left clicking in the timeline.
2. Select the video object by clicking on it and click on the cut button.
3. Place the start marker at the end of the part you wish to remove and click on the cut button again.
4. Select the middle object that was created and press the “DEL” key.
5. Pull the object at the back to the front; it should automatically snap into place.
   All subsequent objects will be moved along in unison so that no gaps appear.

You can also use this function to apply effects to a certain part of an object only.

Keyboard shortcut: T

Search empty sections
With this wizard you can spot gaps (view page 102) in your slideshows quickly.

Select all objects
All objects in the arrangement will be selected.

Keyboard Shortcut: Ctrl + A
Effects Menu

**Image optimization**
This places the image material in the right light, sharpens shaky recordings, and corrects tint, all conveniently from the Media Pool (view page 48).

**TV picture**
This submenu item performs various adjustments for the TV picture. Besides interlace and anti-flickering filters, you will find the option to adjust the image to the real proportions of the TV picture. A special algorithm ensures an optimal ratio between image size and image borders (anti-cropping).

**Interpolation for interlace material**
Choose this option to remove interlace artifacts from your video image. If, for instance, you extract freeze frames from a video, ridge structures appear in sequences which feature movement.

**Anti-flicker filter**
Choose this option for still pictures with detailed structures and high contrast. This filter reduces line flickering during TV playback.

**Border cropping adjustment:**
Select this option if the edges are cropped during playback on your television. Values stored in “Slideshow effects settings (view page 85)” will be applied.

**Distortion**
Image material can be transformed in various artistic ways; a broad palette of effects is available to you for this in the Media Pool.

**View & animation**
These effects allow properties like section, image size, position, and rotation of image and video objects to be specified in the Media Pool.

**Stereo3D**
This accesses the program’s Stereo 3D functionality. Please read the corresponding chapter “Stereo 3D”. (view page 115)

**Design**
Add different decorations, speech bubbles, and animations to photos directly in the Media Pool to add life to your slideshow.
Rotate right

Rotates the photo 90° clockwise.

Keyboard shortcuts:
- Ctrl + Alt + F to the right
- Ctrl + Alt + G to the left

Automatically cut to fit monitor

This option enables photos to be adjusted to suit the current format. In this case, the picture is zoomed in to such an extent that the upper and lower parts of the photo are hidden and the annoying black bars to the sides disappear. The consequence of course is that portions of the image will be missing.

Keyboard shortcut: Shift + A

Display duration...

Enter the display duration for the current photo here in [Minutes]:[Seconds]:[Frames].

Apply to area between the start and end markers: Applies the settings to all photos located between the start and end markers.

Apply to all: The settings are applied to every photo in the current slideshow. The settings will not be applied to photos in additional slideshows in the project.

Edit image (external)...

The command “Edit image (external)” enables photos to be edited with the MAGIX Photo Designer 7 graphics program. The command appears in the context menu for every image. The context menu opens by clicking the small FX button at the top edge of the photo box. A dialog window of the MAGIX Photo Designer 7 wizard appears. This is a clever little helper that recommends several typical photo tasks from which you can simply select the specific task, mark with a cross, and then send your picture to MAGIX Photo Designer 7. MAGIX Photo Designer 7 opens and loads the selected picture. In MAGIX Photo Designer 7 you are supplied with the necessary instructions for editing your photos. Have fun experimenting!

After editing has been completed, the modified picture will be used instead of the original material.

Retouch redeye, select clippings, apply creative distortions (“flowing color”), enhance Internet photos, and much more. The integrated MAGIX Photo Designer 7 makes it possible. Even unsuccessful recordings can be fit for presentation in the blink of an eye. Read more on this in the MAGIX Photo Designer 7 help.
Create panorama image...
With only a single click you can create a panorama (view page 112) in MAGIX PhotoStory on DVD 2013 Deluxe. You can do this fully automatic or manually; try experimenting with it.

Show/Hide
Hides or shows the selected object.

Fades
Here you can find all fades from MAGIX PhotoStory on DVD 2013 Deluxe, sorted into various categories. One click on a category displays all of the fades that are contained.

To load a fade, drag it with a held-down mouse key onto the object, into which you would like to fade.

You can find additional information in the “Fades” (view page 73) section.

Picture-in-picture collages
These work similarly to normal picture-in-picture effects, but more objects are used. Depending on the collage, arrange the selected objects one after the other and drag the collage onto the first object.

Background design
Select a color, a picture, or any video on your hard disk, which you would like to serve as the background for the photo displayed. This function is especially useful when photos have black bars around them, or if they are reduced in size.

You can use the arrow to move quickly to the previous or next photo in the slideshow and adjust the background.

Reset background
Resets the background for the currently selected object.

Video stabilization
Opens the video stabilizer dialog to help you correct shaky footage. Read more on this topic in “Video stabilization”.

Keyboard shortcut: Shift + K

Title Editor

Keyboard shortcut: Ctrl + T
Save as title template...
If you have designed special titles, these can be saved as a template. Titles will be saved in the titles folder in MAGIX PhotoStory on DVD 2013 Deluxe to make them easier to find in the Media Pool (under “Titles”).

Keyboard shortcut: Ctrl + Shift + E

Convert to 3D title...
The title object is transformed into a 3D object. You can choose a template in the Media Pool in “Title < 3D”.

Fade in date as title
MAGIX PhotoStory on DVD 2013 Deluxe can add a time or date (“timecode”) to the picture material. To add a timecode, right click the image and choose the “Fade in date as title” option from the context menu.

If a photo file is involved (i.e. a photo created with a digital camera that contains EXIF data), then the date the picture was taken will be added. If a different kind of file is involved, the creation date will be used as the timecode. Next, the title editor opens for you to customize the entry.

Sound optimization
The “Audio cleaning (More information can be found in the section “Sound optimization” on page 81)” dialog will open to help you remove noise.

Keyboard shortcut: Shift + W

Audio editing (external)
Transfers the highlighted audio object to MAGIX Music Editor for further editing.

Volume settings
If you have added background music to your slideshow or created a collage of several videos that will be played back simultaneously, you can specify the “foreground audio” by reducing the volume of all other audio tracks (view page 113). The “Volume decrease of other tracks” dialog will open.

Volume curve
Display volume curve: Here you can edit the volume curve (view page 114) to decrease the volume in specific ranges.

Reset volume curve: All adjustments to the volume curve are deleted.

Effects settings
Apply to all objects: Copies the current effects settings to all objects in the Arranger. Use the dialog to specify which settings should be copied.
Apply to all following objects: Copies the current effects settings to all of the following objects in the Arranger. Use the dialog to specify which settings should be copied.

Copy: Copies the current settings to a new object. Use the dialog to select which settings should be copied.

Keyboard shortcut: Alt + Shift + K

Insert: Inserts the current settings on a new object. Use the dialog to select which settings should be copied.

Keyboard shortcut: Alt + Shift + U

Reset: This “effect” is actually no effect. In fact it disables all applied effects.

Keyboard shortcut: Alt + Shift + C

Object properties
This function displays all the information about the currently selected objects such as file name, position on the hard-drive, tempo, etc.

You can also set a background color for the object to make it stand out and easier to find.

Keyboard shortcut: Ctrl + E

"Share" menu

Here you will find many options for quickly and easily publishing your data from the program on the web. Additionally, data transfer into other programs for specialized editing, if you have such programs installed, is enabled.

Youtube/Flickr/Facebook
This is the direct connection used to upload your slideshows as videos from MAGIX PhotoStory on DVD 2013 Deluxe to Youtube, Flickr or Facebook.

Upload current slideshow as video
Loads current slideshow to the selected platform or community Enter the data for video into the fields provided, so that the search function for this portal can also find this video.

MAGIX PhotoStory on DVD 2013 Deluxe partially uses the H.264 format for this, which is a component of the MPEG-4 codec. Because Flash directly supports this format and most communities and portals use it already, the slideshow doesn't have to be rendered again on each server. This avoids loss of quality.
When HD material is uploaded, a resolution of 720p is used for the HD format.

**Upload all selected media in Media Pool**
Uploads the media selected in the Media Pool to the corresponding portal or the selective community.

**Help Menu**

**Help**
This command is available for almost every feature of the program, and it opens the “Help” file for the corresponding topic. Use this command to get help on any of MAGIX PhotoStory on DVD 2013 Deluxe’s functions.

Keyboard shortcut: F1

**Context help**
The mouse cursor will turn into an arrow with a question mark.

Click on any button of the main screen, to open program help which will describe the control element in question.

Shortcut: Alt + F1

**PDF manual**
Opens the manual in PDF format. Similar to the Help feature that can be accessed by pressing F1, this manual contains all of the important information about the program.

**magix.info**
Do you have questions, need help, or are looking for expert tips and tutorial videos on using your MAGIX product? At magix.info you will find answers and solutions as well as workshops and a comprehensive user forum for software and multimedia queries.

You can access magix.info online at www.magix.info

**Start introductory video**
The introductory video shows you how all the most important features work. Specific topics are explained in detail in additional tutorial videos.

Keyboard shortcut: Ctrl + F1

To play the introductory video you may have to insert the program CD.

**Display tooltips**
Tooltips are small information windows that open up automatically if the mouse pointer stops briefly on a button or some other area. They provide information about
the function of the button. These information boxes can be switched on or off with this option.

Register online
This option opens the MAGIX homepage for online registration where you can register yourself as a MAGIX user.

Registration grants you access to the MAGIX support website http://support.magix.net (see support) where various program updates and help programs can be downloaded.

With the registration form supplied (start menu under “MAGIX PhotoStory on DVD 2013 Deluxe -> Service and support -> Register“) you can register via post or fax. Simply print it out, fill it in, and send it off!

Keyboard shortcut: F12

Update online
This option connects directly to the MAGIX online update page where you can get the latest version of your program.

Keyboard shortcut: Ctrl + Shift + F12

Product information...
Opens the MAGIX PhotoStory on DVD 2013 Deluxe website.

About MAGIX PhotoStory on DVD 2013 Deluxe
Displays copyright info and version number of MAGIX PhotoStory on DVD 2013 Deluxe.
Activate additional functions

You can activate encoders/decoders for various file formats as required.

Why does it have to be "activated"?
To import (decode) or export (encode) certain video and audio formats, you will require a specific codec. MAGIX PhotoStory on DVD 2013 Deluxe will ask you if you want to activate the codec as soon as you need it. The integration of decoders and encoders from third parties into programs usually costs money. These codecs are integrated via additional, voluntary activation in MAGIX programs which, according to usage and degree of prevalence, can be free or fee-based for special high-quality codecs. This way, MAGIX can continue to offer you good value for your money.

Free activation (MPEG 2 & 4 codec)
To be able to use the MPEG-2 and MPEG-4 codec, you will have to first activate it for free.

Activation can be done online via telephone or via post/fax. The quickest and easiest way to order an activation code is via the Internet.

Order activation code online
Click on “Order online...” (Field 1). Your Internet browser will open. Once you have registered, the activation code will be sent to the email address you supplied upon registration. If your computer has no Internet access, you have the following options for activation:

Order activation code in MAGIX Service Center
Use this option to conduct activation from a different computer which has Internet access.

Order activation code via telephone
The telephone number and necessary details you will need to call to receive activation by telephone are displayed here.

Order activation code via post/fax
After clicking on “Order via post/fax” (field 2), your user code will appear. This automatically assigns your personal activation code to your PC. Click on “Continue to order form” to transfer your user code automatically to the post/fax form. Now send the completed form as a print out to the address/fax no. mentioned. Your activation code will be sent to you in just a few days via post or fax. It can also be sent by mail if an email address is stated.

Enter activation code
After receiving your personal activation code, you can use the activation dialog for the corresponding file format to start exporting for the respective format. If you receive
the activation code via email, then copy it into the input field in the dialog and click "Activate...".

Activation problems

**Problem**: The entered code is incorrect (telephone activation)

Make sure your entry is correct; in most cases a typo is to blame. If the code is entered correctly, dial the number of our Call Center. Our support staff will help you personally.

**The MAGIX website won't open**

Check your Internet connection; you may have to use manual dial-up.

**The form for ordering via post/fax won't open**

- Check that an adequate text editing program is installed and activated (for example, MS Word).

**I still haven't received an email with the activation code**

- Check that your inbox isn't full.
- Have a look in your spam folder.

You can always send questions via email to our support whenever you like. Please have the following information at hand so that we can assist you as quickly and as specifically as possible.

- Complete product name
- Exact version number (to be found in the about box in the "About" menu item of the "Help" menu)
- Encoder/Decoder name
- Your user code (accessible via the "Activate via post/fax" dialog)

**Problem**: I have installed MAGIX PhotoStory on DVD 2013 Deluxe on a new computer, installed a new hard drive in my old computer (sound card, memory...), or installed it multiple times on the same computer. My activation code is no longer accepted!

If the program cannot be activated again after it has been activated multiple times, please contact the MAGIX customer service (view page 8).
Problems and solutions

File will not load

- If files cannot be loaded, this means that the format is either not supported by MAGIX PhotoStory on DVD 2013 Deluxe and the corresponding codec must first be activated. Read the sections “Import and export formats” and “Activate additional functions”.
- In case of AVI files, it is possible that the necessary codec is not installed. For this, read the section “General tips for AVI videos” (view page 198) in the “Digital video and data carriers” supplement of the PDF manual or help (F1 key).

Tip: To find out which codecs are used in the movie file, different help programs are available. An example for this is “GSpot” or “AVIcodec”.

Choppy or uneven playback

If playback isn’t smooth, don’t worry: the final result will be exported without any glitches. Don’t forget that MAGIX PhotoStory on DVD 2013 Deluxe calculates all effects in real-time. This lets you see for yourself what sort of influence each of the effects has on your slideshow.

Some effects make even today’s advanced computers work hard for their money. A steady, continuous video stream is simply not possible on your PC. The final product free from previous chopiness is only available after rendering it to DVD or exporting it. For that very reason, you should first arrange the slideshow in its raw version without effects. The preview generally delivers a steady picture, allowing you to work quickly and quietly.

Activation problems

Problem: The entered code is incorrect (telephone activation)

Make sure your entry is correct; in most cases a typo is to blame. If the code is entered correctly, dial the number of our Call Center. Our support staff will help you personally.

The MAGIX website won’t open

Check your Internet connection; you may have to use manual dial-up.

The form for ordering via post/fax won’t open
Check that an adequate text editing program is installed and activated (for example, MS Word).

**I still haven’t received an email with the activation code**

- Check that your inbox isn’t full.
- Have a look in your spam folder.

You can always send questions via email to our support whenever you like. Please have the following information at hand so that we can assist you as quickly and as specifically as possible.

- Complete product name
- Exact version number (to be found in the about box in the “About” menu item of the “Help” menu)
- Encoder/Decoder name
- Your user code (accessible via the “Activate via post/fax” dialog)

**Problem:** I have installed MAGIX PhotoStory on DVD 2013 Deluxe on a new computer, installed a new hard drive in my old computer (sound card, memory...), or installed it multiple times on the same computer. My activation code is no longer accepted!

If the program cannot be activated again after it has been activated multiple times, please contact the MAGIX customer service (view page 8).
Appendix: MPEG Encoder Settings

**General settings**

**MPEG type:** Set the output type of the created MPEG file. You can adjust the encoder settings freely (to export your video in the corresponding format, for instance) for further use in other programs or on your own website.

If you open the encoder from a burn dialog, or intend to use the exported material for VCDs, SVCDs or DVDs, then select the corresponding option. This will adjust the settings of the encoder according to the standards required for the corresponding discs to be played in a compatible player.

**Video format:** Automatically specifies the video format, aspect ratio, and frame rate (see video settings (view page 178)). You can choose between PAL or NTSC.

**Interlace mode:** The movie is encoded interlaced (i.e. in two half-screens, so-called fields). This is essential for later playback on TV screens. If you want to view the exported movie on your PC only and like a "cinemascope" view, you can also encode by frame (progressively). Some video projectors also support playback of progressively encoded image material. See Interlace (view page 194).

**Bit rate:** The bit rate determines the memory requirement by the completed video. The amount of data available can be used differently for different display modes. 20 MB can be 4 seconds of DVD video, or 5 minutes of Internet streaming at the thumbnail size. The quality of an MPEG video is measured by the width of the created data stream, i.e. the bit rate. This is the amount of transmitted data per time unit and is indicated in kBit/s or bit per second.

**Quality:** Determines the quality of the encoding process, or the quality of the movement (view page 191) to be more precise. The higher the quality, the better the finished video will look, but encoding will take considerably longer. The preset value “10” is a good compromise between speed and quality.

**Smart Rendering:** Smart Rendering can considerably reduce the encoding/processing strain of MPEG files. The production of MPEG files re-encodes only those parts of the movie that were changed in the program (e.g. by video cleaning or effects). Please note: The MPEG files contained in the movie must have the same format, i.e. the bit rates (variable or constant), audio formats, image resolutions, and video formats must match.

**Quick, GOP-precise copying:** This special Smart Rendering mode enables MPEG material to be transferred without having to encode it for the target medium, thereby greatly increasing the encoding speed. The video material cannot appear to have been altered in any way; only hard cuts (without fades) are permitted. These won’t be
executed precisely to the frame, but will rather take place at the next GOP borders. For this reason, cuts should be set somewhat more generously.

To burn DVDs in original 5.1 Surround Sound (Dolby Digital Audio) without having to re-encode, this option has to be activated.

Allows you to rip the necessary settings from an existing MPEG file. This can be useful if you want to merge MPEG files together without re-rendering via Smart Rendering.

**Video settings**

**Frame rate:** PAL requires 25 frames/sec, NTSC 29.97 frames/sec. Please note: encoding NTSC material as PAL or vice versa may be possible; however, it will result in jittery images.

**Aspect ratio:** Lets you set the image side or pixel ratio. With MPEG-2 the image format is displayed as image ratio; correspondingly there is 1:1 (square screen, not recommended), 4:3 (regular video), 16:9 (widescreen) and 2.21:1 (cinemascope). This applies irrespectively of the selected video format.

For MPEG-1 the pixel format is set; the options here are 1:1, CCIR601 (represents normal 4:3 video) for 625 lines = PAL and 525 lines = NTSC and the same for 16:9.

The option **Auto** is set as default. Here you can adjust the Movie settings accordingly.

**Resolution:** Width and height of the video corresponds with the settings in the export dialog.

**GOP structure:** Here you can change the settings of the GOP (view page 193) sequence, i.e. the number of P frames and B frames per I frame within a GOP. Please note that the total length of the GOP must not exceed 15 frames, which corresponds to the default setting (1 I frame + 4 P frames + 5*2 B frames = 15 frames).

However, you can reduce the length of the GOP sequence (while compromising the image quality at the same bit rate). This speeds up the encoding process considerably as the motion estimation while encoding P and B frames requires high CPU performance. The speed of decoding, i.e. playback, is also increased.

If I frame is set to 1, each frame is an I frame. If the value is set higher, the setting describes the total length of the GOP.

**Auto GOP:** Closed GOPs do not contain relations to frames from subsequent GOPs. MPEGs where all GOPs are closed, make MPEG editing easier as the I frames only can be edited alone if the GOP is closed. Auto GOP closes GOPs at scene changes, whereby two different and complex procedures (“fast” and “VCSD”) are used.
Bit rate mode

In "constant bit rate" mode a bit rate that constantly remains the same is used. With a constant bit rate the full power of MPEG compression can not be used properly as bandwidth for non-moving scenes is lost.

"Variable bit rate" mode attempts to adjust the available storage space to the requirements of the video you want to encode. The actual bit rate fluctuates around a mean value. During calm sections of the video it may drop to a minimum value, if there are movements in the scene it may rise to the maximum value. There are two different regulation processes (mode 1 and mode 128).

Advanced video settings

MPEG profile and level: The MPEG-2 standard defines various "profiles" and "levels". For creating DVDs you can use the "Main profile & Main level". The high profile adds additional properties to the data stream, such as the option of displaying an image at a reduced resolution for restricted transmission quality (SNR scalable profile) or locally scaled, for instance an HDTV data stream on a standard TV set). The 4:2:2 profile is used if the image data is to be encoded for alternative chroma scanning (view page 192). However, these profiles are only supported by very few encoders, mainly for professional use.

The different levels define the restrictions to the image resolution and the maximum data rate. Low level can only reach a reduced resolution (352 x 2888 = CIF), high level or High -1440 enables encoding in HDTV format.

Estimate movement: These parameters are controlled by the quality controller (see General Settings).

Other

Noise sensitivity: This factor defines how sensitive the encoder will react to noise in the source material. If your source material only contains little noise (digital recordings, computer animations or already de-noised by video cleaning), you don’t have to change the default value 4, or you can even reduce it in order to increase the quality further.

However, if you want to encode noisy material, a factor that is too low will considerably increase the encoding time without producing higher quality. For an unedited analog video you can increase the factor to 8-14.

Noise reduction (click on noise sensitivity): A noise filter is used which has adjustable settings from 1-31.
Advanced parameters

Additional expert settings are available in the tree to the right of the window. These should only be changed by experienced users. They have been optimized for general applications to such an extent that adjustment is only necessary in exceptional cases.

Audio settings

Audio type: You can use MPEG Layer 1, 2 or PCM (WAV) audio. Select “No audio” in the export dialog.

Sample rate: You can set a sample rate of 32, 44.1 or 48 kHz for the audio track. DVDs require 48 kHz. To reduce the size of audio data it is recommended to lower the bit rate instead of the sample rate.

Mode: You can use Mono, Stereo, Joint Stereo or Dual Channel.

Bit rate: Here you can set the bitrate of the audio signal. The higher the bit rate, the better the playback quality. For DVDs you can choose between 384 kbit/s and 448 kbit/s.

MPEG-4 encoder

MPEG-4 is actually a collection of highly efficient codecs for video and audio based on the MPEG standard. Compared to MPEG-2, the same quality can be achieved with smaller file size.

Recommendation: Check the presets that the program offers to find the right preset for each application and the right playback device. These presets are optimized for typical applications.

The advanced settings in “Advanced” are divided into “Video”, “Audio”, and “Multiplexer”.

Under „Video“ there is a choice between „MPEG-4 Simple“ (MPEG-4 Visual/MPEG-4 Part 2) (view page 186) and „MPEG-4 H.264“ (AVC/MPEG-4 Part 10) (view page 181).

Depending on the purpose of application of the material to be exported, either one of these encoder settings can be selected for compressing the video material. Refer to the manual for the playback device to find out which encoder is supported.

Under „Audio“ „AAC“ (view page 189) is preset. If you have chosen an AVCHD transport stream from the presets, “AC3 (Dolby Digital)” will be available.

Under „Multiplexer“ you can adjust certain presets, e.g. container format and streaming properties. This is only recommended for experts.
The option “Export as website” also creates an HTML page in an integrated Flash player that can play back the video created. Read the topic “Embed Flash videos into your own web site”.

**Tip:** First, check if there is a suitable preset in the export dialog for your purposes. Advanced users can make specific adjustments to these three areas using the advanced settings.

**Video codec**

**MPEG-4 H.264**

The MPEG-4 H.264/AVC codec is suitable for all types of material; however, it requires relatively higher CPU power for later decoding.

In the advanced encoder settings of the AVC encoder the “Generic” options in “Main Settings” are mainly interesting.

The AVC preset and video format can be adjusted here. For instance, if DVD quality is desired you should select “DVD”. The video format should be selected specific to the country so that the material can be played on the devices most commonly available in these countries. For instance, you should select PAL for Germany, SECAM for France and NTSC for the US.

**MVC**

MVC: Multiview Video Coding (MVC) is an expansion for stereoscopic applications. Activate this to export MVC files.

**Note:** MVC is only available in the Video deluxe Pro versions.

**2-pass**

The video to be exported will be encoded twice. The first run-through serves to calculate the streaming rate for each section (for video this is per frame). The second run-through is when the actual video is created with the streaming rates that were calculated in the first run-through. The result is an improved image quality, but encoding takes place approximately twice as long.

**Smart Render and Smart Copy**

**Smart Render** lowers the demand on the encoder for AVCHD material. In the production of AVCHD files, only those parts of the movie that were changed in the program (e.g. by video cleaning or effects) are re-encoded. Please note: The AVCHD files contained in the movie **must** have the same format, i.e. the bit rates (variable or constant), audio formats, image resolutions and video formats must match.

The Smart Rendering special mode „**Smart Copy**“ enables AVCHD material to be transferred without having to encode it for the target medium which greatly increases
the encoding speed. The video material cannot appear to have been altered in any way, only hard cuts (without fades) are permitted. These won’t be executed precisely to the frame, but rather take place at the next GOP borders. For this reason, cuts should be set somewhat more generously.

**Hardware acceleration - CUDA, Quick Sync Video, OpenCL**

MAGIX PhotoStory on DVD 2013 Deluxe supports hardware acceleration for AVCHD exports, AVCHD Disc and Blu-ray (H.264) Disc encoding (burning). This can noticeably speed up the encoding process.

The following hardware acceleration technology is supported: Quick Sync Video (Intel), OpenCL (AMD) and CUDA (NVIDIA).

**Note:** Ask your graphics card manufacturer whether your graphics card supports hardware acceleration. Make sure that all the necessary drivers are installed.

If your system does support hardware acceleration, you can activate it through “Advanced...” > “Hardware acceleration”. The program will make the adjustments according to the available technology.

**Advanced video settings**

**Generic**

**AVC preset**

This is where the actual video stream that will be exported is selected.

- **Baseline:** According to ISO/ICE 11172-1/2 standard
- **Main:** Corresponds with ISO/ICE 13818-1/2 standard
- **High:** High Profile
- **SVCD:** Corresponds with MPEG-2 Super VideoCD
- **D1:** Corresponds with MPEG-2 DVD
- **DVD:** DVD video
- **Blu-ray:** Blu-ray-Disc
- **Blu-ray HD:** Blu-ray-Disc in High Definition
- **Sony PSP:** Sony PSP-compatible format
- **HD 1280x720p:** High Profile with a resolution of 1280x720p (progressive)
- **HD 1440 x 1080i:** High profile with a resolution of 1440 x 1080i (interlaced)
- **Apple iPod:** Apple iPod-compatible stream.
Profiles

Profiles define the encoder properties that are supported.

- **Baseline profile**: The basis of applications with limited computing performance, especially for video conferences or videos on mobile telephones.
- **Main profile**: This profile was originally intended for the broadcast industry and for backup purposes. It has become less popular since the development of the “High Profile” for this purpose.
- **High profile**: This profile is used for broadcast and backup applications, and it is also used sometimes in the HDTV industry (High Definition Television). This profile is used for HD-DVD and Blu-ray Discs, for example.

Level

H.264 defines different levels. The level determines which bit rate and resolution are possible for the video.

With the “Auto level” option, the encoder determines the level automatically on the basis of the resolution of “AVC preset” video formats, the set bit rate and the profile.

Frame type

“Picture type” specifies which parts of a frame should be used as the basis for the encoding:

- **Progressive Frame**: A single image from a video sequence, also called a fullscreen.
- **Interlaced Field**: This is half an image. Two of these are combined to produce a frame. Read more about this explanation regarding “Interlace (view page 194)”. 
- **Interlace Frame**: The encoder creates a „Frame field“ which is the basis for the encoding.

Field order

*Note*: This parameter is only available if the setting “Field” is selected for “Frame type”.

In case of interlaced streams, the half-image sequence is set. Read more about this explanation regarding “Interlace (view page 194)”. 
**Slice count**

A frame can be divided into multiple slices for encoding. Specify the maximum number of slices are permitted. If set to "0", then the number will be determined automatically.

**Rate control**

The bit rate indicates how much data per second is saved in the video (playback speed). This makes the bit rate the deciding parameter with regard to the file size and quality of the video to be encoded. A higher bit rate means more quality but also a larger file size.

**Mode**

- **Constant bit rate**: The constant bit rate should only be used if the device used to play the video supports constant bit rates.
- **Constant quantizer**:
- **Variable bit rate**: The bit rate varies. For faster movements in the video, the bit rate increases, and for still images or slow pans, a lower bit rate is sufficient for creating the video in constant quality.

**Pass**

Here you can choose whether you want to manually perform one-pass or multi-pass encodings (2-pass, multi-pass)

**Note:** The 2-pass option in the main dialog of the MPEG-4 export is recommended. This automatically performs two encoder passes.

If you want to perform 2-pass encoding manually, you must select "Multi-pass analysis" in the first pass and "Multi-pass encode" in the second pass.

- **Single pass**: The encoder process takes place without prior analysis. This requires the least amount of time.
- **Multi-pass analysis**: Analysis data is calculated during encoding and used for multi-pass encoding.
- **Multi-pass encode**: Assumes that an analysis has already been performed. The analysis data is used during encoding to optimize the results.
**Bit rate (Bits/s)**

- In "**Constant bit rate**" mode: Exactly those values entered are applied to be able to calculate the size of the video precisely.
- In "**Variable bit rate**" mode: The values entered here are applied to the video as an average as a guideline. The size of the video to be exported can only be approximated.

**HSS rate**

This is the maximum bit rate that should be present in the video stream, i.e. maximum number of bits that may be transferred to the decoder.

**Note**: This option is only available in "Variable bit rate" mode. "Use HRD" must also be activated.

**Aspect ratio**

In the film industry, this is an indication of the ratio between width and height of a rectangle, monitor, or screen.

There are 3 different sizes available:

- **Picture Aspect Ratio** (also **Display Aspect Ratio**, **DAR**): This indicates the desired aspect ratio of the video to be exported. Here are some examples of typical aspect ratios: at home 4:3, 16:9 (typical for TV sets) or 16:10 (widescreen-flatscreens, widescreen notebooks), 3:2 for 35mm films and photos. In cinemas you mostly find 1.85:1.

- **Pixel Aspect Ratio (PAR, pixel aspect ratio)**: Indicates the aspect ratio of individual pixels. The majority of computer monitors have quadratic pixels (PAR=1:1), for analog television monitors (PAL at 4:3) 128:117.

- **Sample Aspect Ratio (SAR, also Storage Aspect Ratio)**: Aspect ratio of the saved resolution (number of pixels), e.g. 720:576 at PAL. It also calculates picture aspect ratio and pixel aspect ratio: \( \text{SAR} = \text{DAR} / \text{PAR} \).

**Note**: In the standard case, the "Aspect ratio" remains set the way it is. You should only change the settings if the resulting video is exported distorted or stretched or if you need to correct the video because it is in the wrong aspect ratio.
GOP structure

Max GOP length

Determines the maximum GOP (view page 193) length. High values mean improved compression. Lower values create stronger security protection and enable improved access to individual frames for processing the video.

Max b-frames count

The maximum number of b-frames (view page 195). Several cases of application, e.g. video conferences require “no b-frames” in order to achieve the shortest possible reaction times during transfer.

Scene change detection

If this option is activated the scenes will be detected during encoding, thus allowing you to insert an I frame (view page 193) after a scene change.

MPEG-4 simple

If MPEG-4 H.264 cannot be played back on your device, use MPEG-4 Simple.

Note: We recommend that only advanced users make adjustments to the advanced settings. You can use the technical specifications of your playback device to help with this.

Advanced video settings

Generic

MPEG-4 preset

Different presets located within the encoder.

(A)SP@L0-L5: (Advanced) Simple Profile in Level 0-5

(Q)CIF (Common Intermediate Format): CIF is a video format produced as soon as 1990 with the video compression format H.261. At that time, the format was used for video telephone conferences. The “Q” in QCIF stands for “Quarter”, and since resolution is halved in terms of height and width compared to CIF, the entire size is only a quarter of CIF. QCIF was popular with mobile telephone manufacturers, since the resolution of 176 x 144 pixels was sensible for the first affordable SmartPhones (144 x 176).
(Half)D1: D1 corresponds with MPEG-2 DVD. HalfD1 has exactly half of the entire number of pixels, meaning that the pixel number of the height and weight is 2/3 of D1.

720p: Video stream with a resolution of 1280 x 720p (progressive).

Apple iPod: Apple iPod-compatible stream.

Sony PSP: Sony PSP-compatible stream.

Profile/Level

Profiles: Profiles define the encoder properties that are supported.

Level: The level determines which bit rate and resolution are possible for the video.

Picture type

“Picture type” specifies which parts of a frame should be used as the basis for the encoding:

- Frame: A frame is a single image from a video sequence, also called a full image.
- Field: A half-image, two of which combine to produce a frame. Read more about this explanation regarding “Interlace (view page 194)”.

Field order

Note: This parameter is only available if the setting “Field” is selected for “Frame type”.

In case of interlaced streams, the half-image sequence is set. Read more about this explanation regarding “Interlace (view page 194)”.

Slice count

A frame can be divided into multiple slices for encoding. Specify the maximum number of slices are permitted. If set to “0”, then the number will be determined automatically.

Rate control

The bit rate indicates how much data per second is saved in the video (playback speed). This makes the bit rate the deciding parameter with regard to the file size and
quality of the video to be encoded. A higher bit rate means more quality but also a larger file size.

**Mode**

- **Constant bit rate**: The constant bit rate should only be used if the device used to play the video supports constant bit rates.
- **Variable bit rate**: The bit rate varies. For faster movements in the video, the bit rate increases, and for still images or slow pans, a lower bit rate is sufficient for creating the video in constant quality.
- **Constant quality**: Similar to the “Variable bit rate” mode, the bit rate varies according to the video material. The quality depends on the selected profile and can be changed.
- **Constant quantizer**: In this mode, a fixed colour quantization is used for the macro blocks. Under Advanced settings, a value between 1 and 32 can be set independent of the respective frame (I-Frame (view page 193), P-Frame, or B-Frame (view page 195)). The higher the value, the stronger the quantization: small values produce qualitatively high-quality images and the data rate increases, and larger values produce a reduction in data, but the quality suffers.

**Bit rate (Bits/s)**

- In “Constant bit rate” mode: Exactly those values entered are applied to be able to calculate the size of the video precisely.
- In “Variable bit rate” mode: The values entered here are applied to the video as an average as a guideline. The size of the video to be exported can only be approximated.

**Max. rate**

This is the maximum bit rate that should be present in the video stream, i.e. maximum number of bits that may be transferred to the decoder.

**Note**: This option is only available in “Variable bit rate” mode.

**Pixel aspect ratio**

Specifies the page ratio of the individual image points (pixels).

**Meaning**: Different television norms and the standard pixel ratio. Select a setting and the results are displayed as “X” and “Y”.

www.magix.com
X/Y: The actual pixel ratio. If under “Meaning” the setting “Custom” is selected, then a custom ratio can be set.

**GOP structure**

**Max key interval**

Determines the maximum GOP (view page 193) length. High values mean improved compression. Lower values create stronger security protection and enable improved access to individual frames for processing the video.

**B-frames count**

The number of B-Frames (view page 195). Several applications, e.g. video conferences, require a setting of “0” for this, i.e. no B-Frames, in order to enable the shortest possible reaction times for transfer.

**Scene change detection**

If this option is activated the scenes will be detected during encoding, thus allowing you to insert an I frame (view page 193) after a scene change.

**Audio codec**

Under „Audio“, „AAC“ (view page 189) is preset. If you have chosen an AVCHD transport stream from the presets, “AC3 (Dolby Digital)” will be available.

**AAC**

AAC was developed by MPEG, the Moving Picture Experts Group (Dolby, Fraunhofer Institut für Integrierte Schaltungen in Erlangen, AT&T, Nokia, Sony) as an audio data compression process that was specified as a further development of MPEG-2 Multichannel in the MPEG-2 standard.

AAC is equally suitable for encoding general audio information and not especially optimized for certain types of audio material.

AAC audio can be encoded with a sample rate of 8000, 16000, 24000, 32000 or 48000 Hz in either mono or stereo. By default, the sound is set to 48000 Hz stereo. The higher the sample rate is, the larger the resulting file and higher the audio quality. You can use the technical specifications of your playback device to help with this.

**Advanced audio settings:**

- The **bit rate** can be set between 6 and 512 kbit/s. 160 kbits/s is active by default. The higher the value is, the larger the resulting file and higher the audio quality.
After a certain limit, additional improvements to audio quality will not be perceived. Bit rates under 64 kb/s are not recommended.

- **As an MPEG version**, set MPEG-4 or the older, proven MPEG-2 format.
- **For the File Header Type**, choose either RAW or ADTS. The "Header" indicates an explanatory head for the beginning of the file segment, which in fact takes up extra space, but is required for decoding under circumstances.
  - **RAW** indicates material which does not include a file header in audio format. The audio material is therefore transferred directly without any special additional information (raw). This requires that decoding routines are able to process the material without the explanatory file header. Especially in case “exotic” sample rates are set, this can lead to problems during RAW encoding.
  - **ADTS** indicates a file header type which contains information for encoded audio material. In case of doubt, select this file header type, since fewer problems can be expected in this case.

### Profiles:

- **Low complexity**: Data is present in a form that hinders different decoding algorithms (noise replacement), but enables others (temporal adjustment noise formation).

**Note:** For example, Apple iPod requires "low complexity encoding". However, you don’t need to worry if you select the right preset for Apple iPod in the export dialog.

### AC3

If you have chosen an AVCHD, AVCHD transport stream or Blu-ray (H.264) from the presets, “AC3 (Dolby Digital)” will be available.

**Note:** AC3 (Dolby Digital) Surround is only available in the PLUS and Pro versions of Video deluxe.

### Multiplexer

The Multiplexer combines audio and video streams so they can be played back together on playback devices.

### Output format

- **MPEG-4 file**: This is an MPEG standard (ISO/IEC-14496) with the original goal of supporting devices with less computing performance. Currently, MPEG-4 has reached a wide bandwidth of application, from HD video to support for mobile telephones.

- **JPEG2000 file**: DCI (Digital Cinema Initiative) has been replaced by the JPEG2000 format for encoding movies. The current distribution and presentation of films has
been taken over by digital projectors that play back high-resolution Mj2 streams in outstanding image and sound quality.

3GPP file: A standard supported by plenty GSM and UMTS mobile telephones. 3GPP is very similar to the MPEG-4 standard, but also supports formats that are not permitted by MPEG-4.

Streamable format
Activate this option if you would like to create files that can be integrated into and played back on websites. This way the file can be played back without having to be completely preloaded.

Note: This setting is recommended if you choose the option “Export as website”.

For Sony PSP
Switch on this option if the video should be played back with the Sony PSP.

For iPod
Switch on this option, if the video should be played back with the Apple iPod.

MPEG glossary

Motion estimation
Motion estimation is a further element for reducing data used in MPEG encoding.

Motion estimation also occurs in the B and P frames. The image difference that still exist after prediction (view page 195) are examined. Complex algorithms are used to search for an original occurrence of the macro block in the reference frame of each macro block of the P or B frame (these are units of 2x2 blocks specially combined for this purpose), which have been moved either by movement or by camera pan. They can then be left out in the P and B frame. Only the information by how far and to where the macro block has been moved is saved instead. This vector is called the motion detector.

In the General encoder settings (view page 177), you can specify the quality of the final MPEG video. This factor also influences the time required for encoding. The longer it takes, the better the quality.

Bit rate
MPEG is a format used for storage and transferring. With older formats (e.g. AVI) you could predict that 20 seconds of movie would result in 20 MB of data. The file size is this a direct measurement of quality.
This is different for MPEG: The amount of data available can be used differently for different display modes. 20 MB can be 4 seconds of DVD Video or 5 minutes Internet streaming in thumbnail format. The quality of an MPEG video is measured by the width of the created data stream, the bit rate. This is the amount of the transmitted data per time unit; it is stated in kBit/s or bit per second.

Bits, not bytes are used, since the data word width has to address the transmission restrictions.

The file size can be calculated from the average bit rate, if its length is known:

\[ F = (BRV + BRA) \times t \]

- **F** = File size
- **BRV** = Video bit rate
- **BRA** = Audio bit rate
- **t** = Length in s

**Block**

For almost all image file editing techniques the image is subdivided into 8 x 8 pixel blocks (image points). This should be noted if you would like to used user-defined image resolutions (width/height), and they should always be a multiple of 8.

**Chroma format**

The color value of each image point consists of the color values for the primary colors red, green, and blue (RGB), and for traditional and technical reasons it is transformed into one brightness value (\( Y = 0.299 \times R = 0.587 \times G + 0.114 \times B \)) and two color difference values (\( U = R - Y, \ V = G - Y \)).

The Y value alone produces the black and white picture. These signal components allow brightness and color information to be handled separately. The first data reduction occurs when single rows comprising a picture are read. Because the human eye has a lower color resolution than a brightness resolution, the color components are recorded only for every other point of a row (4:2:2) for each four pixels grouped (4:1:0), i.e. color signal under-reading.

4:2:2 This corresponds to the established TV standard. One piece of color information is transmitted per row for two pixels which corresponds to a 2/3 compression of the output data.

4:1:0 This is the color coding used for DVDs and most other consumer video applications. For each 4 pixels grouped together on two rows, one unit of color information is saved. This corresponds to a output data compression of 1/2.

**Field**

A half-image, i.e. two halves which combine to produce a frame (see de-interlacing (view page 194)).
Frame
A frame is a single image from a video sequence which also called a full image. PAL video, for example, contains 25 frames per second, NTSC 29.97 frames.

Video recordings, with the exception of computer animations and still frames, don't contain full images. Instead, they have double numbers of half-images (fields) which are transmitted in an interlaced state. However, we still refer to frames, since many predecessors of MPEG compression are based on such frames. Video editing literature usually refers to frames.

GOP
Group of Pictures: The sequence of I frames and the P and B frames that belong to them.

e.g. I B B P B B P B B I ...

(This GOP has a length of 9, with 2 P frames and 2 B frames)

I frames contain the entire image information of a frame, while P and B have part of the information. So-called prediction (view page 195) and movement approximation are methods used for reduction.

The combination P B B is called a subgroup.

I frames must appear in regular intervals in the data stream for image and sound to be synchronized. Between the I frames only a limited count of P and B frames is allowed. This explains a few things: Since P and B frames contain only differential information, these differences will be larger with time, since more and more changes takes place from frame to frame. A large count does not make much sense, since GOP has a maximum length of 15 (4P, 2B) in PAL and 18 (5P, 2B) in NTSC. (More than 2 B frames between P frames is not allowed).

In a closed GOP, B frames of the last subgroup may contain only backward predictions or references to the preceding P frame, but no references to the following I frame, since it belongs to the next GOP.

I frames
Intra-frames: In these pictures, the entire image information of a frame is saved and only information from this frame is used (“intra-frame encoded”). In contrast to the I frame, P and B frames save only the differences between the current frame, and preceding and/or following frame are also found in MPEG video (P frame = “predicted frame”, B frame = “bidirectional frame”, see Prediction (view page 195)).
Interlace
For historical reasons, pictures in a movie are always recorded and transmitted in the form of two fields, first the lines with even numbers and then those with odd numbers. These fields are alternately displayed with a double-frame rate. The (lazy) eye of the viewer or the processing of the TV tube puts the two frames together to form one.

The output image  First field  Second field

You normally don’t have to worry about field processing. The video material goes through the entire processing chain as fields and is exported again as fields or burned onto DVD or shown on TV when played back on a DVD as a full picture. Only in certain rare conditions is it necessary to delve deeper into this process. Two problems can occur:

Interlace artifacts
To be displayed on a computer monitor the two fields must be combined to form a full screen.

These two fields are not the same, since two fields are created during the recording (between which a 1/50 of a second gap is evident). Moving objects can therefore produce artifacts at the vertical edges.

Typical interlacing errors
You can use so-called “de-interlacing” to avoid these artifacts. A picture in between the two fields is created (interpolated). So if you want to create stationary pictures from movies, then you should definitely use a de-interlace filter.

In the system settings (File menu-> Program settings) you can set the preview monitor display to use hardware de-interlacing during video recordings, for the video recorder, and for display in the arranger.

Incorrect field rate
If you move around the series of fields in a movie data stream you can see strong jitter and flicker effects. Picture objects move in a backward movement - two steps
forwards, one back - since a delayed field is shown before the previous one. This can happen in the processing chain if you export video material improperly with the wrong field order and then import it into different material.

We use MXV or MPEG “Top field first” format for all analog recordings (“odd” in other programs). DV-AVI on the other hand is saved with “Bottom Field First”.

You can correct the field series for each video object in its object settings. See: Menu -> Effects -> Object properties

**P frames and B frames**

P frames save only the difference between the current picture and the preceding I frame. The “P” comes from the term “prediction” which describes this process.

B frames save the differences between the current picture and the I or P frame preceding and following. This includes the information that was the same before and remained the same after the current frame. Both directions are analyzed (indicates the “B” in the name, i.e. “bidirectional-predicted”). You can read more under prediction (view page 195).

**Prediction**

Prediction is a method of data reduction used by the MPEG format. The image elements already known from the previous or following frames are removed from the data stream.

**How does it work?**

The encoder has a precisely defined GOP, for example IBBPBBPBB. This sequence is transmitted together with the encoder, which always knows exactly which kind of frame comes next. I, P, and B frames are differentiated.

Hint: When we talk about pictures, we mean frames of the video output, and I, P and dB frames are the frames of the encoded video. Just as in movement approximation, blocks (8x8 pixels) are united into macroblocks (16x16 pixels) during prediction.

The first frame is always the I frame. It is completely encoded from the first picture. Afterwards, the 4th picture is analyzed for the creation of the first P frame. (As already said, the encoder, and later the decoder, will know that two B frames belong between them.) This image will also be completely encoded, and afterwards all macroblocks that haven’t changed in comparison to the I frame will be deleted. They will be replaced by corresponding references for the decoder that tell it “you already know what should be shown here, and you can get it from the last I frame”.

Now, the 2nd will be completely encoded, and all macroblocks identical to the first I frame and the following P frame will be removed. References to previous frames are called backward predictions, and references to following frames are called forward predictions. The third picture will be edited in exactly the same fashion.
The fourth picture we have already explained, and now we need the next P frame, or picture number 7. Pictures 5 and 6 are B frames again, which are compared to P frames to both sides of them (picture 4 and 7); these are followed by the last two B frames. These have a special place, since in closed GOPs, they may contain only backward predictions, and no references to the next I frame, because it belongs to the next GOP.

Something else: Since the decoder is not a prophet, the P frames are always transmitted before the B frames! The GOP explained above will be encoded and transmitted in the order it is written.

Original GOP

| I0 | B01 | B02 | P01 | B01 | P02 | B11 | B12 | I1 |

Data stream

| I0 | P01 | B01 | B02 | P02 | B11 | B12 | B21 | B22 | I1 |

... for closed GOPs

| I0 | P01 | B01 | B02 | P02 | B11 | B12 | I1 | B21 | B22 | P11 |

... for open GOPs

Due to this nested structure, it is easy to see that during direct editing of MPEG material, complicated computations have to take place! These are made easier using a frame table. A frame table contains a list, where the information of every frame in the data stream is found, identifying the type of frame it is.

Using Movement prediction (view page 191) P and B frames are likewise reduced.

Quantization scaling

The single pictures in MPEG are saved using a compression method comparable to JPEG with bitmaps and associated with quality loss. For this single images are divided into 8 x 8 blocks (view page 192). Each one of these blocks is then transformed into an 8 x 8 matrix (a table with rows and columns) using a DCT (discrete cosine transformation) mathematical method. Each of these values is produced using all 64 individual pixels of the block, but the values in the matrix are ordered in such a way that the image information is ordered according to its importance.

This matrix will then be multiplied by another matrix, i.e. the quantization matrix. Exactly how and why this matrix must be created is the biggest secret of encoder programmers, since this determines the quality of the whole encoding process. What is known is that the result should contain as many zeros as possible! These zeros correspond to the "unimportant" image elements mentioned and will not be transmitted in the data stream.

Depending on the encoder parameters regarding the target bit rate, fewer or more values of the matrix will be declared unimportant by dividing the quantization matrix by the quantization scaling factor. Since only whole numbers are used, a division can produce a zero is the remainder is discarded.

This factor is also a direct measure of the sought image quality of the MPEG data stream, since the "Q" in "Q" factor stands for quantization and quality.
Annex: Digital Video and Data Storage

Video Editing on the PC

Digital video processing with the PC is comparable to audio processing. The analog medium that is video must first be digitized before it can be processed by the computer.

Digital video processing functions quite similar to recording via a sound card. The signal flow is measured in very short, regular intervals, and the values resulting from it can then be processed by the computer. The accuracy of each individual measurement results in the resolution, and the frequency of the measurements results in the frame rate. The more precise and frequent the signal is measured, the higher the quality of the digitized video, but also the higher demands on the capture performance and the required storage space. The Windows standard format for video files is AVI (audio and video Interleaved).

Digitizing video adopts either the camera or the graphics card, a TV card (e.g. Miro PCTV), or a video card (e.g. Fast AV Master). However, video handling makes much higher demands upon the hardware if good image quality is required. In order to be able to reasonably process video files on today’s PCs, they must be compressed. Digital audio, on the other hand only uses compression for saving storage space.

HDTV

This acronym stands for “High Definition Television.

High definition television is a general term applied to a series of television norms that differentiate themselves from normal television by increased resolution and an altered aspect ratio (16:9). This type of digital television offers cinema-like image quality and impressive sound quality. With doubled horizontal and vertical resolution the image quality of HDTV is approximately four times as sharp as previous standards (PAL, NTSC, SESAM).

At this time MAGIX PhotoStory on DVD 2013 Deluxe supports two resolution standards:

- 720p (1280x720 pixel)
- 1080i (1920x1080 pixel)
MPEG Compression

MPEG means “Moving Picture Experts Group” and defines a workgroup which cooperates with the International Standards Organization (ISO) as well as the international Electro Technical Commission (ETC) to develop standards for video and audio coding.

Generally, the graphic data rate of the digital video standard is 167 megabits per second, which, when not compressed, requires a far higher storage capacity than a DVD can offer. A one-sided DVD 5 with 4.7 GB storage capacity is enough for 4 Minutes. For this reason, the available pictorial material must be effectively compressed – a function which is achieved with the MPEG procedure.

This procedure is based on the simple fact that up to 96% of digital video data consists of repetition and can be compressed without visible degradation of the pictorial quality.

Each MPEG compression is, however, a data reduction and as such connected with information loss. If the video consists of very extensive details, or if the content changes very fast, then the picture may blur (dependent on the strength of the compression and the quality of the encoder).

Errors can also result from so-called compression artifacts such as small color defects or images that are too dark.

At average compression rates under 3 megabits per second it is probable that you will notice reduced quality. At rates around 6 megabit per second the degradation in quality becomes almost invisible.

General notes on AVI videos

The AVI format (Audio Video Interleaved) isn’t actually a proper video format! Rather, it is a so-called “container”, where the conventions for transferring audio and video files to the program are only loosely defined. The codec (coder/decoder) actually defines what storage format is used. A codec compresses audio/video data into its own unique format which can only be read by the codec itself and is decoded when the film is played.

In concrete terms, a computer-generated AVI file can only be loaded by and played on a different computer if the same codec is installed on it.

Many codecs (e.g. Intel Indeo® video) have now become standard components of the Windows™ installation. Others like the popular DivX codec are not standard. If you are generating an AVI file for future play on another computer using one of these codecs, you should first install this codec on the other PC. The best method available is to copy the codec installer to your export directory and burn it every time you create a video disc (slideshow disc) for play on computers.
You may encounter some problems when using older video editing cards with codecs which only function with the card’s hardware. Such AVIs can only be used on the computer which was used to create them. Try to avoid using this kind of codec.

Digital Versatile Disc (DVD)

**Quality**
Featuring a resolution of 720 x 576 (PAL) and encoded with MPEG-2, 25 frames per second provides very good results.

**Writable data storage formats**
The recordable DVD market is currently split into three types: “DVD-RAM”, “DVD+RW”, and “DVD-RW”.

**DVD-R/+R:** This medium may only be written to once. The DVD-R may be specified with file structures for DVD video, DVD audio, or DVD-ROM.

**DVD +RW:** +RW drives allow re-writable DVDs to be created which may be read by almost any commercial DVD-ROM or DVD player. The companies involved are mainly Philips, Sony, HEWLETT PACKARD (as well as Ricoh, Yamaha and Mitsubishi).

**DVD-RW:** This is a write/erase DVD technology promoted by Pioneer and Sharp. This format was developed by the Pioneer company and should be compatible with existing DVD players.

**DVD-RAM:** DVD-RAM technology is based on either Phase Change, MOs, or hard disks, etc. and is now almost 100% incompatible with all available players.

Due to the small storage capacity and incompatibility with DVD players, setting on this standard is not recommended.

**Note:** MAGIX PhotoStory on DVD 2013 Deluxe supports DVD±R and DVD±RW, but not DVD-RAM.

**Blank discs:** Single-sided recordable blank discs featuring a capacity of 4.7 GB and a duration of approx. 2 hours.

**Copy Protection**
**Macrovision (APS):** The movie industry claims that even DVD-ROM drives and decoders or diagram cards with composite outputs or s-video outputs must support the Macrovision analog copy protection (APS). Only some older DVD players do not possess APS.
APS adds additional signals to a DVD’s stored graphical data. The data is almost unchanged. These supplementary signals disturb the synchronization and the automatic recording regulation of most video recorders to prevent recording of the video. They are not noticeable on the television or the monitor, however.

Content Scrambling System (CSS): CSS prevents saving and duplication of DVD video tracks to hard disk. The VOB streams of DVDs without CSS can otherwise (like other video files) be loaded via the Import Video button.

There are further types of copy protection besides APS and CSS which ensure that retail DVDs cannot be copied without distortion.

Blu-ray Disc

Since early 2008, Blu-ray Discs are viewed as successors to DVDs and offer especially high storage capacity of up to 27 GB in a single layer (double-layer up to 54 GB) with very few write errors.

The term Blu-ray Disc comes from the blue color of the laser. Because a color cannot be registered as a trademark, the letter “e” was removed from the word “blue.”

The high storage capacity of the Blu-ray Disc suits high definition videos and slideshows in high quality perfectly, since these are characterized by large file sizes (depending on material approximately 40 MB/sec) and very high memory use. The MPEG-2 codec is used to create video.

Companies that were involved in developing Blu-ray technology have united themselves into the Blu-ray Disc Association (BDA).

Blu-ray Discs come in three varieties:
- Only readable BD ROM (comparable to DVD video),
- rewritable BD-RE (comparable to DVD±RW or DVD-RAM),
- and as a disc that can be written to only once BD-R (comparable to DVD±R).

AVCHD disc

Use this format to create a high-resolution video. You can burn Blu-ray (BD-R/RE) blanks as well as conventional DVD±R/RWs. In contrast to Blu-ray Discs (view page 200), MPEG-4/AVC codec (view page 180) is applied as the video format, which requires less memory at a comparable image quality.

Compatibility

AVCHD disc on Blu-ray blank: Since this is a BD-conformant format, the disc created can be played back in any conventional Blu-ray player. Playback problems can almost
always be traced to incompatibilities between Blu-ray blanks and Blu-ray players. In
this case, consult the instructions for your Blu-ray player or ask the manufacturer
which blanks are compatible with the device.

AVCHD disc on DVD blank: The DVDs created with AVCHD video are not supported
by all Blu-ray players. The behavior of the devices is quite different. Normal DVD
players cannot replay AVCHD discs, since the AVC format is not supported.

If you still have questions

Tips for program help

The “Help” file features hints on how to use the program and additional information.
Many important terms are indicated in the text in italics and clicking on them displays
an explanation.

Context help: Press the “F1” key at any point in the opened program and the help file
will open with the matching topic (context help).

Search function: Use the search function to find out information about specific words.
Enter either the individual word or use logical operators (OR, AND, NEAR) to refine
your search if you have several search words.

• “OR” (between two words): All topics which contain both words or one of the
words will be listed.
• “AND” (between two words): Only those topics will be listed which contain both
words.
• “NEAR” (between two words): Only those topics will be listed which contain both
words. A maximum of six other words may be added between the search terms.
• “NOT” (before a word): Topics which contain this word will not be listed.

Print: Use the help program’s print function to make a printout of individual topics or
entire sections. The print button is located at the top of the help window in the
toolbar.
System requirements

- For Microsoft Windows
- XPI Vista 7 | 8
- 32-bit and 64-bit systems

Minimum configuration & HD output

- Processor: 1.83 GHz
- RAM: 512 MB
- Graphics card: Onboard graphics card with a screen resolution of at least 1024 x 768
- Hard disk memory: 1 GB free disk space for program installation
- Optical drive: DVD drive
- Burning: CD-R, DVD or Blu-ray burner

Note: The program's internal online services and the online update require an Internet connection. For copy protection reasons, MPEG-4, MPEG-2, and DolbyDigital must first be activated for free. MP3 export requires installation of Windows Media Player version 10 or higher.

System requirements for HD and Stereo3D editing

- Processor: Quad processor 2.83 GHz and higher
- RAM: 4 GB
- Graphics card: Dedicated graphics card with 512 MB VRAM or more
Glossary

A
audioID
audioID is a process used to determine the title and artist name based on musical properties. An Internet connection is required to access the audioID database.

AVI
The AVI format (Audio Video Interleaved) isn't actually a proper video format! Rather, it is a so-called “container” for which the conventions for transferring audio and video files to the program are only loosely defined. More in this topic can be found in General notes on AVI videos. (view page 198)

B
Browser
A browser (also known as web browser, or Internet browser) is a computer program that displays websites. The best-known browsers are Internet Explorer, Firefox, Safari, and Opera.

Button
Refers to an element of the graphic user interface of a program. The button initiates an action in the program via left mouse click.

C
Cache
Simply stated, this is a temporary folder where frequently accessed files are saved so that they can be quickly launched while you are working.

CC
CC stands for “Connectivity Co-ordination” and describes how the change of a domain name from one provider to another occurs (domain transfer).

CDA
Short for “audio CD” produced in accordance with the so-called “Red Book” standard. It contains audio files (music) and can be played in CD-ROM drives as well as in regular CD players in stereos.
Clip level  
Signifies the volume level at which the recorded signal is overmodulated, or “clipped”.

Clipboard  
The clipboard is used to temporarily store objects during execution of commands like “copy” and “cut”.

Context menu  
Context menu can be reached by right clicking on a selected object. It offers functions which are available and can be expected in the given context.

Copyright  
Protection of intellectual and creative property against unauthorized copying.

CPU  
Central processing unit: The name for the main processor of the computer (CPU). Modern computers have even two or more processors, or one processor with several cores.

D  
Dialog  
A dialog opens in a new window and lets the user interact with the program. This means that the dialog can present information to the user and/or expects to receive input from the user.

A dialog can contain various user elements which can be manipulated by a simple mouse click. Keyboard entries are also possible.

Disc project  
A project includes everything that you want to put on your CD and DVD. This normally contains one or more slideshows and includes a menu structure/menu design which allows you to choose a slideshow later on the CD or DVD.

Disc types  
The disc types determines the format and medium (CD, DVD, Blu-ray disc, etc.) to which the current project will be burned.
DNS
The abbreviation DNS stands for Domain Name Service and refers to a provider of Internet services that registers domain names for customers.

Domain
A domain is the website’s Internet address. It consists of the name of the Internet protocol (usually http://), the computer or network name (such as www), the second-level domain (such as magix), and the top level domain (like .com, .net).

Altogether we have: protocol://networkname.second-level-domain.top-level-domain (such as “http://www.magix.com”).

Domains are allocated by a country’s so-called NIC (Network Information Center). In Germany the DENIC is responsible for the release of domains.

Domain transfer
See CC. If you already have a domain, you can move it from your previous provider to another provider.

Drag & drop
Enables files and objects to be moved freely between various applications (or within an application) by dragging the object and letting it drop using the mouse cursor.

F
Fader
Used for visual input of values. Similar to volume control on a mixing board, you can control various parameters by sliding the fader. A very common example for this is the zoom slider that lets you see a picture in more detail.

Field
A half-image, two of which combine to produce a frame (see interlace).

Flip menu
Drop down menus create menus consisting of lists of selectable choices. They look very similar to text input fields, but have a button with a downward-pointing symbol on the right-hand side.

Frame
A frame is a single image from a video sequence which also called a full image.

A PAL video contains 25 frames per second; NTSC contains 29.97 frames.
Handles
Handles are the five little rectangles at the edges of selected objects. All curve points can be moved by holding down the left mouse button.

Length handles: Bottom right and bottom left. You can use them to change the length of an object.

Fade handles: Top right and top left. These can be used to softly fade an object in or out.

Volume/Brightness handle: Above-center. You can use it to adjust the volume or the brightness.

Hard disk
Storage medium with the largest storage capacity where the operating system(s), programs, and files are saved. A hard disk can be built into the computer, but there are also external hard disks which can be used with different computers via a USB connection (portable drives or external hard disk).

Hard disk drive
Storage medium with the largest storage capacity where the operating system(s), programs, and files are saved. A hard disk can be built into the computer, but there are also external hard disks which can be used with different computers via a USB connection (portable drives or external hard disk).

Hardware
The all-encompassing name for all internal components of a computer. For example hard disk, graphics card, mainboard, etc. External peripheral devices are also considered hardware, i.e. printer, scanner, monitor, etc. The synchronization of single hardware components is coordinated by the software.

HDD
Storage medium with the largest storage capacity where the operating system(s), programs, and files are saved. A hard disk can be built into the computer, but there are also external hard disks which can be used with different computers via a USB connection (portable drives or external hard disk).

HDTV
This acronym stands for "High Definition Television.

HTTP
Stands for Hyper Text Transfer Protocol and is used for transferring websites onto the Internet (from web server to the browser). For this reason, the abbreviation http://
always comes before the Internet address. This is automatically inserted and does not have to be entered when entering the Internet address.

**Hyperlink**

Hyperlinks (or in short “links”) are references to other websites/online documents (or other computer networks). They build the base of the World Wide Web (WWW) as it is only via these hyperlinks that networking or interlinking between the billions of website out there is actually possible.

**ID3 tags**

ID3 tags contain title information that can be added to a music title. This includes the title, artist, album, as well as the genre, year of release, and other criteria that can help searching through a database. The database is created using this information.

*Info:* Title information will only be saved for MP3s in the so-called ID3 tags (Identify an MP3), but other formats offer similar possibilities, like “Vorbis comment” for the OGG Vorbis format, for example.

**Image**

An image is a representation of a CD, DVD, hard drive, or another storage medium that is saved as a file.

The difference from a copy or backup is that an image contains information about the structure of the original storage medium, and not just individual files. This enables 01:01 copies of complete storage media to be created.

*Caution!* Copyright laws forbid copying of commercial CDs/DVDs, and for this reason, this process can be prohibited by copy protection.

**IMAP**

Stands for Internet Message Access Protocol and is an advanced process of receiving emails.

**Interlace**

Describes the creation of a full image from 2 half-images (fields).

In this process, even and odd lines are alternately assigned to one of the two fields.

The human eye perceives both of the projected half-images as a single full image, so that despite the slow image repetition rate (25 Hz for PAL, 29.97 for NTSC) a subjectively fluid image is seen.
Intro
“Intro” means the introduction or opening credits of a movie.

J
jpx
A format developed by MAGIX which is used for photo editing. It enables free experimentation with effects without altering the original file. The effects settings are also displayed when the photos are opened using a different MAGIX program.

M
Menu
Menus contain practically all function of a program. They can be opened using a simple mouse click on the corresponding menu. Keyboard shortcuts, if available, are also found at the end of menu entries.

The graphical surface of a CD/DVD will also be represented as a menu.

Menu bar
Almost every program has a menu bar. It can normally be found underneath the title line of the program. A simple mouse click opens a corresponding menu.

MIDI
MIDI files do not contain the actual sounds like audio files, but only the note control information which can be interpreted during playback by the synthesizer chip on the sound card or an external synthesizer.

Motherboard
This is the centerpiece of hardware components of a computer. All other hardware components like CPU, RAM, hard disk, additional drives, graphics cards, as well as other cards for specialized uses are connected to the motherboard.

Motherboard
This is the centerpiece of hardware components of a computer. All other hardware components like CPU, RAM, hard disk, additional drives, graphics cards, as well as other cards for specialized uses are connected to the motherboard.

Motherboard
This is the centerpiece of hardware components of a computer. All other hardware components like CPU, RAM, hard disk, additional drives, graphics cards, as well as other cards for specialized uses are connected to the motherboard.
MOV
MOV is a video and audio format developed by Apple, which has since become widely used with Windows. QuickTime supports lots of compression technology, which make it possible to optimize audio and video and even graphics for the Internet and multimedia/video applications. Conventional (hardware) DVD players are not able to play this format.

MP3
MP3 (actually MPEG-1 layer 3) is currently the most important standard for compressing audio files.

MPEG
MPEG is short for “Moving Picture Experts Group” and refers to a committee concerned with the standardization of video and audio data compression as well as container formats.

MS audio
A process developed by Microsoft for compressing audio files with properties similar to those of MP3.

MXV
This is the MAGIX video format for quicker processing with MAGIX products. It offers very low loss of quality, but it cannot be played via conventional DVD players.

Noise Sample
Sample of a noise that is to be removed.

NTSC (USA, Japan)
NTSC stands for "National Television Systems Committee". This is a US institution that defined the first color carrier system for TV which is now used in most of America and some East Asian countries.

The image repetition rate for NTSC is 29.97 Hz.

Numeric keypad
Also known as the numpad, or the number block.

OGG VORBIS
This is a new, royalty-free format with similar properties to MP3.
PAL (Europe)
Phase Alternating Line, or PAL, is a process for color transmission for analog TV that is primarily used in Europe, but also in Australia, South America, and many African and Asian countries.

The image repetition rate for PAL is 25 Hz.

Play marker
The play marker is a red vertical line which moves from left to right during playback. It indicates the current play position.

Playlist
Arrange your songs in playlists from various sources in different formats and in whatever way you like, sometimes updated daily.

**Important**: Playlists are only links to songs on your hard drive or in your CD drive.

When you add a song to your playlist whose real source is a CD in your computer’s drive, the song will no longer be playable when the CD is removed from the drive.

Similarly, when you move a folder on your hard drive, the playlist will no longer be able to play the song, since the link is no longer valid.

For the latter, however, there is a simple solution: If you know where the song has been saved, then you can redefine the path. A corresponding dialog window is provided for this purpose. You can reset the path by navigating through the Explorer folders. The playlist is now correct once again.

Plug-in
Plug-ins are additional programs that expand the functionality of the main program. They are inserted into the main program.

Podcast
Think of a podcast as something like a radio station on the Internet. Regular Internet radio stations “transmit” in real time, which means that you can simply listen to the program that’s playing and edit it. Podcasting is different. The programs are preproduced and loaded to an Internet server for downloading. As a listener you can subscribe to the podcast and the files will be downloaded at a specified time for you to listen to them whenever you like, for example on the go via your portable player.
Podcasting
Podcast is the name for a relatively new Internet transfer form. It is made up of "pod" from "iPod", the name of a popular portable MP3 player, and the term "casting" for broadcasting content to a wide group of listeners/viewers.

A podcast is therefore something like an online radio station. “Broadcasting” web radio stations means you can only listen to and record the currently broadcast radio station. Podcasting is different. You as the listener can subscribe to the podcast and the files will be downloaded at a specific time and you can listen to them whenever you like, for example, on the move with your portable player. The shows are pre-produced and placed on an Internet server for download.

POP3
Stands for Post Office Protocol (version 3) and is used in standard email programs for receiving email (for example, Outlook Express). POP3 enables email to be collected by the provider’s email server and loaded into your email program.

Project
A project includes everything that you want to put on your CD and DVD. This normally contains one or more slideshows and includes a menu structure/menu design which allows you to choose a slideshow later on the CD or DVD.

Project
A “Disc project” includes everything that you want to put on your CD and DVD. This normally contains one or more movies and includes a menu structure/menu design which allows you to choose a movie later on the CD or DVD.

Provider
A provider or ISP (Internet Service Provider) offers Internet services like webhosting or domains (DNS). In relation to the MAGIX Website Service, MAGIX is the provider.

R
RAM (Random Access Memory)
This is a hardware component of a computer. RAM is needed to temporarily save files. This type of storage is erased when the computer is shut down or reset. The larger this storage is, the faster you can work with programs to change and save files.

Ratio:
The aspect ratio is the ratio between the height and width of a rectangle. In practice these are photos, screens or projection screens. This method can also be used to describe the aspect ratio of pixels.
Here are some examples of typical aspect ratios: at home 4:3, 16:9 (typical for TV sets), or 16:10 (widescreen flat screens, widescreen notebooks), 3:2 for 35 mm films and photos. In cinemas you mostly find 1.85:1.

**Red Book**

Specific standards have been established for the different CD types in order to unify their data structure and to make them compatible with the different CD drives. Their names refer to the color of the books where these standards were written.

The term “Red Book” is common language for the Compact Disc Audio Standard. The requirements listed here have to be observed for industrial CD production. Audio CD players only read CDs created according to the Red Book format. It is therefore necessary to first convert PC files into this format before writing them onto an audio disc compatible with any audio CD player.

**Restore**

Restoration of files originating from a backup will be called “Restoring”.

**RM**

RealMedia includes all of the media formats from software developer RealNetworks. RealMedia especially refers to the “RealVideo” video format and the “RealAudio” sound format. The quality of RealVideo files is comparably good at high compression rates, but does have some loss of quality. These formats cannot be played back by (hardware) DVD players.

**Screenshot**

A screenshot is an image composed of all visible screen elements (messages, open dialogs, etc.) at a certain time. By pressing the “Print screen” key on the keyboard, this image is saved into the clipboard. Next, open a program which can edit images and select “Insert” (shortcut “Ctrl+V”) in a new document to add the screenshot for editing and saving.

Note: Press “Alt + Print screen” on the keyboard to capture the active window only.

**Slider**

Used for visual input of values. Similar to volume control on a mixing board, you can control various parameters by sliding the fader. A very common example for this is the zoom slider that lets you see a picture in more detail.

**Slideshow**

An arrangement of various objects (photos, text, sound, etc.) is called a slide show. Slideshows can be saved separately as “MVM” files.
SMTP
Stands for Simple Mail Transfer Protocol and enables the exchange of emails across computer networks.

Software
The name for all non-physical functional components of a computer. This primarily includes computer programs and files that are meant to be used by computer programs.

Submenu
Besides normal entries, a menu can contain submenus that offer additional functions. This makes menus more comprehensive.

Super Video CD (SVCD)
The Super Video CD (SVCD) is a technological advancement of the video CD. SVCDs are also like VCD-specified CD-ROMs which can be played using either a Super Video CD player (connected to the television), or directly with the CD-ROM drive of a computer. Many DVD players can also play SVCDs. MPEG-2 and the increase of the data transfer rate makes it hard to tell videos from videos in DVD quality apart.

Resolution: SVCDs use the better MPEG-2 encoder in a standardized resolution of 480 x 576 (PAL). The MPEG-2 format offers a maximum resolution of up to 720 x 576 points and improved compression methods characterized by excellent image definition and homogeneity.

Hard disk capacity: An average 90-minute movie must be spread across 3 CDs. On one SVCD you can get about 30 minutes of good-quality movie.

Encoder setting: Compared to the VCD with 1.3, the data transfer rate is doubled to 2.6 Mbit/s.

MPEG-2 format introduces the so-called variable bit rate (VBR). In contrast to the constant bit rate (CBR) of the MPEG-1 encoders, this encoder has the option of using more bits for movement-intensive sections, as well as saving bits if picture content remains the same.

Toolbar
Here you will find small buttons that provide a function when clicked. For example, you can cut out a selected object by clicking on the scissors.

All basic functions of the corresponding program can be found here. The corresponding functions can be called up via mouse click.
**Top-level domain**

Top-level domains (TLD) are always those separated by a dot at the end of an Internet address (for example, “http://www.magix.com” < here, .com is the top-level domain). Among these are also country top-level domains, such as .co.uk, .us, .de as well as so-called generic top-level domains like .net, .org, .biz, and so on.

**Traffic**

Traffic (data transmission) occurs within your MAGIX Website Service as soon as data is transferred across the Internet: for example, when uploading or downloading files to your website or when someone else opens your website.

**U**

**Universal Plug & Play; UPnP**

Universal Plug ‘n’ Play (UPnP) is a network protocol which enables data exchange between different devices (PCs, hi-fi systems, video cameras, PDAs, and web servers). UPnP allows various devices to participate in network-wide communication, i.e. the initialization of functions and other device functions. Long-winded configuring or installing of drivers is not required as the devices can handle their own functions and data sources by themselves. Find out more at www.upnp.org.

**Hint:** To work with UPnP you have to activate it first. This can be found under “Options” (“Y” -> UPnP).

**URL**

URL stands for Uniform Resource Locator and describes where a source can be found online (for example, a website). The address or the path to the storage location of a file on your computer is known as a URL. Often the term URL is used as a term for the domain. The URL for the MAGIX website is: http://www.magix.co.uk

**V**

**VST and DirectX plug-ins**

Plug-ins are additional programs that expand the functionality of the main program. They are inserted into the main program.

Two standards exist for audio editing: VST (Steinberg) and DirectX (Microsoft). VST has asserted itself stronger in the current market.

**W**

**WAV**

Wave (*.WAV) is a standard uncompressed audio format.
Wave
Wave (*.WAV) is a standard uncompressed audio format.

Wave file
Wave (*.WAV) is a standard uncompressed audio format.

Webhosting
This means that an Internet Service Provider makes domains and webspace available to its customers. With the MAGIX Website Service, MAGIX provides webhosting to its customers.

Webmail
Webmail enables the customer to view and receive the contents of their email inbox without having to install email software on their computer. Customers of the MAGIX Website Service can use MAGIX Webmail for this.

Webmaster
A webmaster is responsible for the administration and maintenance of a website. Often, the webmaster is also the owner of the website as well as the domain that belongs to it. Once you have registered a domain in the MAGIX Website Service, an email account will automatically be set up, for example: "mailto:webmaster@domainname.co.uk".

Webserver
Webserver refers to the computer on which your host saves your website’s pages and which makes your pages accessible on the Internet 24-hours a day.

WMA
A process developed by Microsoft for compressing audio files with properties similar to those of MP3.

WMV
Windows Media Video (WMV) is a trademark video codec from Microsoft. If you have Windows installed on your PC, then playing WMV files shouldn’t be a problem. Only a few (hardware) DVD players are able to play this format. Read more about this in your DVD player’s manual.

This video format is very good for web videos as it allows relatively high compression rates.

World Wide Web (WWW)
WWW stands for “World Wide Web” and is the most used service of the Internet. On the WWW, web browsers (for example, Internet Explorer) are used to display information via websites. The process is colloquially called “Surfing the Internet”.

ZIP is a file format for archiving your files. The original file is reduced and then restored to its original size after it is unpacked without losing any quality.
Keyboard shortcuts

Tip: In Windows, keyboard settings are changed using the Alt + Shift key combination. Those who often use keyboard shortcuts can accidentally change their keyboard settings, so that they keys don’t correspond to the pictured symbols. To prevent this, you can remove the check mark found by going to “Control panel” > "Regional and language options" > "Languages" tab > "Details" > "Keyboard" > "Change keyboard combination" under "Change input layout".

Media Pool

Delete file Del
Copy file Ctrl + Ins
Insert file Shift + Ins
Rename file Alt + R
New folder Ctrl + P
Program settings P
Help F1

Select files:

Select multiple sequential images: Shift-click on the first and last file you wish to select
Select multiple individual pictures: Ctrl-click on the images
Select all images of the opened folder: Ctrl + A

Slideshow

Load/Save project

New project Alt + Ctrl + N
Load project Alt + Ctrl + O
Save project Alt + Ctrl + S
Save project as... Alt + Shift + S
Delete project Alt + Shift + O
New slideshow Ctrl + N
Load slideshow Ctrl + O
Load restoration slideshow Alt + O
Save slideshow Ctrl + S
Save slideshow as... Shift + S
Close slideshow Shift + O
Delete slideshow Shift + I
Burn backup copy to disc: Alt + Shift + R

Recording

Audio recording: R

Tools

Select all (not in Storyboard mode): Ctrl + A
Cut: Ctrl + X
Copy: Ctrl + C
Paste: Ctrl + V
Undo: Ctrl + Z
Redo: Ctrl + Y
Delete: Del
Slideshow Maker: W
Optimize photo: Shift + X
Audio cleaning: Shift + W
Create title: Ctrl + T

Cut

Split object: T
Remove object beginning: D
Remove object end: U
Split slideshow: Alt + W

Effects

Edit photo: Shift + Y
Zoom 2: Ctrl + Alt + 1
Zoom 3: Ctrl + Alt + 2
Free zoom selection: Ctrl + Alt + 3
Fix image proportions: Ctrl + Alt + 4
Reset section: Ctrl + Alt + 5
Rotate to left: Ctrl + Alt + F
Rotate right: Ctrl + Alt + G
Rotate 180 degrees: Ctrl + Alt + H
Transition (length): Alt + L
Apply transition to all: Alt + A
Random transition: Alt + Z

Color shift 1/2/3: Shift + 1/2/3
Reset video effects: Ctrl + C

www.magix.com
Object properties

**Arrangement display**

Switch Storyboard/Timeline mode
Optimize view
Zoom range between start and end marker
Zoom the entire slideshow
Zoom image

**Playback and marker placement**

Start/Stop playback
Stop at position (stop playback, move start marker to current position)
Move start marker to the beginning
Move end marker to the end
Slow wind left
Slow wind right
Fast wind left
Fast wind right
Full screen playback

Space bar, cursor up
Escape, Cursor down
0 on the number pad
Home
End
Left
Right
Ctrl + Left
Ctrl + Right
Alt + Enter
# Index

## 2

2-pass......................................................................................................................... 181

## 3

3D basics...................................................................................................................... 116
3D fades....................................................................................................................... 74, 75
3D series..................................................................................................................... 75

## A

AAC ............................................................................................................................ 180, 189
About MAGIX PhotoStory on DVD 2013 Deluxe......................................................... 172
AC3........................................................................................................................................ 190
Actions at the end of the slideshow (Slideshow menu only)..................................... 132
Activate additional functions...................................................................................... 173
Activation problems.................................................................................................. 174, 175
Add new font to text................................................................................................... 138
Additional programs.................................................................................................. 162
Adjust & delete locations........................................................................................... 106
Adjust background and buttons................................................................................. 138
Adjust map section..................................................................................................... 107
Adjusting the Signal Level...................................................................................... 87, 88, 90
Advanced audio recording settings........................................................................... 88
Advanced settings................................................................................................. 72, 157
Advanced video settings...................................................................................... 179, 182, 186
Align videos and pictures for 3D............................................................................. 120
Also in Timeline mode and Overview mode.......................................................... 42
Angle & shape........................................................................................................... 66
Animate objects......................................................................................................... 77
Animated selection menus....................................................................................... 129
Animation.................................................................................................................. 72, 108, 109
Annex
Digital Video and Data Storage............................................................................. 133, 197
Anti-flicker filter...................................................................................................... 166
Appendix
MPEG Encoder Settings....................................................................................... 144, 177
Archive project onto disc........................................................................................ 151
Archive project onto hard disk.............................................................................. 151
Arranger................................................................................................................... 30
Art filter ..................................................................................................................... 59
Aspect ratio............................................................................................................. 185
Attach......................................................................................................................... 153
Audio codec.......................................................................................................... 189
Audio commentary................................................................................................. 155
Audio editing (external)......................................................................................... 169
<table>
<thead>
<tr>
<th>Audio playback</th>
<th>30</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio recording</td>
<td>46, 87, 155</td>
</tr>
<tr>
<td>Audio settings</td>
<td>180</td>
</tr>
<tr>
<td>Audio tracks of inserted material</td>
<td>111</td>
</tr>
<tr>
<td>audioid</td>
<td>203</td>
</tr>
<tr>
<td>Automatic image effects</td>
<td>42</td>
</tr>
<tr>
<td>Automatic volume damping</td>
<td>114, 169</td>
</tr>
<tr>
<td>Automatically cut to fit monitor</td>
<td>167</td>
</tr>
<tr>
<td>AVC preset</td>
<td>182</td>
</tr>
<tr>
<td>AVCHD disc</td>
<td>133, 200</td>
</tr>
<tr>
<td>AVI</td>
<td>203</td>
</tr>
</tbody>
</table>

**B**

| Background | 67 |
| Background design | 42, 168 |
| Background music | 97 |
| Backup copy | 161 |
| B-frames count | 189 |
| Bit rate | 191 |
| Bit rate (Bits/s) | 185, 188 |
| Block | 192, 196 |
| Blu-ray Disc | 133, 200 |
| Border cropping adjustment: | 166 |
| Brightness | 54 |
| Browser | 203 |
| Burn dialog for DVD player | 142 |
| Burn project (image) again | 162 |
| Burn project and media | 161 |
| Burn slideshow and media to CD/DVD | 161 |
| Burn to CD or DVD | 161 |
| Burning | 15 |
| Button | 203 |

**C**

| Cache | 203 |
| Calculating the panorama image | 112 |
| Camera/zoom | 62 |
| Catooh – the Online Content Library | 11, 159 |
| CC | 203 |
| CDA | 203 |
| Checking the automatic tempo recognition | 100 |
| Choose music style | 98 |
| Choppoy or uneven playback | 175 |
| Chroma format | 179, 192 |
| Cleaning Wizard | 165 |
| Clean-up Wizard | 103, 165 |
| Clip level | 204 |
| Clipboard | 204 |
| Color | 55, 85 |
Color changes .................................................................................................................. 57
Color shade .................................................................................................................... 56
Combined objects .......................................................................................................... 47
Compressor ...................................................................................................................... 83
Computer .......................................................................................................................... 51
Connect objects in all tracks ......................................................................................... 43, 48
Connecting the source for recording ............................................................................ 89
Context help ...................................................................................................................... 171
Context menu .................................................................................................................... 47, 204
Convert to 3D title .......................................................................................................... 169
Copy .................................................................................................................................. 41, 164
Copy keyframes ............................................................................................................... 78
Copy project and media into folder ................................................................................. 161
Copy Protection .................................................................................................................. 199
Copy slideshow and media into folder ........................................................................... 161
Copyright ............................................................................................................................. 2, 204
CPU ................................................................................................................................... 204
Create a button design .................................................................................................... 130
Create a picture of a map ................................................................................................. 109
Create a slideshow with the wizard .................................................................................. 91, 164
Create disc menu and burn ............................................................................................. 25
Create DVD menus without a template ........................................................................... 139
Create panorama image .................................................................................................. 168
Create panorama images ............................................................................................... 112, 168
Create slideshow ............................................................................................................ 98
Creating an ISO image ..................................................................................................... 142
Creating titles using a template ....................................................................................... 69
Creating titles without a template ................................................................................... 69, 112
Cut ...................................................................................................................................... 41, 163
Cut button and editing menu ........................................................................................... 39

D

Database ............................................................................................................................. 154
Declipper ............................................................................................................................ 81
Decoration ........................................................................................................................... 67
Dehisser .............................................................................................................................. 83
Delete .................................................................................................................................. 41, 164
Delete keyframe ............................................................................................................... 79
Deleting, copying, and moving files ................................................................................ 50
Design ................................................................................................................................. 67, 166
Design page ......................................................................................................................... 129
Design title .......................................................................................................................... 112
Dialog .................................................................................................................................. 204
Digital Versatile Disc (DVD) ............................................................................................. 199
Direction & time ................................................................................................................. 62
Disc options ........................................................................................................................ 128
Disc project .......................................................................................................................... 204
Disc selection dialog ....................................................................................................... 28, 124, 141
Disc types ............................................................................................................................ 204
Disk space ........................................................................................................................... 133
Display .................................................................................................................................. 33

www.magix.com
Index

E

Edit ............................................................................................................................................... 14
Edit disc menu ................................................................................................................................. 124, 127
Edit DVD menus with MAGIX Photo & Graphic Designer 7 .......................................................... 135
Edit externally .................................................................................................................................. 137
Edit image (external) ....................................................................................................................... 167
Edit Menu ......................................................................................................................................... 163
Edit menu elements ......................................................................................................................... 127
Edit titles retroactively ................................................................................................................... 71
Editing a menu for 3 to 5 movies ..................................................................................................... 137
Editing slideshows ............................................................................................................................ 22
Effects .............................................................................................................................................. 53, 71, 77, 95
Effects from the Media Pool ............................................................................................................. 77
Effects in menus .................................................................................................................................. 77
Effects Menu ..................................................................................................................................... 77, 84, 112, 166
Effects settings .................................................................................................................................. 169
Encoder .............................................................................................................................................. 177
Encoder settings ................................................................................................................................. 143
Equalizer .......................................................................................................................................... 81, 83
Exchange .......................................................................................................................................... 165
Exchange object ................................................................................................................................. 41
Exit ...................................................................................................................................................... 163
Export ............................................................................................................................................... 15, 35, 103, 145, 146, 155
Export and burn 3D videos ............................................................................................................... 122
Export as 3D video .............................................................................................................................. 148
Export menu ....................................................................................................................................... 135, 138, 139
Export slideshow file ......................................................................................................................... 153
Export to device ................................................................................................................................. 161
Exposure ........................................................................................................................................... 84

F

Fade in date as title ............................................................................................................................. 169
Fader ................................................................................................................................................... 205
Fades .................................................................................................................................................. 53, 168
<table>
<thead>
<tr>
<th>Index</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>IMAP</td>
<td>207</td>
</tr>
<tr>
<td>Import</td>
<td>14</td>
</tr>
<tr>
<td>Import files from camera</td>
<td>38, 154</td>
</tr>
<tr>
<td>Import from camera</td>
<td>154</td>
</tr>
<tr>
<td>Import from computer</td>
<td>154</td>
</tr>
<tr>
<td>Import media from web</td>
<td>159</td>
</tr>
<tr>
<td>Import menu back into MAGIX PhotoStory on DVD 2013 Deluxe</td>
<td>138</td>
</tr>
<tr>
<td>Import slideshow file</td>
<td>153</td>
</tr>
<tr>
<td>Including video objects</td>
<td>96</td>
</tr>
<tr>
<td>Insert your own material</td>
<td>111</td>
</tr>
<tr>
<td>Intensity</td>
<td>95</td>
</tr>
<tr>
<td>Interlace</td>
<td>33, 177, 183, 187, 192, 194, 207</td>
</tr>
<tr>
<td>Internet</td>
<td>159</td>
</tr>
<tr>
<td>Interpolation for interlace material</td>
<td>166</td>
</tr>
<tr>
<td>Intro</td>
<td>208</td>
</tr>
<tr>
<td>Introduction</td>
<td>13</td>
</tr>
<tr>
<td>Intros / Outros</td>
<td>67</td>
</tr>
<tr>
<td>Invert image sequence for panorama image</td>
<td>112</td>
</tr>
<tr>
<td>jpx</td>
<td>208</td>
</tr>
<tr>
<td>Jump to linked page</td>
<td>131</td>
</tr>
<tr>
<td>Keyboard shortcuts</td>
<td>110, 217</td>
</tr>
<tr>
<td>Load photos</td>
<td>19, 92</td>
</tr>
<tr>
<td>Load project</td>
<td>38</td>
</tr>
<tr>
<td>Lower toolbar</td>
<td>39</td>
</tr>
<tr>
<td>MAGIX Community</td>
<td>12</td>
</tr>
<tr>
<td>MAGIX media</td>
<td>52, 154</td>
</tr>
<tr>
<td>MAGIX News Center</td>
<td>11, 32</td>
</tr>
<tr>
<td>MAGIX Online Album</td>
<td>11, 159</td>
</tr>
<tr>
<td>MAGIX Soundtrack Maker</td>
<td>98, 164</td>
</tr>
<tr>
<td>MAGIX Website Maker</td>
<td>11</td>
</tr>
<tr>
<td>magix.info</td>
<td>171</td>
</tr>
<tr>
<td>Manage slideshow</td>
<td>153</td>
</tr>
<tr>
<td>Manage slideshows</td>
<td>25</td>
</tr>
<tr>
<td>Manual volume decrease</td>
<td>47, 89, 115, 169</td>
</tr>
<tr>
<td>Max b-frames count</td>
<td>186</td>
</tr>
<tr>
<td>Max GOP length</td>
<td>186</td>
</tr>
<tr>
<td>Max key interval</td>
<td>189</td>
</tr>
<tr>
<td>Max. rate</td>
<td>188</td>
</tr>
<tr>
<td>Media</td>
<td>49</td>
</tr>
</tbody>
</table>
Media Pool ......................................................................................................................... 35, 48, 166, 217
Media: ............................................................................................................................... 158
Menu .................................................................................................................................. 126, 133, 208
Menu bar ......................................................................................................................... 208
Menu entry/menu page properties ............................................................................. 130, 131
Menu image ................................................................................................................... 132
Menu templates .......................................................................................................... 124, 126
Menu text ...................................................................................................................... 131
Menu text with external menu editing ...................................................................... 135
Menu view and menu navigation .............................................................................. 25
Menus ............................................................................................................................. 35, 152
MIDI ................................................................................................................................ 208
Mirror ............................................................................................................................... 66
Mirror & Rotate ............................................................................................................. 65
Mode ................................................................................................................................ 184, 188
More about MAGIX ........................................................................................................ 11
Motherboard .................................................................................................................. 208
Motion estimation ........................................................................................................ 177, 191, 196
Mouse mode for individual objects ........................................................................... 42, 47
Mouse modes ................................................................................................................. 47
MOV ................................................................................................................................. 209
Movement in direction ................................................................................................. 62
Movie templates ............................................................................................................ 52, 111
MP3 .................................................................................................................................. 209
MPEG ............................................................................................................................... 209
MPEG Compression ....................................................................................................... 198
MPEG glossary .............................................................................................................. 191
MPEG-4 encoder .......................................................................................................... 144, 180, 200
MPEG-4 H.264 ............................................................................................................ 180, 181
MPEG-4 preset ............................................................................................................. 186
MPEG-4 simple ............................................................................................................. 180, 186
MS audio ......................................................................................................................... 209
Multiplexer ...................................................................................................................... 190
Musical Cut Adjustment .............................................................................................. 100, 164
Musical editing adjustment ......................................................................................... 164
Mute sound .................................................................................................................... 43
MVC .................................................................................................................................. 181
MXV .................................................................................................................................. 209
My Media ....................................................................................................................... 51

Navigation ....................................................................................................................... 128
Navigation buttons ....................................................................................................... 50
New .................................................................................................................................. 152
New project .................................................................................................................... 37
Noise Reduction
  Denoiser and Dehisser ............................................................................................... 81
Noise Sample ............................................................................................................... 209
NTSC (USA, Japan) ...................................................................................................... 209
Numeric keypad ............................................................................................................ 209

www.magix.com
# Index

## O

- Object cutting and fades................................................................. 47
- Object properties......................................................................................... 170
- Objects ........................................................................................................ 46
- OGG VORBIS .............................................................................................. 209
- Only in Timeline mode............................................................ 42, 151, 158
- Open automatically saved project.................................................. 152
- Opening and closing credits................................................................. 96
- Optimize grid view ..................................................................................... 42
- Options ........................................................................................................ 31, 143
- Other ........................................................................................................... 31
- Output as individual photos................................................................. 147
- Output as media player.................................................................................. 151, 158
- Output as video file..................................................................................... 146
- Output for a mobile device........................................................................ 150, 161
- Output format............................................................................................ 190
- Overview mode.............................................................................................. 35, 43

## P

- P frames and B frames................................................................. 186, 188, 189, 195
- PAL (Europe) ................................................................................................ 210
- Panorama settings......................................................................................... 112
- Pass ................................................................................................................ 184
- Paste.................................................................................................................................................. 41, 164
- Paths.................................................................................................................. 31, 129
- PDF manual........................................................................................................ 171
- Picture type ........................................................................................................ 187
- Picture-in-picture collages............................................................................... 67, 168
- Pixel aspect ratio................................................................................................ 188
- Play marker........................................................................................................ 210
- Playback ............................................................................................................. 30
- Playlist................................................................................................................. 210
- Plug-in................................................................................................................. 210
- Podcast................................................................................................................ 210
- Podcasting.......................................................................................................... 211
- POP3 ..................................................................................................................... 211
- Position ................................................................................................................ 64
- Position titles ....................................................................................................... 191, 193, 195
- Preface................................................................................................................ 3
- Preparation - Setting the start marker and object end.................................. 100
- Prepare 3D editing............................................................................................... 118
- Preparing animations......................................................................................... 77
- Present on MAGIX Online Album...................................................................... 148
- Preview................................................................................................................ 31
- Preview and editing............................................................................................ 125
- Problems and solutions.................................................................................. 175
Save as................................................................................................................... .............38
Save project.........................................................................................................................38
Save/delete style template ...............................................................................................95
Scan image .........................................................................................................................154
Scan with............................................................................................................................155
Scan photo externally ..................................................................154
Scan with............................................................................................................................155
Scene change detection .....................................................................................................186, 189
Screen
  Slideshow .......................................................................................................................35
  Screenshot .....................................................................................................................212
  Search ............................................................................................................................49
  Search empty sections .................................................................................................102, 165
  Section ..........................................................................................................................61
  Select all objects ..........................................................................................................165
  Select locations on the map ..........................................................................................104
  Select pictures for panorama ....................................................................................112
  Select source ...............................................................................................................155
  Separate project onto multiple discs ..........................................................................134
  Serial number ...........................................................................................................10
  Set keyframes ............................................................................................................78
  Set mood change .........................................................................................................98
  Set playback mode for 3D ..........................................................................................75, 119, 120
  Settings ......................................................................................................................29, 162
  Sharpness ...............................................................................................................58
  Show lines (connect locations) ..................................................................................106, 108
  Show/Hide ...............................................................................................................168
  Simple crossfade in Timeline Mode ..........................................................................76
  Single frame as BMP file ..........................................................................................157
  Single frame as JPG ..................................................................................................158
  Size .............................................................................................................................64
  Size/Position ..............................................................................................................64
  Slice count ..................................................................................................................184, 187
  Slider ..........................................................................................................................212
  Slideshow ....................................................................................................................29, 152, 212, 217
  Slideshow & photo menu ...........................................................................................128
  Slideshow effect settings ...........................................................................................163
  Slideshow effects .......................................................................................................29, 84
  Slideshow length .......................................................................................................96
  Slideshow Maker .......................................................................................................39, 94, 164
  Slideshow music ..........................................................................................................52
  Slideshow wizard .......................................................................................................164
  Slideshow ....................................................................................................................162
  Smart Render and Smart Copy ...................................................................................181
  SMTP ..........................................................................................................................213
  Soft movement ..........................................................................................................79
  Software ....................................................................................................................213
  Sorting Photos ............................................................................................................20
  Sound optimization ....................................................................................................47, 81, 88, 169
  Soundtrack Maker .......................................................................................................164
  Special functions and wizards ..................................................................................17, 91
  Specify effects ............................................................................................................93
  Specify settings .........................................................................................................91
Templates ................................................................. 53
Test series with variable encoder settings ......................... 133
The ........................................................................ 35, 124, 161
Timeline ..................................................................... 45
Timeline mode .......................................................... 35, 45
Tips for program help ............................................... 201
Title .......................................................................... 53
Title editor ................................................................ 42, 68
Title Editor .................................................................. 168
Title object .............................................................. 72
Toolbar ...................................................................... 37, 213
Top Toolbar ............................................................. 37
Top-level domain ...................................................... 214
Track damping options ............................................. 89
Tracks ...................................................................... 46
Traffic ...................................................................... 214
Transitions ............................................................... 95
Transitions (fades) ..................................................... 32, 45, 53, 74, 168
Transitions in Storyboard Mode .................................. 74
Travel route animation .............................................. 53, 103, 165
Travel routes ........................................................... 53
Treat special image formats intelligently ......................... 96
Turn camera movements into 3D videos ......................... 121
TV image size (Slideshow master effects) ....................... 72, 84, 85, 128, 166
TV picture ................................................................... 166
Twain scanner .......................................................... 155
U

Undo.................................................................39, 163
Update online.........................................................172
Upload all selected media in Media Pool......................171
Upload current slideshow as video...............................170
Universal Plug & Play..................................................214
Upright-format effects..................................................67
URL...........................................................................214
User directory................................................................51
User-defined:..............................................................150

V

Video........................................................................158
Video as animated GIF..............................................157
Video as AVI...............................................................155
Video as MAGIX video.................................................156
Video as MotionJPEG AVI...........................................156
Video as MPEG video..................................................155
Video as MPEG-4 video...............................................157
Video as Quicktime Movie..........................................156
Video codec...............................................................181
Video Editing on the PC..............................................197
Video monitor and transport console..........................35, 36
Video options...........................................................31
Video settings............................................................177, 178
Video stabilization......................................................79, 168
Video standard..........................................................31
View & animation.....................................................61, 166
Volume curve.............................................................169
Volume settings..........................................................169
VST and DirectX plug-ins............................................214

W

WAV.................................................................214
Wave........................................................................215
Wave file.................................................................215
Webhosting.............................................................215
Webmail.................................................................215
Webmaster..............................................................215
Webserver...............................................................215
What is MAGIX PhotoStory on DVD 2013 Deluxe?........13
What’s new in MAGIX PhotoStory on DVD 2013 Deluxe?....13
White balance.........................................................55
Windows Media Export............................................156
Wizards.................................................................164
WMA......................................................................215
WMV....................................................................215
World Wide Web (WWW) .............................................................. 215

Y

Youtube/Flickr/Facebook .............................................................. 170

Z

Zip ............................................................................................................. 216
Zoom in video monitor ................................................................................. 37
Zooming ................................................................................................. 46